Site Recovery Manager Installation and Configuration

Site Recovery Manager 8.3
You can find the most up-to-date technical documentation on the VMware website at:

https://docs.vmware.com/

If you have comments about this documentation, submit your feedback to
docfeedback@vmware.com
7 Deploying the Site Recovery Manager Appliance 49
  Deploy the Site Recovery Manager Virtual Appliance 49
  Log In to the VMware Site Recovery Manager Appliance Management Interface 52
  Configure the Site Recovery Manager Appliance to Connect to a vCenter Server 52
  Connect to the Site Recovery Manager Appliance Embedded vPostgres Database 55
  How to Set Up a Trusted Environment for the Site Recovery Manager Virtual Appliance 55
  Use the VMware OVF Tool to Deploy the Site Recovery Manager Virtual Appliance Virtual Machine from a Client OVF Template 56

8 Reconfiguring the Site Recovery Manager Virtual Appliance 59
  Configure the Time Zone and Time Synchronization Settings for the Site Recovery Manager Appliance 59
  Start, Stop, and Restart Site Recovery Manager Appliance Services 60
  Configure the Site Recovery Manager Appliance Network Settings 61
  Change the Site Recovery Manager Appliance Certificate 62
    Generate and Download a Certificate Signing Request for the Site Recovery Manager Appliance 62
  Enable or Disable SSH Access to the Site Recovery Manager Appliance 63
  Forward Site Recovery Manager Appliance Log Files to Remote Syslog Server 63

9 Network Ports for Site Recovery Manager 65

10 Configuring the Customer Experience Improvement Program 70
  Categories of Information that VMware Receives 70

11 Provide Feedback with the Site Recovery User Interface 71

12 Modifying and uninstalling Site Recovery Manager 72
  Modify a Site Recovery Manager Server Installation 73
  Reconfigure the Connection Between Sites 76
  Break the Site Pairing and Connect to a New Remote Site 77
  Repair a Site Recovery Manager Server Installation 78
  Rename a Site Recovery Manager Site 79
  Uninstall Site Recovery Manager 79
  Uninstall and Reinstall the Same Version of Site Recovery Manager 81
    Migrating a Site Recovery Manager Server to Run on a Different Host 81

13 Exporting and Importing Site Recovery Manager Configuration Data 86
  Export Site Recovery Manager Configuration Data through the User Interface 87
  Export Site Recovery Manager Configuration Data by Using a Script Without Credentials 88
  Modify the Export Script of the VMware Site Recovery Manager 8.3 Configuration Import/Export Tool 88
Schedule an Export of Site Recovery Manager Configuration Data by Using a Cron Job 89
Export Site Recovery Manager Appliance Configuration Data by Using a Callout 89
Export Site Recovery Manager Configuration Data with the Standalone Import/Export Tool 90
Use a Properties File to Export Site Recovery Manager Configuration Data 92
Import the Site Recovery Manager Configuration Data through the User Interface 92
Import Site Recovery Manager Configuration Data with the Standalone Import/Export Tool 93
Use a Properties File to Import Site Recovery Manager Configuration Data 94
Syntax of the Import/Export Tool 95
Properties for Automated Export and Import of Site Recovery Manager Configuration Data 97
Troubleshooting the VMware Site Recovery Manager 8.3 Configuration Import/Export Tool 99
Export Fails with an Error About a Duplicate Key 99

14 Upgrading Site Recovery Manager 101
Information That Site Recovery Manager Upgrade Preserves 101
Types of Site Recovery Manager Upgrade 102
Upgrade Site Recovery Manager for Windows 103
  Order of Upgrading vSphere and Site Recovery Manager Components 105
  Prerequisites and Best Practices for Site Recovery Manager Upgrade 107
  In-Place Upgrade of Site Recovery Manager Server 108
Upgrade Site Recovery Manager Server with Migration 112
Configure and Verify the Upgraded Site Recovery Manager Installation 116
Revert to a Previous Release of Site Recovery Manager 118
Update the Site Recovery Manager Virtual Appliance 119

15 Migrating from Site Recovery Manager for Windows to the Site Recovery Manager Virtual Appliance 120
Migrate from Site Recovery Manager for Windows to Site Recovery Manager Virtual Appliance 120
Roll Back from the Site Recovery Manager Virtual Appliance to Site Recovery Manager for Windows 123

16 Installing Site Recovery Manager to Use with a Shared Recovery Site 124
Shared Recovery Sites and vCenter Server Deployment Models 127
  Site Recovery Manager in a Shared Recovery Site Configuration 127
  Site Recovery Manager in a Shared Protected Site Configuration 128
Limitations of Using Site Recovery Manager in Shared Recovery Site Configuration 129
  Timeout Errors When Powering on Virtual Machines on a Shared Recovery Site 129
Models for Assigning Site Recovery Manager Licenses in a Shared Recovery Site Configuration 130
Install Site Recovery Manager In a Shared Recovery Site Configuration 131
  Use vSphere Replication in a Shared Recovery Site Configuration 132
Install Site Recovery Manager Server on Multiple Protected Sites to Use with a Shared Recovery Site 134
Install Multiple Site Recovery Manager Server Instances on a Shared Recovery Site 135
Configure the Site Recovery Manager Appliance on Multiple Protected Sites to Use with a Shared Recovery Site 136

Connect the Site Recovery Manager Sites in a Shared Recovery Site Configuration 139

Use Array-Based Replication in a Shared Recovery Site Configuration 139

Configure Placeholders and Mappings in a Shared Recovery Site Configuration 140

Upgrade Site Recovery Manager in a Shared Recovery Site Configuration 141

17 Silent Installation, Upgrade, and Uninstallation of Site Recovery Manager 144

Install Site Recovery Manager with Embedded vPostgreSQL Database Silently 144

Install Site Recovery Manager Server Silently with an External Database 149

Upgrade Site Recovery Manager with Embedded vPostgreSQL Database Silently 154

Upgrade Site Recovery Manager Server Silently 156

Uninstall Site Recovery Manager Server Silently 158
About VMware Site Recovery Manager Installation and Configuration

*Site Recovery Manager Installation and Configuration* provides information about how to install, upgrade, and configure VMware Site Recovery Manager.

This information also provides a general overview of Site Recovery Manager.

For information about how to perform day-to-day administration of Site Recovery Manager, see *Site Recovery Manager Administration*.

**Intended Audience**

This information is intended for anyone who wants to install, upgrade, or configure Site Recovery Manager. The information is written for experienced Windows or Linux system administrators who are familiar with virtual machine technology and datacenter operations.
Overview of VMware Site Recovery Manager

VMware Site Recovery Manager is a business continuity and disaster recovery solution that helps you to plan, test, and run the recovery of virtual machines between a protected vCenter Server site and a recovery vCenter Server site.

You can configure Site Recovery Manager to protect virtual machines in different ways.

**Datastore groups**
- Protect the virtual machines in datastore groups by using third-party disk replication mechanisms to configure array-based replication. Array-based replication surfaces replicated datastores to recover virtual machine workloads.

**Individual virtual machines**
- Protect the individual virtual machines on a host by using Site Recovery Manager in combination with VMware vSphere Replication.

**Storage policies**
- Protect virtual machines based on their association with specific storage policies. Protecting virtual machines by using storage policies requires array-based replication.

You can use Site Recovery Manager to implement different types of recovery from the protected site to the recovery site.

**Planned migration**
- The orderly evacuation of virtual machines from the protected site to the recovery site. Planned migration prevents data loss when migrating workloads in an orderly fashion. For planned migration to succeed, both sites must be running and fully functioning.

**Disaster recovery**
- Similar to planned migration except that disaster recovery does not require that both sites be up and running, for example if the protected site goes offline unexpectedly. During a disaster recovery operation, failure of operations on the protected site is reported but is otherwise ignored.
Site Recovery Manager orchestrates the recovery process with the replication mechanisms, to minimize data loss and system down time.

- At the protected site, Site Recovery Manager shuts down virtual machines cleanly and synchronizes storage, if the protected site is still running.
- Site Recovery Manager powers on the replicated virtual machines at the recovery site according to a recovery plan.

A recovery plan specifies the order in which virtual machines start up on the recovery site. A recovery plan specifies network parameters, such as IP addresses, and can contain user-specified scripts that Site Recovery Manager can run to perform custom recovery actions on virtual machines.

Site Recovery Manager lets you test recovery plans. You conduct tests by using a temporary copy of the replicated data in a way that does not disrupt ongoing operations at either site.

- **About Protected Sites and Recovery Sites**
  In a typical Site Recovery Manager installation, the protected site provides business-critical datacenter services. The recovery site is an alternative infrastructure to which Site Recovery Manager can migrate these services.

- **Bidirectional Protection**
  You can use a single set of paired Site Recovery Manager sites to protect virtual machines in both directions. Each site can simultaneously be a protected site and a recovery site, but for a different set of virtual machines.

- **Heterogeneous Configurations on the Protected and Recovery Sites**
  Some components in the Site Recovery Manager and vCenter Server installations must be identical on each site. Because the protected and recovery sites are often in different physical locations, some components on the protected site can be of a different type to their counterparts on the recovery site.

**About Protected Sites and Recovery Sites**

In a typical Site Recovery Manager installation, the protected site provides business-critical datacenter services. The recovery site is an alternative infrastructure to which Site Recovery Manager can migrate these services.

The protected site can be any site where vCenter Server supports a critical business need. The recovery site can be located thousands of miles away from the protected site. Conversely, the recovery site can be in the same room as a way of establishing redundancy. The recovery site is usually located in a facility that is unlikely to be affected by environmental, infrastructure, or other disturbances that affect the protected site. You can establish bidirectional protection in which each site serves as the recovery site for the other. See **Bidirectional Protection**.
The vSphere configurations at each site must meet requirements for Site Recovery Manager.

- The version of vCenter Server must be compatible with the version of Site Recovery Manager. For information about compatibility between vCenter Server and Site Recovery Manager versions, see vCenter Server Requirements in the Compatibility Matrices for Site Recovery Manager 8.3 at https://docs.vmware.com/en/Site-Recovery-Manager/8.3/rn/srm-compat-matrix-8-3.html.

- Each site must have at least one datacenter.

- If you are using array-based replication, the same replication technology must be available at both sites, and the arrays must be paired.

- If you are using vSphere Replication, you require a vSphere Replication appliance on both sites. The vSphere Replication appliances must be connected to each other.

- The vSphere Replication version must be compatible with the version of Site Recovery Manager. For information about compatibility between vSphere Replication and Site Recovery Manager versions, see vSphere Replication Requirements in the Compatibility Matrices for Site Recovery Manager 8.3 at https://docs.vmware.com/en/Site-Recovery-Manager/8.3/rn/srm-compat-matrix-8-3.html.

- The recovery site must have hardware, network, and storage resources that can support the same virtual machines and workloads as the protected site. You can oversubscribe the recovery site by running additional virtual machines there that are not protected. In this case, during a recovery you must suspend noncritical virtual machines on the recovery site.

- The sites must be connected by a reliable IP network. If you are using array-based replication, ensure that your network connectivity meets the arrays’ network requirements.

- The recovery site should have access to comparable public and private networks as the protected site, although not necessarily the same range of network addresses.
Bidirectional Protection

You can use a single set of paired Site Recovery Manager sites to protect virtual machines in both directions. Each site can simultaneously be a protected site and a recovery site, but for a different set of virtual machines.

You can implement bidirectional protection by protecting datastore groups or storage policies by using array-based replication or by protecting individual virtual machines by using vSphere Replication. If you are using array-based replication, each of the array’s LUNs replicates in only one direction. Two LUNs in paired arrays can replicate in different directions from each other.

Heterogeneous Configurations on the Protected and Recovery Sites

Some components in the Site Recovery Manager and vCenter Server installations must be identical on each site. Because the protected and recovery sites are often in different physical locations, some components on the protected site can be of a different type to their counterparts on the recovery site.

Site Recovery Manager is compatible with N-1 version of Site Recovery Manager on the paired site. For example, if the current version of Site Recovery Manager is 8.3, the supported versions for the paired site is 8.2 and later.

Although components can be different on each site, you must use the types and versions of these components that Site Recovery Manager supports. See the https://docs.vmware.com/en/Site-Recovery-Manager/8.3/rn/srm-compat-matrix-8-3.html.

Table 1-1. Heterogeneity of Site Recovery Manager Components Between Sites

<table>
<thead>
<tr>
<th>Component</th>
<th>Heterogeneous or Identical Installations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Recovery Manager Server</td>
<td>Must be 8.x version on both sites.</td>
</tr>
<tr>
<td>vCenter Server and Platform Services Controller</td>
<td>The Site Recovery Manager version must be compatible with the vCenter Server and Platform Services Controller version.</td>
</tr>
<tr>
<td>vSphere Replication</td>
<td>Must be 8.x version on both sites. The vSphere Replication version must be compatible with the Site Recovery Manager version and the vCenter Server version.</td>
</tr>
<tr>
<td>vCenter Server Appliance or standard vCenter Server instance</td>
<td>Can be different on each site. You can run a vCenter Server Appliance on one site and a standard vCenter Server instance on the other site.</td>
</tr>
<tr>
<td>Storage arrays for array-based replication</td>
<td>Can be different versions on each site. You can use different versions of the same type of storage array on each site. The Site Recovery Manager Server instance on each site requires the appropriate storage replication adapter (SRA) for each version of storage array for that site. Check SRA compatibility with all versions of your storage arrays to ensure compatibility.</td>
</tr>
<tr>
<td>Site Recovery Manager database</td>
<td>Can be different on each site. You can use different versions of the same type of database on each site, or different types of database on each site.</td>
</tr>
</tbody>
</table>
### Table 1-1. Heterogeneity of Site Recovery Manager Components Between Sites (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>Heterogeneous or Identical Installations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host operating system of the Site Recovery Manager Server installation</td>
<td>Can be different on each site. You can run different versions of the host operating system and the host operating system can run in different locales on each site.</td>
</tr>
<tr>
<td>Host operating system of the vCenter Server installation</td>
<td>Can be different on each site. You can run different versions of the host operating system and the host operating system can run in different locales on each site.</td>
</tr>
</tbody>
</table>

### Example: Heterogenous Configurations on the Protected and Recovery Sites

The Site Recovery Manager and vCenter Server installations might be in different countries, with different setups.

- **Site A in Japan:**
  - Site Recovery Manager Server runs on Windows Server 2008 in the Japanese locale
  - Site Recovery Manager extends a vCenter Server Appliance instance
  - Site Recovery Manager Server uses the embedded Site Recovery Manager database

- **Site B in the United States:**
  - Site Recovery Manager Server runs on Windows Server 2012 in the English locale
  - Site Recovery Manager extends a standard vCenter Server instance that runs on Windows Server 2008 in the English locale
  - Site Recovery Manager Server uses an Oracle Server database
The system on which you install Site Recovery Manager must meet specific hardware requirements.

Minimum System Requirements for Site Recovery Manager for Windows

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>At least two 2.0 GHz or faster Intel or AMD x86 processors. Site Recovery Manager deployments that manage large environments require four 2.0 GHz CPUs.</td>
</tr>
<tr>
<td>Memory</td>
<td>4 GB minimum. You might require more memory if you use the embedded database, as the content of the database expands. The memory requirement increases if Site Recovery Manager manages large environments.</td>
</tr>
<tr>
<td>Disk Storage</td>
<td>5 GB minimum. If you install Site Recovery Manager on a different drive to the C: drive, the Site Recovery Manager installer still requires at least 1 GB of free space on the C: drive. This space is required for extracting and caching the installation package. If you use the embedded database, you might require more disk storage as the content of the database expands.</td>
</tr>
<tr>
<td>Networking</td>
<td>1 Gbit for communication between Site Recovery Manager sites. Use a trusted network for the deployment and use of Site Recovery Manager and for the management of ESXi hosts.</td>
</tr>
</tbody>
</table>

Minimum System Requirements for the Site Recovery Manager Virtual Appliance

Site Recovery Manager is distributed as a 64-bit virtual appliance packaged in the .ovf format. You must deploy the virtual appliance in a vCenter Server environment by using the OVF deployment wizard on an ESXi host.
### Deployment type

<table>
<thead>
<tr>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Light</strong></td>
</tr>
<tr>
<td>2 vCPU, 8 GB RAM, one 16 GB hard disk, and one 4 GB hard disk, 1 Gbit network card. You can use the light deployment type for deployments that protect less than 1000 virtual machines.</td>
</tr>
<tr>
<td><strong>Standard</strong></td>
</tr>
<tr>
<td>4 vCPU, 12 GB RAM, one 16 GB hard disk, and one 4 GB hard disk, 1 Gbit network card. Use the standard deployment type for deployments that protect more than 1000 virtual machines.</td>
</tr>
</tbody>
</table>


- **Site Recovery Manager Licensing**
  After you install Site Recovery Manager, it remains in evaluation mode until you install a Site Recovery Manager license key.

- **Operational Limits of Site Recovery Manager**
  Each Site Recovery Manager server can support a certain number of protected virtual machines, protection groups, datastore groups, recovery plans, and concurrent recoveries.

### Site Recovery Manager Licensing

After you install Site Recovery Manager, it remains in evaluation mode until you install a Site Recovery Manager license key.

After the evaluation license expires, existing protection groups remain protected and you can recover them, but you cannot create new protection groups or add virtual machines to an existing protection group until you obtain and assign a valid Site Recovery Manager license key. Obtain and assign Site Recovery Manager license keys as soon as possible after installing Site Recovery Manager.

Site Recovery Manager licenses allow you to protect a set number of virtual machines. To obtain Site Recovery Manager license keys, contact your VMware sales representative.

### Site Recovery Manager License Keys and vCenter Server Instances in Linked Mode

If your vCenter Server instances are connected with vCenter Server instances in linked mode, you install the same Site Recovery Manager license on both vCenter Server instances.

### Site Recovery Manager License Keys and Shared Platform Services Controller Instances

You can share an external Platform Services Controller across several vCenter Server instances. In this case, you can use the same Site Recovery Manager license on different vCenter Server instances as long as the vCenter Server instances belong to the same Platform Services Controller.
Site Recovery Manager License Keys and Protected and Recovery Sites

Site Recovery Manager requires a license key on any site on which you protect virtual machines.

- Install a Site Recovery Manager license key at the protected site to enable protection in one direction from the protected site to the recovery site.
- Install the same Site Recovery Manager license keys at both sites to enable bidirectional protection, including reprotect.

Site Recovery Manager checks for a valid license whenever you add a virtual machine to or remove a virtual machine from a protection group. If licenses are not in compliance, vSphere triggers a licensing alarm and Site Recovery Manager prevents you from protecting further virtual machines. Configure alerts for triggered licensing events so that licensing administrators receive a notification by email.

Example: Site Recovery Manager Licenses Required for Recovery and Reprotect

You have a site that contains 25 virtual machines for Site Recovery Manager to protect.

- For recovery, you require a license for at least 25 virtual machines, that you install on the protected site to allow one-way protection from the protected site to the recovery site.
- For reprotect, you require a license for at least 25 virtual machines, that you install on both the protected and the recovery site to allow bidirectional protection between the sites.

Operational Limits of Site Recovery Manager

Each Site Recovery Manager server can support a certain number of protected virtual machines, protection groups, datastore groups, recovery plans, and concurrent recoveries.

Protection Maximums for Site Recovery Manager 8.3

Table 2-1. Protection Maximums for Site Recovery Manager 8.3

<table>
<thead>
<tr>
<th>Item</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total number of virtual machines configured for protection</td>
<td>5000</td>
</tr>
<tr>
<td>(array-based replication, vSphere Replication, vVols Replication,</td>
<td></td>
</tr>
<tr>
<td>and storage policy protection combined)</td>
<td></td>
</tr>
<tr>
<td>Total number of virtual machines configured for protection using</td>
<td>5000</td>
</tr>
<tr>
<td>array-based replication</td>
<td></td>
</tr>
<tr>
<td>Total number of virtual machines configured for protection using</td>
<td>2000</td>
</tr>
<tr>
<td>vSphere Replication</td>
<td></td>
</tr>
<tr>
<td>Total number of virtual machines configured for protection using</td>
<td>500</td>
</tr>
<tr>
<td>vVols Replication</td>
<td></td>
</tr>
<tr>
<td><strong>Note</strong> Contact your storage vendor for exact number of supported</td>
<td></td>
</tr>
<tr>
<td>virtual machines, replicated with vVols Replication.</td>
<td></td>
</tr>
<tr>
<td>Total number of virtual machines configured for storage policy</td>
<td>2000</td>
</tr>
<tr>
<td>protection</td>
<td></td>
</tr>
</tbody>
</table>
### Table 2-1. Protection Maximums for Site Recovery Manager 8.3 (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total number of virtual machines configured for storage policy protection with stretched storage</td>
<td>1000</td>
</tr>
<tr>
<td>Total number of virtual machines per protection group</td>
<td>500</td>
</tr>
<tr>
<td>Total number of array-based replication protection groups and vSphere Replication protection groups</td>
<td>500</td>
</tr>
<tr>
<td>Total number of storage policy protection groups</td>
<td>32</td>
</tr>
<tr>
<td>Total number of recovery plans</td>
<td>250</td>
</tr>
<tr>
<td>Total number of protection groups per recovery plan</td>
<td>250</td>
</tr>
<tr>
<td>Total number of virtual machines per recovery plan</td>
<td>2000</td>
</tr>
<tr>
<td>Total number of replicated datastores (using array-based replication)</td>
<td>255</td>
</tr>
</tbody>
</table>

You can run array-based protection groups alongside vSphere Replication protection groups and storage policy protection groups in the same Site Recovery Manager server instance. The total number of protection groups cannot exceed 500 for all protection types combined. For example, you cannot create 250 array-based replication protection groups and then create 350 vSphere Replication protection groups, as this creates 600 protection groups in total.

If you have 250 array-based protection groups, you can create additional 250 vSphere Replication protection groups, to make a total of 500 protection groups. Similarly, in a setup that combines an array-based replication and vSphere Replication, you can protect a maximum of 5,000 virtual machines, even if you combine replication types. The protection limit for array-based replication is 5,000 virtual machines. The protection limit for vSphere Replication is 2,000 virtual machines. However, the maximum number of virtual machines that you can protect by using a combination of array-based and vSphere Replication is still 5,000 virtual machines, and not 7,000.

If you protect 2,000 virtual machines with vSphere Replication, you can protect a maximum of another 3,000 virtual machines with array-based replication.

If you protect 1,000 virtual machines with array-based replication, you can protect a maximum of another 2,000 virtual machines with vSphere Replication.

### Bidirectional Protection

If you establish bidirectional protection, in which site B serves as the recovery site for site A and at the same time site A serves as the recovery site for site B, limits apply across both sites, and not per site. In a bidirectional implementation, you can protect a different number of virtual machines on each site, but the total number of protected virtual machines across both sites cannot exceed the limits.

If you protect 3,000 virtual machines using array-based replication from site A to site B, you can use array-based replication to protect a maximum of 2,000 virtual machines from site B to site A. If you are using array-based replication for bidirectional protection, you can protect a total of 5,000 virtual machines across both sites.
If you protect 1500 virtual machines using vSphere Replication from site A to site B, you can use vSphere Replication to protect a maximum of 500 virtual machines from site B to site A. If you are using vSphere Replication for bidirectional protection, you can protect a maximum of 2000 virtual machines across both sites.

If you protect 3,000 virtual machines using array-based replication from site A to site B and 1,000 virtual machines using vSphere Replication from site A to site B, you can protect a maximum of 1,000 virtual machines from site B to site A. If you are using a combination of array-based replication and vSphere Replication for bidirectional protection, you can protect a maximum of 5,000 virtual machines across both sites, of which you can protect a maximum of 2,000 by using vSphere Replication.

### Recovery Maximums for Site Recovery Manager 8.3

<table>
<thead>
<tr>
<th>Item</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total number of concurrently running recovery plans.</td>
<td>10</td>
</tr>
<tr>
<td>Total number of virtual machine recoveries that you can start</td>
<td>2000</td>
</tr>
<tr>
<td>simultaneously, for array-based replication, vSphere Replication,</td>
<td></td>
</tr>
<tr>
<td>and storage policy protection combined, across multiple</td>
<td></td>
</tr>
<tr>
<td>recovery plans.</td>
<td></td>
</tr>
</tbody>
</table>

If you protect 5000 virtual machines with Site Recovery Manager, you can recover up to 2000 virtual machines in one recovery plan. After that plan has finished, you can run another recovery plan to recover another 2000 virtual machines. When the second plan has also completed, you can recover the remaining 1000 virtual machines.

If you have five recovery plans that each contain 1000 virtual machines, you can run a maximum of two of these plans at the same time. If you have 10 recovery plans that each contains 200 virtual machines, you can run all 10 plans at the same time.

### IP Customization Maximums for Site Recovery Manager 8.3

If you implement IP customization for recovered virtual machines, you can configure a maximum of one IP address for each NIC, using DHCP, static IPv4, or static IPv6. For static IPv4 or IPv6 addresses, you provide the following information per NIC:

- 1 IP address
- Subnet information
- 1 gateway server address
- 2 DNS servers (primary and secondary)

You also set 2 WINS addresses for DHCP or IPv4, on Windows virtual machines only.
Deployment Maximums for Site Recovery Manager 8.3 in a Shared Recovery Site Configuration

In a shared recovery site configuration, you can deploy a maximum of 10 Site Recovery Manager server instances for each vCenter Server instance. The limits apply to each Site Recovery Manager pair in a shared recovery site configuration.
Creating the Site Recovery Manager Database

The Site Recovery Manager Server requires its own database, which it uses to store data such as recovery plans and inventory information.

Site Recovery Manager provides an embedded vPostgreSQL database that requires fewer steps to configure than an external database. The embedded vPostgreSQL database can support a full-scale Site Recovery Manager environment. You can select the option to use the embedded database when you install Site Recovery Manager. The Site Recovery Manager installer creates the embedded database and a database user account according to the information that you specify during installation.

You can also use an external database. If you use an external database, you must create the database and establish a database connection before you can install Site Recovery Manager.

Site Recovery Manager cannot use the vCenter Server database because it has different database schema requirements. You can use the vCenter Server database server to create and support the Site Recovery Manager database.

Each Site Recovery Manager site requires its own instance of the Site Recovery Manager database. Use a different database server instance to run the individual Site Recovery Manager databases for each site. If you use the same database server instance to run the databases for both sites, and if the database server experiences a problem, neither Site Recovery Manager site will work and you will not be able to perform a recovery.

Site Recovery Manager does not require the databases on each site to be identical. You can run different versions of a supported database from the same vendor on each site, or you can run databases from different vendors on each site. For example, you can run different versions of Oracle Server on each site, or you can have an Oracle Server database on one site and the embedded database on the other.

If you are updating Site Recovery Manager to a new version, you can use the existing database. Before you attempt an upgrade, make sure that both Site Recovery Manager Server databases are backed up. Doing so helps ensure that you can revert back to the previous version after the upgrade, if necessary.

- **Requirements when Using Microsoft SQL Server with Site Recovery Manager**
  When you create a Microsoft SQL Server database, you must configure it correctly to support Site Recovery Manager.

- **Requirements for Using Oracle Server with Site Recovery Manager**
  When you create an Oracle Server database, you must configure it correctly to support Site Recovery Manager.

- **Back Up and Restore the Embedded vPostgres Database**
  If you select the option to use an embedded database for Site Recovery Manager, the Site Recovery Manager installer creates a vPostgres database during the installation process. You can back up and restore the embedded vPostgres database by using PostgreSQL commands.

- **Create an ODBC System DSN for Site Recovery Manager**
  You must provide Site Recovery Manager with a system database source name (DSN) for a 64-bit open database connectivity (ODBC) connector. The ODBC connector allows Site Recovery Manager to connect to the Site Recovery Manager database.

---

### Requirements when Using Microsoft SQL Server with Site Recovery Manager

When you create a Microsoft SQL Server database, you must configure it correctly to support Site Recovery Manager.

This information provides the requirements for an SQL Server database for use with Site Recovery Manager. For specific instructions about creating an SQL Server database, see the SQL Server documentation.

- **Database user account:**
  - If you use Integrated Windows Authentication to connect to SQL Server and SQL Server runs on the same machine as Site Recovery Manager Server, use a local or domain account that has administrative privileges on the Site Recovery Manager Server machine. Use the same account or an account with the same privileges when you install Site Recovery Manager Server. When the Site Recovery Manager installer detects an SQL Server data source name (DSN) that uses Integrated Windows Authentication, it configures Site Recovery Manager Server to run under the same account as you use for the installer, to guarantee that Site Recovery Manager can connect to the database.

  - If you use Integrated Windows Authentication to connect to SQL Server and SQL Server runs on a different machine from Site Recovery Manager Server, use a domain account with administrative privileges on the Site Recovery Manager Server machine. Use the same account or an account with the same privileges when you install Site Recovery Manager Server. When the Site Recovery Manager installer detects an SQL Server data source name (DSN) that uses Integrated Windows Authentication, it configures Site Recovery Manager Server to run under the same account as you use for the installer, to guarantee that Site Recovery Manager can connect to the database.
If you use SQL authentication, you can run the Site Recovery Manager service under the Windows Local System account, even if SQL Server is running on a different machine to Site Recovery Manager Server. The Site Recovery Manager installer configures the Site Recovery Manager service to run under the Windows Local System account by default.

Make sure that the Site Recovery Manager database user account has the **ADMINISTER BULK OPERATIONS**, **CONNECT**, and **CREATE TABLE** permissions.

Database schema:

- The Site Recovery Manager database schema must have the same name as the database user account.
- The Site Recovery Manager database user must be the owner of the Site Recovery Manager database schema.
- The Site Recovery Manager database schema must be the default schema for the Site Recovery Manager database user.
- The Site Recovery Manager database must be the default database for all SQL connections that Site Recovery Manager makes. You can set the default database either in the user account configuration in SQL Server or in the DSN.
- Map the database user account to the database login.

For information about database sizing, see the [Sizing calculator for vCenter Site Recovery Manager databases - MSSQL](https://www.vmware.com/products/site-recovery-manager/resource.html).

**Requirements for Using Oracle Server with Site Recovery Manager**

When you create an Oracle Server database, you must configure it correctly to support Site Recovery Manager.

You create and configure an Oracle Server database for Site Recovery Manager by using the tools that Oracle Server provides.

This information provides the general steps that you must perform to configure an Oracle Server database for Site Recovery Manager. For instructions about how to perform the relevant steps, see the Oracle documentation.

- When creating the database instance, specify UTF-8 encoding.
- Grant the Site Recovery Manager database user account the **connect**, **resource**, **create session** privileges and permissions.

For information about database sizing, see the [Sizing calculator for vCenter Site Recovery Manager databases - Oracle](https://www.vmware.com/products/site-recovery-manager/resource.html).
Back Up and Restore the Embedded vPostgres Database

If you select the option to use an embedded database for Site Recovery Manager, the Site Recovery Manager installer creates a vPostgres database during the installation process. You can back up and restore the embedded vPostgres database by using PostgreSQL commands.

Always back up the Site Recovery Manager database before updating or upgrading Site Recovery Manager. You also might need to back up and restore the embedded vPostgres database if you need to uninstall then reinstall Site Recovery Manager and retain data from the previous installation, migrate Site Recovery Manager Server to another host machine, or revert the database to a clean state in the event that it becomes corrupted.

Prerequisites

For information about the commands that you use to back up and restore the embedded vPostgres database, see the pg_dump and pg_restore commands in the PostgreSQL documentation at https://www.postgresql.org/docs/9.3/static/index.html.

Procedure

1. Log into the system on which you installed Site Recovery Manager Server.
2. Stop the Site Recovery Manager service.
3. Navigate to the folder that contains the vPostgres commands.
   
   If you installed Site Recovery Manager Server in the default location, you find the vPostgres commands in C:\Program Files\VMware\VMware vCenter Site Recovery Manager Embedded Database\bin.

4. Create a backup of the embedded vPostgres database by using the pg_dump command.

   
   pg_dump -Fc --host 127.0.0.1 --port port_number --username=db_username srm_db > srm_backup_name

   You set the port number, username, and password for the embedded vPostgres database when you installed Site Recovery Manager. The default port number is 5678. The database name is srm_db and cannot be changed.

5. Perform the actions that necessitate the backup of the embedded vPostgres database.

   For example, update or upgrade Site Recovery Manager, uninstall and reinstall Site Recovery Manager, or migrate Site Recovery Manager Server.

6. (Optional) Restore the database from the backup that you created in Step 4 by using the pg_restore command.

   pg_restore -Fc --host 127.0.0.1 --port port_number --username=db_username --dbname=srm_db srm_backup_name

7. Start the Site Recovery Manager service.
Create an ODBC System DSN for Site Recovery Manager

You must provide Site Recovery Manager with a system database source name (DSN) for a 64-bit open database connectivity (ODBC) connector. The ODBC connector allows Site Recovery Manager to connect to the Site Recovery Manager database.

You can create the ODBC system DSN before you run the Site Recovery Manager installer by running odbcad32.exe, the 64-bit Windows ODBC Administrator tool.

Alternatively, you can create an ODBC system DSN by running the Windows ODBC Administrator tool during the Site Recovery Manager installation process.

**Note**  If you use the embedded Site Recovery Manager database, the Site Recovery Manager installer creates the ODBC system DSN according to the information that you provide during installation. If you uninstall the embedded database, the uninstaller does not remove the DSN for the embedded database. The DSN remains available for use with a future reinstallation of Site Recovery Manager.

**Prerequisites**

You created the database instance to connect to Site Recovery Manager.

**Procedure**

1. Double-click the odbcad32.exe file at C:\Windows\System32 to open the 64-bit ODBC Administrator tool.

   **Important**  Do not confuse the 64-bit Windows ODBC Administrator tool with the 32-bit ODBC Administrator tool located in C:\Windows\SysWOW64. Do not use the 32-bit ODBC Administrator tool.

2. Click the **System DSN** tab and click **Add**.

3. Select the appropriate ODBC driver for your database software and click **Finish**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Server</td>
<td>Select SQL Server Native Client 10.0, SQL Server Native Client 11.0, or ODBC Driver 11 for SQL Server.</td>
</tr>
<tr>
<td>Oracle Server</td>
<td>Select Microsoft ODBC for Oracle.</td>
</tr>
</tbody>
</table>
4  (Optional) Create an SQL Server data source for the database.
   a  Provide the details for the data source.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for this data source, for example SRM.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the data source, for example SRM.</td>
</tr>
<tr>
<td>Server</td>
<td>Select the running database instance to which to connect or enter the address of the database server.</td>
</tr>
</tbody>
</table>

b  Select the authentication method that corresponds to the type of database user account that you created and click **Next**.

If you select Integrated Windows Authentication, you must use the same user account, or an account with the same privileges on the Site Recovery Manager Server host machine, when you run the Site Recovery Manager.

c  Select the **Change the default database to** check box and select the Site Recovery Manager database.

d  Click **Next** to retain the default settings for this database connection and click **Finish**.

5  (Optional) Create an Oracle Server data source for the database and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source Name</td>
<td>Enter a name for this data source, for example SRM.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the data source, for example SRM.</td>
</tr>
<tr>
<td>TNS Service Name</td>
<td>Enter the address of the database server in the format <code>database_server_address:1521/database_name</code></td>
</tr>
<tr>
<td>User ID</td>
<td>Enter the database user name.</td>
</tr>
</tbody>
</table>

6  Click **Test Data Source** to test the connection and click **OK** if the test succeeds.

If the test does not succeed, check the configuration information and try again.

7  Click **OK** to exit the Windows ODBC Administrator tool.

**Results**

The ODBC driver for your database is ready to use.
Site Recovery Manager Authentication

The Platform Services Controller handles the authentication between Site Recovery Manager and vCenter Server at the vCenter Single Sign-On level.

All communications between Site Recovery Manager and vCenter Server instances take place over transport layer security (TLS) connections. Previous versions of Site Recovery Manager supported both secure sockets layer (SSL) and TLS connections. This version of Site Recovery Manager only supports TLS, due to weaknesses identified in SSL 3.0.

Solution User Authentication

Site Recovery Manager uses solution user authentication to establish secure communication to remote services, such as the Platform Services Controller and vCenter Server. A solution user is a security principal that the Site Recovery Manager installer generates. The installer assigns a private key and a certificate to the solution user and registers it with the vCenter Single Sign-On service. The solution user is tied to a specific Site Recovery Manager instance. You cannot access the solution user private key or certificate. You cannot replace the solution user certificate with a custom certificate.

After installation, you can see the Site Recovery Manager solution user in the Administration view of the vSphere Web Client. Do not attempt to manipulate the Site Recovery Manager solution user. The solution user is for internal use by Site Recovery Manager, vCenter Server, and vCenter Single Sign-On.

During operation, Site Recovery Manager establishes authenticated communication channels to remote services by using certificate-based authentication to acquire a holder-of-key SAML token from vCenter Single Sign-On. Site Recovery Manager sends this token in a cryptographically signed request to the remote service. The remote service validates the token and establishes the identity of the solution user.

Solution Users and Site Recovery Manager Site Pairing

When you pair Site Recovery Manager instances across vCenter Single Sign-On sites that do not use Enhanced Linked Mode, Site Recovery Manager creates an additional solution user for the remote site at each site. This solution user for the remote site allows the Site Recovery Manager Server at the remote site to authenticate to services on the local site.
When you pair Site Recovery Manager instances in a vCenter Single Sign-On environment with Enhanced Linked Mode, Site Recovery Manager at the remote site uses the same solution user to authenticate to services on the local site.

**Site Recovery Manager SSL/TLS Server Endpoint Certificates**

Site Recovery Manager requires an SSL/TLS certificate for use as the endpoint certificate for all TLS connections established to Site Recovery Manager. The Site Recovery Manager server endpoint certificate is separate and distinct from the certificate that is generated during the creation and registration of a Site Recovery Manager solution user.

For information about the Site Recovery Manager SSL/TLS endpoint certificate, see Chapter 5 Creating SSL/TLS Server Endpoint Certificates for Site Recovery Manager.
Creating SSL/TLS Server Endpoint Certificates for Site Recovery Manager

The Site Recovery Manager server endpoint certificate establishes the identity of Site Recovery Manager Server to clients. The endpoint certificate secures the communication between the client and Site Recovery Manager Server.

During installation of Site Recovery Manager, there is an option for Site Recovery Manager to generate an SSL/TLS certificate to use as the Site Recovery Manager endpoint certificate. This is the simpler option that requires minimal user action.

You can also provide a custom SSL/TLS certificate that is signed by a certificate authority. If you use a custom SSL/TLS certificate, the certificate must meet certain requirements to work with Site Recovery Manager.

Note Unlike in 5.x releases, Site Recovery Manager 8.x does not also use custom SSL/TLS certificates to authenticate with vCenter Server. For information about how Site Recovery Manager authenticates with vCenter Server, see Chapter 4 Site Recovery Manager Authentication.

This chapter includes the following topics:

- Requirements When Using Custom SSL/TLS Certificates with Site Recovery Manager
- Enable the SHA-1 Hashing Function

Requirements When Using Custom SSL/TLS Certificates with Site Recovery Manager

If you use custom SSL/TLS certificates for the Site Recovery Manager server endpoint certificate, the certificates must meet specific criteria.

Site Recovery Manager 8.x uses standard PKCS#12 certificates. Site Recovery Manager places some requirements on the contents of those certificates.

- Site Recovery Manager does not accept certificates with MD5 signature algorithms. Use SHA256 or stronger signature algorithms.
- By default, Site Recovery Manager does not accepts certificates with SHA-1 signature algorithms. Use SHA256 or stronger signature algorithms.
The Site Recovery Manager certificate is not the root of a trust chain. You can use an intermediate CA certificate which is not the root of a trust chain, but that is still a CA certificate.

If you use a custom certificate for vCenter Server and Platform Services Controller, you are not obliged to use a custom certificate for Site Recovery Manager. The reverse is also true.

The private key in the PKCS #12 file must match the certificate. The minimum length of the private key is 2048 bits.

The Site Recovery Manager certificate password must not exceed 31 characters.

The current time must be within the period of validity of the certificate.

The certificate must be a server certificate, for which the x509v3 Extended Key Usage must indicate TLS Web Server Authentication.

- The certificate must include an extendedKeyUsage or enhancedKeyUsage attribute, the value of which is serverAuth.
- There is no requirement for the certificate to also be a client certificate. The clientAuth value is not required.

The Subject Name must not be empty and must contain fewer than 4096 characters. In this release, the Subject Name does not need to be the same for both members of a Site Recovery Manager Server pair.

The certificate must identify the Site Recovery Manager Server host.

- The recommended way to identify the Site Recovery Manager Server host is with the host's fully-qualified domain name (FQDN). If the certificate identifies the Site Recovery Manager Server host with an IP address, this must be an IPv4 address. Using IPv6 addresses to identify the host is not supported.
- Certificates generally identify the host in the Subject Alternative Name (SAN) attribute. Some CAs issue certificates that identify the host in the Common Name (CN) value of the Subject Name attribute. Site Recovery Manager accepts certificates that identify the host in the CN value, but this is not the best practice. For information about SAN and CN best practices, see the Internet Engineering Task Force (IETF) RFC 6125 at https://tools.ietf.org/html/rfc6125.
- The host identifier in the certificate must match the Site Recovery Manager Server local host address that you specify when you install Site Recovery Manager.

If Site Recovery Manager Server, vCenter Server, and Platform Services Controller run on the same host machine, you can use the same certificate for all three servers. In this case, you must provide the certificate in two formats:

- For Site Recovery Manager, the certificate must be a Personal Information Exchange Format (PKCS#12) certificate that contains both of the private and public keys.
- For vCenter Server and Platform Services Controller, the certificate must be separated into two files, one for the certificate with the public key and one for the private key. For information about certificate requirements for vCenter Server and Platform Services Controller, see vSphere Security Certificates in the vSphere 6.7 documentation.
If you use a custom certificate that is signed by a third-party CA for which the root certificate is not registered by default in Windows, and you want the certificates to be trusted without the need for thumbprint verifications, install the root CA certificate in the Windows certificate store.

Enable the SHA-1 Hashing Function

You can install certificates, signed with the SHA-1 hashing function in the Site Recovery Manager Appliance in case your environment requires it.

By default, the Site Recovery Manager server rejects installation of new certificates, which are signed with the SHA-1 hashing function. To install a certificate, signed with the SHA-1 hashing function, you must enable it in the Site Recovery Manager Appliance.

Procedure

1. Establish an SSH connection to the Site Recovery Manager Appliance.

2. Navigate to the /opt/vmware/srm/conf/ folder and open the vmware-dr.xml and the drconfig.xml files in a text editor.

3. Find the <connections> section and add a <allowSha1> section.

   <connections>
   <allowSha1>true</allowSha1>
   </connections>

4. Save the files and restart the Site Recovery Manager Server service.

5. Use the following command to restart the dr-configurator service.

   sudo systemctl restart dr-configurator
Installing Site Recovery Manager for Windows

You must install a Site Recovery Manager Server instance at the protected site and also at the recovery site.

Site Recovery Manager requires a vCenter Server instance of the appropriate version at each site before you install Site Recovery Manager Server. The Site Recovery Manager installer must be able to connect to this vCenter Server instance during installation. For information about compatibility between vCenter Server and Site Recovery Manager versions, see vCenter Server Requirements in the Compatibility Matrices for Site Recovery Manager 8.3 at https://docs.vmware.com/en/Site-Recovery-Manager/8.3/rn/srm-compat-matrix-8-3.html.

After you install the Site Recovery Manager Server instances, the Site Recovery Manager plug-in appears in the vSphere Web Client. You use the Site Recovery Manager plug-in in the vSphere Web Client for the vCenter Server instances on the protected and recovery sites to configure and manage Site Recovery Manager. Site Recovery Manager 5.8 or later does not support the vSphere Client for Windows.

Procedure

1 Site Recovery Manager and vCenter Server Deployment Models
   You can install Site Recovery Manager in any of the deployment models that vCenter Server supports. However, the vCenter Server deployment model that you select can have implications for Site Recovery Manager operation.

2 Prerequisites and Best Practices for Site Recovery Manager Server Installation
   Before you install Site Recovery Manager Server, you must perform several tasks and verify that you have certain information.

3 Install Site Recovery Manager Server for Windows
   You must install Site Recovery Manager Server at the protected site and at the recovery site.

4 Connect the Site Recovery Manager Server Instances on the Protected and Recovery Sites
   Before you can use Site Recovery Manager, you must connect the Site Recovery Manager Server instances on the protected and recovery sites. This is known as site pairing.

5 Reconnect a Site Pair and Breaking a Site Pair
   You can reconfigure or break an existing site pair.
6 Establish a Client Connection to the Remote Site Recovery Manager Server Instance
   After you connect the Site Recovery Manager Server instances, you must establish a connection from the Site Recovery Manager interface in the vSphere Web Client to the remote Site Recovery Manager Server.

7 Install the Site Recovery Manager License Key
   Site Recovery Manager Server requires a license key to operate. Install a Site Recovery Manager license key as soon as possible after you install Site Recovery Manager.

8 Site Recovery Manager Server Does Not Start
   Site Recovery Manager depends on other services. If one of those services is not running, the Site Recovery Manager Server does not start.

9 Unregister an Incompatible Version of vSphere Replication
   Site Recovery Manager requires the corresponding version of vSphere Replication. The Site Recovery Manager installer verifies the version of vSphere Replication and stops if it detects an incompatible version.

Site Recovery Manager and vCenter Server Deployment Models

You can install Site Recovery Manager in any of the deployment models that vCenter Server supports. However, the vCenter Server deployment model that you select can have implications for Site Recovery Manager operation.

You deploy vCenter Server with a Platform Services Controller. You can either embed the Platform Services Controller with vCenter Server or it can be external to vCenter Server. Several vCenter Server instances can share the same external Platform Services Controller.

You can deploy the Platform Services Controller in several different configurations.

- Each Platform Services Controller can have its own vCenter Single Sign-On domain.
- Several Platform Services Controller instances can join the same vCenter Single Sign-On domain.
- You can configure vCenter Single Sign-On domains in Enhanced Linked Mode, which federates all of the Platform Services Controller instances from each of the linked domains.

For information about the deployment models that vCenter Server supports, see Deploying the vCenter Server Appliance and Platform Services Controller Appliance in vCenter Server Installation and Setup.

You must take the deployment model of vCenter Server and Platform Services Controller into consideration when you install Site Recovery Manager. During a disaster recovery, Site Recovery Manager, vCenter Server, and the associated Platform Services Controller must be up and running on the recovery site.
Configuring the Platform Services Controller and Selecting the Correct vCenter Server Instance in an Enhanced Linked Mode Environment

When you install Site Recovery Manager Server, you provide the address of the Platform Services Controller that is associated with the vCenter Server instance to protect. You then select the vCenter Server instance with which to register Site Recovery Manager from the list of all of the vCenter Server instances that this Platform Services Controller serves. In an Enhanced Linked Mode environment, that list might include vCenter Server instances from other sites. If you select the wrong vCenter Server instance and complete the Site Recovery Manager installation, you cannot subsequently modify the Site Recovery Manager installation to select the correct vCenter Server instance. In this case, you must uninstall and reinstall Site Recovery Manager to select the correct vCenter Server instance.

- When you install Site Recovery Manager Server on the protected site, make sure that you select the vCenter Server instance that manages the virtual machines to protect.
- When you install Site Recovery Manager Server on the recovery site, make sure that you select the vCenter Server instance to which to recover virtual machines.
- Ensure that the Platform Services Controller, vCenter Server, and Site Recovery Manager Server are all located on the protected site, or all on the recovery site.

After you have installed Site Recovery Manager, if vCenter Server migrates to a different Platform Services Controller or if the address of the Platform Services Controller changes, you can reconfigure Site Recovery Manager with the new Platform Services Controller address. For example, you can change from an embedded Platform Services Controller to an external Platform Services Controller. For information about changing Platform Services Controller, see Converging vCenter Server with an External Platform Services Controller to a vCenter Server with an Embedded Platform Services Controller in vCenter Server Installation and Setup.

You change the Platform Services Controller address by running the Site Recovery Manager installer in Modify mode.

Sharing Platform Services Controller Instances Across Site Recovery Manager Sites

A single point of failure is created if you share a Platform Services Controller instance between the protected and recovery sites. If the shared Platform Services Controller goes offline, neither the protected site nor the recovery site will function, making recovery impossible.
Concurrent Installations of Site Recovery Manager in an Enhanced Linked Mode Environment

In an Enhanced Linked Mode environment, do not install Site Recovery Manager under more than one Platform Services Controller at the same time. A conflict can arise in the creation of the solution user that Platform Services Controller creates at the domain level for Site Recovery Manager authentication with vCenter Server if the following conditions exist:

- If the installation of one Site Recovery Manager Server instance overlaps with the installation of another Site Recovery Manager Server instance under two different Platform Services Controller instances.
- Those Platform Services Controller instances are in Enhanced Linked Mode.

The conflict does not prevent installation, but it does cause one of the Site Recovery Manager Server instances to fail to start, with the error message Failed to start service. The message Failed to start Authorization Manager appears in the event log for that Site Recovery Manager Server instance.

Site Recovery Manager and External Platform Services Controller Instances

Site Recovery Manager supports Platform Services Controller HA, a load-balanced pair of Platform Services Controller instances which uses a third-party load balancer. For more information about supported load balancers, see vCenter HA Deployment Options in the vSphere Availability documentation.

Site Recovery Manager in a Two-Site Topology with One vCenter Server Instance per Platform Services Controller

The most common deployment for Site Recovery Manager is to have two sites with one vCenter Server instance per Platform Services Controller.

In this configuration, the Platform Services Controller instances can be either external to vCenter Server or embedded in the vCenter Server instances.

The Platform Services Controller instances can belong to vCenter Single Sign-On domains that are either in Enhanced Linked Mode or are not in Enhanced Linked Mode.
Site Recovery Manager in a Two-Site Topology with One vCenter Server Instance per Platform Services Controller

You can deploy Site Recovery Manager in a topology in which multiple vCenter Server instances share a Platform Services Controller on each site.

In this configuration, the Platform Services Controller instances are external to the vCenter Server instances.

The Platform Services Controller instances can belong to vCenter Single Sign-On domains that are either in Enhanced Linked Mode or are not in Enhanced Linked Mode.
Figure 6-2. Site Recovery Manager in a Two-Site Topology with Two vCenter Server Instances per Platform Services Controller

Site Recovery Manager in a Single Site Topology with a Shared Platform Services Controller

You can deploy Site Recovery Manager Server so that both instances connect to vCenter Server instances that share a Platform Services Controller.

In this configuration, both vCenter Server instances connect to the same Platform Services Controller within a single site.

Important When the vCenter Server instances on the protected and recovery sites share the same Platform Services Controller, the Platform Services Controller becomes a single point of failure. If the Platform Services Controller goes offline, neither of the protected and recovery sites can function, and recovery is impossible. This configuration is not appropriate for disaster recovery, and is not recommended.
Prerequisites and Best Practices for Site Recovery Manager Server Installation

Before you install Site Recovery Manager Server, you must perform several tasks and verify that you have certain information.

- Install the appropriate version of Platform Services Controller and vCenter Server on both sites. For information about compatibility between vCenter Server and Site Recovery Manager versions, see vCenter Server Requirements in the Compatibility Matrices for Site Recovery Manager 8.3 at https://docs.vmware.com/en/Site-Recovery-Manager/8.3/rn/srm-compat-matrix-8-3.html.

- When you install and configure Platform Services Controller, vCenter Server, and vSphere Replication, use fully qualified domain names (FQDN) whenever possible rather than IP addresses. Using FQDN rather than IP addresses allows you to change the vSphere infrastructure, for example by using DHCP, without having to redeploy or reconfigure Site Recovery Manager. You must also use FQDN if you use custom certificates, because most certificate authorities do not accept certificates that use IP addresses for the SAN or CN value.

- The way in which you deploy Platform Services Controller, vCenter Server, and vCenter Single Sign-On on a site affects how you deploy Site Recovery Manager. For information about how the vCenter Server deployment model affects Site Recovery Manager, see Site Recovery Manager and vCenter Server Deployment Models.

- Obtain the address of the Platform Services Controller instance for both sites. The Platform Services Controller must be running and accessible during Site Recovery Manager installation.
Synchronize the clock settings of the systems on which Platform Services Controller, vCenter Server, and Site Recovery Manager Server run. To avoid conflicts in the time management across these systems, use a persistent synchronization agent such as network time protocol daemon (NTPD), W32Time, or VMware Tools time synchronization. If you run Platform Services Controller, vCenter Server, and Site Recovery Manager Server in virtual machines, set up NTP time synchronization on the ESXi host on which the virtual machines run. For information about timekeeping best practices, see http://kb.vmware.com/kb/1318.

The Site Recovery Manager installer presents the SSL/TLS certificate of the Platform Services Controller for validation when it runs. Obtain the necessary information to allow you validate the certificate.

Obtain the vCenter Single Sign-On administrator user name and password for both of the local and remote sites.

Download the Site Recovery Manager installation file to a folder on the machine on which to install Site Recovery Manager.

Obtain a Windows user account with the appropriate privileges on the system on which to install and run Site Recovery Manager Server. You can configure the Site Recovery Manager service to run under a specified user account. The account can be a local user or a domain user that is a member of the Administrators group on the machine on which you are installing Site Recovery Manager. Alternatively, you can configure Site Recovery Manager to run under the Local System account during installation.

Verify that no reboot is pending on the Windows machine on which to install Site Recovery Manager Server. Verify that no other installation is running, including the silent installation of Windows updates. Pending reboots or running installations can cause the installation of Site Recovery Manager Server or the embedded Site Recovery Manager database to fail.

For environments with a small number of virtual machines to protect, you can run Site Recovery Manager Server and vCenter Server on the same system. For environments that approach the maximum limits of Site Recovery Manager and vCenter Server, install Site Recovery Manager Server on a system that is different from the system on which vCenter Server is installed. If Site Recovery Manager Server and vCenter Server are installed on the same system, administrative tasks might become more difficult to perform in large environments. Furthermore, if you install Site Recovery Manager Server in a virtual machine, and this virtual machine is not the same as the one that runs vCenter Server, you can use vSphere High Availability and VMware Fault Tolerance to protect the Site Recovery Manager Server virtual machine.

If you use custom certificates, obtain an appropriate certificate file. See Requirements When Using Custom SSL/TLS Certificates with Site Recovery Manager.

If you configure Site Recovery Manager in an IPv6 network, verify that the IPv6 address of the Site Recovery Manager Server, vCenter Server, the ESXi hosts, and the external database, if used, are mapped to fully qualified domain names on the DNS server. Install the Site Recovery Manager Server using FQDN and use only FQDNs, not static IPv6 addresses, for all connections.
Obtain the user name and password for the Site Recovery Manager database, if you are not using the embedded database.

If you do not use the embedded Site Recovery Manager database, Site Recovery Manager requires a database source name (DSN) for 64-bit open database connectivity (ODBC). You can create the ODBC system DSN before you run the Site Recovery Manager installer, or you can create the DSN during the installation process. For details about creating the ODBC system DSN, see Create an ODBC System DSN for Site Recovery Manager. If you use the embedded Site Recovery Manager database, the Site Recovery Manager installer creates the necessary DSN.

If you do not use the embedded Site Recovery Manager database, configure and start the Site Recovery Manager database service on both sites before you install the Site Recovery Manager Server. Each Site Recovery Manager instance requires its own database. See Chapter 3 Creating the Site Recovery Manager Database.

To use Site Recovery Manager with vSphere Replication, deploy the appropriate version of vSphere Replication on both of the protected and recovery sites before you install Site Recovery Manager Server. The Site Recovery Manager installer verifies the version of vSphere Replication during installation and stops if it detects an incompatible version. This verification is not performed if you install vSphere Replication after you install Site Recovery Manager Server, which might lead to incompatible versions. Incompatible versions of Site Recovery Manager and vSphere Replication cause the vSphere Web Client to stop working. For information about compatibility between vSphere Replication and Site Recovery Manager versions, see vSphere Replication Requirements in the Compatibility Matrices for Site Recovery Manager 8.3 at https://docs.vmware.com/en/Site-Recovery-Manager/8.3/rn/srm-compat-matrix-8-3.html.

If you cannot upgrade an existing incompatible version of vSphere Replication, you must unregister vSphere Replication from both vCenter Server instances before you install Site Recovery Manager. Incompatible versions of Site Recovery Manager and vSphere Replication cause the vSphere Web Client to stop working. See Unregister an Incompatible Version of vSphere Replication.

Optimize the Adobe Flash Player settings in your browser to increase the amount of storage space that the vSphere Web Client can use. Performing a recovery with Site Recovery Manager can sometimes exceed the default amount of storage space that Flash Player is permitted to consume. For information about how to optimize the Flash Player settings for Site Recovery Manager in the vSphere Web Client, see http://kb.vmware.com/kb/2106096.

Install Site Recovery Manager Server for Windows

You must install Site Recovery Manager Server at the protected site and at the recovery site.

If you are upgrading an existing Site Recovery Manager installation, see Chapter 14 Upgrading Site Recovery Manager.

If you are installing Site Recovery Manager in a shared recovery site configuration, see Chapter 16 Installing Site Recovery Manager to Use with a Shared Recovery Site.
Prerequisites

- Perform the tasks and verify that you have the required information listed in Prerequisites and Best Practices for Site Recovery Manager Server Installation.
- If you use an SQL Server database with Integrated Windows Authentication as the Site Recovery Manager database, you must use the same user account or an account with the same privileges when you install Site Recovery Manager Server as you used when you created the Integrated Windows Authentication data source name (DSN) for SQL Server.

Procedure

1. Double-click the Site Recovery Manager installer, select an installation language, and click OK.
2. Follow the installer prompts to accept the license agreement, and verify that you satisfied the installation prerequisites.
3. Select where to install Site Recovery Manager Server, and click Next.
   - Keep the default destination folder.
   - Click Change to change the destination folder, and select a target volume.

   The default installation folder for Site Recovery Manager is C:\Program Files\VMware\VMware vCenter Site Recovery Manager. If you use a different folder, the pathname must be up to 120 characters including the end slash, and you must use ASCII characters.

4. Enter information about the Platform Services Controller at the site where you are installing Site Recovery Manager and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>The host name or IP address of the Platform Services Controller for the vCenter Server with which to register Site Recovery Manager. Enter the host name in lowercase letters. After installation is complete and you are configuring the connection between the protected and recovery sites, supply this host name or IP address exactly as you enter it here, because it is subject to case-sensitive comparisons.</td>
</tr>
<tr>
<td>HTTPS Port</td>
<td>Accept the default value of 443 or enter a new value if Platform Services Controller uses a different port. Platform Services Controller only supports connections over HTTPS and does not support HTTP connections.</td>
</tr>
<tr>
<td>Username</td>
<td>The vCenter Single Sign-On user name for the vCenter Single Sign-On domain to which this Platform Services Controller instance belongs. This user account must be a member of the vCenter Single Sign-On Administrator group on the Platform Services Controller instance. Only members of the Administrator group have the necessary permissions to create or recreate the Site Recovery Manager solution user.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for the specified vCenter Single Sign-On user name.</td>
</tr>
</tbody>
</table>
5 If prompted, verify the Platform Services Controller certificate and click **Accept** to accept it.

6 Select the vCenter Server instance with which to register Site Recovery Manager and click **Next**.

**Important**  The drop-down menu includes all of the vCenter Server instances that are registered with the Platform Services Controller. In an environment that uses Enhanced Linked Mode, it can also include vCenter Server instances from other Platform Services Controller instances. Make sure that you select the correct vCenter Server instance. Once the Site Recovery Manager installation is complete, you cannot modify it to select a different vCenter Server instance.

7 Enter information with which to register the Site Recovery Manager extension with vCenter Server, and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Site Name</td>
<td>A name for this Site Recovery Manager site, which appears in the Site Recovery Manager interface. The vCenter Server address is used by default. Use a different name for each Site Recovery Manager installation in the pair.</td>
</tr>
<tr>
<td>Administrator E-mail</td>
<td>Email address of the Site Recovery Manager administrator. This information is required even though you use the standard vCenter Server alarms to configure email notifications for Site Recovery Manager events.</td>
</tr>
<tr>
<td>Local Host</td>
<td>Name or IP address of the local host. The Site Recovery Manager installer obtains this value. Only change it if it is incorrect. For example, the local host might have more than one network interface and the one that the Site Recovery Manager installer detects is not the interface you want to use.</td>
</tr>
<tr>
<td>Listener Port</td>
<td>HTTPS port for all management traffic to Site Recovery Manager Server, including traffic with external API clients for task automation. The port is also used by vSphere Web Client to download the Site Recovery Manager client plug-in. This port must be accessible from the vCenter Server proxy system. Do not change the port unless the default of 9086 causes port conflicts.</td>
</tr>
<tr>
<td>Note</td>
<td>Changing the listener port prevents you from using the VMware Site Recovery service on VMware Cloud on AWS.</td>
</tr>
<tr>
<td>SRM UI Port</td>
<td>HTTPS port for the Site Recovery Manager user interface. The default port is 443. If the Platform Services Controller is installed on the same machine, you must change this port.</td>
</tr>
</tbody>
</table>
8 Select the default Site Recovery Manager plug-in identifier, or create a plug-in identifier for this Site Recovery Manager Server pair, and click Next.

Both Site Recovery Manager Server instances in a site pair must use the same plug-in identifier.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default SRM Plug-in Identifier</td>
<td>Use this option when you install Site Recovery Manager in a standard configuration with one protected site and one recovery site.</td>
</tr>
<tr>
<td>Custom SRM Plug-in Identifier</td>
<td>Use this option when you install Site Recovery Manager in a shared recovery site configuration, with multiple protected sites and one recovery site. Enter the details of the plug-in identifier.</td>
</tr>
</tbody>
</table>

- **Plug-in ID**
  - A unique identifier. Assign the same identifier to the Site Recovery Manager Server instances on the protected site and the shared recovery site.

- **Organization**
  - The name of the organization to which this Site Recovery Manager Server pair belongs. This name helps to identify to Site Recovery Manager Server pairs in a shared recovery site configuration, especially when multiple organizations use the shared recovery site.

- **Description**
  - An optional description of this Site Recovery Manager Server pair.

9 Select a certificate type and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Automatically generate certificate | Use an automatically generated certificate:  
  a Select Automatically generate certificate and click Next.  
  b Enter text values for your organization and organization unit, typically your company name and the name of your group in the company.  
  c Click Next. |
| Load a certificate file      | Use a custom certificate:  
  a Select Use a PKCS#12 certificate file and click Next.  
  b Click Browse, navigate to the certificate file, and click Open. The certificate file must contain exactly one certificate with exactly one private key matching the certificate.  
  c Enter the certificate password.  
  d Click Next. |
10 Select whether to use the embedded database or a custom database, and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the embedded database server</td>
<td>Site Recovery Manager provides a built-in vPostgres database that you can use with minimal configuration.</td>
</tr>
<tr>
<td>Use a custom database server</td>
<td>Select an existing 64-bit DSN from the drop-down menu. You can also click DSN Setup to start the Windows 64-bit ODBC Administrator tool, to view the existing DSNs, or to create a new 64-bit system DSN for the Site Recovery Manager database.</td>
</tr>
</tbody>
</table>

11 Provide the Site Recovery Manager database configuration information and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source Name</td>
<td>This option is only visible if you selected Use the embedded database server. Enter a name for the DSN that the Site Recovery Manager installer creates when it creates the embedded database. The embedded database DSN can only contain alphanumeric characters and underscores.</td>
</tr>
</tbody>
</table>
| Database Username       | Enter a user name for the database user account that the Site Recovery Manager installer creates when it creates the embedded database. The embedded database username can only contain lower case alphanumeric characters and underscores.  
  **Important** Do not use postgres as the embedded database user name. The postgres user name is reserved for the vPostgres database super user.  
  Enter the user name for an existing database user account to use with a custom database. This option is disabled if you use SQL Server with Integrated Windows Authentication. In this case, the credentials of the user account running the Site Recovery Manager installer are used to authenticate with SQL Server. This account is also used to run the Site Recovery Manager service, to guarantee that Site Recovery Manager can connect to the database. |
| Database Password       | Enter a password for the database user account that the Site Recovery Manager installer creates when it creates the embedded database. The password cannot contain any white spaces, quotation marks, backslashes, or Extended ASCII characters.  
  Enter the password for an existing database user account to use with a custom database. This option is disabled if you use SQL Server with Integrated Windows Authentication. |
| Database Port           | This option is only visible if you selected Use the embedded database server. You cannot change this value if the embedded database already exists. |
### Table 1: Site Recovery Manager Server Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Count</td>
<td>Enter the initial connection pool size. If all connections are in use and a new one is needed, a connection is created as long as it does not exceed the maximum number of connections allowed. It is faster for Site Recovery Manager to use a connection from the pool than to create one. The maximum value that you can set depends on your database configuration. In most cases, it is not necessary to change this setting. Before changing this setting, consult with your database administrator. Setting the value too high can lead to database errors.</td>
</tr>
<tr>
<td>Max Connections</td>
<td>Enter the maximum number of database connections that can be open simultaneously. The maximum value that you can set depends on your database configuration. If the database administrator restricted the number of connections that the database can have open, this value cannot exceed that number. In most cases, it is not necessary to change this setting. Before you change this setting, consult with your database administrator. Setting the value too high can lead to database errors.</td>
</tr>
</tbody>
</table>

12. Select the user account under which to run the Site Recovery Manager Server service and click **Next**.

- Select **Use Local System Account** to run the Site Recovery Manager Server service under the Local System account.
- Enter the username and password of an existing LDAP user account to run the Site Recovery Manager Server service under a different user account. This can be any user account, including local users, that is a member of the built-in Administrators group.

  This option is not available if you use an SQL Server database with Integrated Windows Authentication. In this case, the Site Recovery Manager Server service runs under the account that you use to install Site Recovery Manager.

13. Click **Install**.

14. After the installation is finished, click **Finish**.

15. Repeat steps **Step 1** through **Step 14** on the other site.

### Connect the Site Recovery Manager Server Instances on the Protected and Recovery Sites

Before you can use Site Recovery Manager, you must connect the Site Recovery Manager Server instances on the protected and recovery sites. This is known as site pairing.

**Important** Site Recovery Manager does not support network address translation (NAT). If the network that you use to connect the Site Recovery Manager sites uses NAT, attempting to connect the sites results in an error. Use credential-based authentication and network routing without NAT when connecting the sites.

**Prerequisites**

- Verify that you installed Site Recovery Manager Server instances at the protected and recovery sites.
If you did not select the default plug-in ID when you installed Site Recovery Manager Server, you must have assigned the same custom plug-in ID to the Site Recovery Manager Server instances on each of the sites.

Procedure

1. In the vSphere Client or the vSphere Web Client, click **Site Recovery > Open Site Recovery**.
2. Click the **New Site Pair** button.
3. Select the first site from the list. Enter the address of the Platform Services Controller for the Site Recovery Manager Server on the second site, provide the user name and password, and click **Next**.

   The address that you provide for the Platform Services Controller must be an exact match of the address that you provided when you installed Site Recovery Manager Server on the recovery site.

   **Important** To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.

4. Select the vCenter Server and the services you want to pair, and click **Next**.
5. On the Ready to complete page, review the pairing settings, and click **Finish**.

Results

The protected and the recovery sites are connected. The pair appears under **Site Pairs** on the Site Recovery Home tab.

Reconnect a Site Pair and Breaking a Site Pair

You can reconfigure or break an existing site pair.

If you have problems with an existing site pair, you can attempt to reconnect the site pair with the **Reconnect** action. When you provide the required credentials, the reconfiguration operation attempts to repair the existing site pair.

With the **Break Site Pair** action, you can break the pairing between the Site Recovery Manager Server and vSphere Replication instances on the protected and the recovery sites. You can select which pairing to break. For example, you can break the pairing between the two Site Recovery Manager Server instances, the two vSphere Replication appliances, or both.

**Note** You cannot use the **Reconnect** action to add a missing pairing or a pairing that was manually broken with **Break Site Pair**. If your site pair is missing a pairing, you must use **New Site Pair** to configure it.
Establish a Client Connection to the Remote Site Recovery Manager Server Instance

After you connect the Site Recovery Manager Server instances, you must establish a connection from the Site Recovery Manager interface in the vSphere Web Client to the remote Site Recovery Manager Server.

You require a client connection to the remote Site Recovery Manager Server to perform operations that affect both sites, such as configuring inventory mappings and creating protection groups. If you do not establish the client connection, Site Recovery Manager prompts you to log in to the remote site when you attempt operations that affect both sites.

Prerequisites
You connected the Site Recovery Manager Server instances on the protected and recovery sites.

Procedure
1. Connect to the vSphere Client on one of the sites, and select Site Recovery > Open Site Recovery.
2. On the Site Recovery home tab, select a site pair, and click View Details.
3. Enter the vCenter Single Sign-On user name and password for the remote site, and click Log in.

Install the Site Recovery Manager License Key

Site Recovery Manager Server requires a license key to operate. Install a Site Recovery Manager license key as soon as possible after you install Site Recovery Manager.

Prerequisites
Site Recovery Manager uses the vSphere licensing infrastructure for license management. Ensure that you have sufficient vSphere licenses for Site Recovery Manager to protect and recover virtual machines on both sites.

Procedure
1. Connect vSphere Web Client to a vCenter Server instance on which Site Recovery Manager is installed.
2. On the vSphere Web Client Home tab, click Licensing.
3. Click the plus sign on the Licenses tab.
4. Enter the Site Recovery Manager license key in the License Keys text box and click Next.
5. Update the license name, review the details of the license, and click Finish.
6. Click the Assets tab and click Solutions.
7. Right-click the Site Recovery Manager site and select Assign License.
8. Select the license from the list of available licenses, and click OK.
Repeat step Step 1 through Step 8 to assign Site Recovery Manager license keys to all appropriate vCenter Server instances.

**Site Recovery Manager Server Does Not Start**

Site Recovery Manager depends on other services. If one of those services is not running, the Site Recovery Manager Server does not start.

**Problem**

After you install, repair, or modify Site Recovery Manager by running the Site Recovery Manager installer, or after you reboot the Site Recovery Manager Server, the Site Recovery Manager Server does not start, or else starts and then stops.

**Cause**

The Site Recovery Manager Server might not start if the Platform Services Controller or vCenter Server are not running, if it cannot connect to the Site Recovery Manager database, or if other services that Site Recovery Manager requires are not running.

**Solution**

1. Check the latest Site Recovery Manager Server log file and the Windows Event Viewer for errors.
   
   Most errors appear in the Site Recovery Manager Server log file. See *Collecting Site Recovery Manager Log Files* in the *Site Recovery Manager Administration* guide. Other errors can appear in the Windows Event Viewer. For example, the Site Recovery Manager database initializes before the Site Recovery Manager logging service starts. If errors occur during database initialization, they appear in the Windows Event Viewer. Errors related to certificate validity also appear in the Windows Event Viewer.

2. Verify that the Platform Services Controller and vCenter Server instances that Site Recovery Manager extends are running.
   
   If the Platform Services Controller or vCenter Server service are running on a different host to the Site Recovery Manager Server and the vCenter Server service stops, the Site Recovery Manager Server will start successfully and then stop after a short period.

3. Verify that the Site Recovery Manager database service is running.
   
   - If you use the embedded database, open the Windows Server Manager utility on the Site Recovery Manager host and select **Configuration > Services** to check that the VMware vCenter Site Recovery Manager Embedded Database service is running.
   
   - If you use an external database, check that the appropriate SQL Server or Oracle Server service is running on the database host.

4. Log in to the machine on which you installed the Site Recovery Manager Server.
5 Run the Site Recovery Manager installer in modify mode to check that the installation is configured correctly.

   To facilitate IP address changes in your infrastructure, provide fully qualified domain name (FQDN) whenever possible, rather than IP addresses.
   - Check that the address for Platform Services Controller is correct.
   - If the vCenter Single Sign-On password has changed since you installed Site Recovery Manager, enter the new password.
   - Check that the vCenter Server address is correct. If the vCenter Server address has changed since you installed Site Recovery Manager, for example if the Site Recovery Manager machine uses DHCP instead of a static address, remove, reinstall, and reconfigure Site Recovery Manager.
   - Check that the local host address for Site Recovery Manager Server is correct.
   - Check that the credentials for the Site Recovery Manager database are correct.
   - Verify that the Site Recovery Manager database permits sufficient connections. If the Site Recovery Manager logs contain the message GetConnection: Still waiting for available connections, increase the maximum number of database connections. Consult with your database administrator before changing these settings.
   - Check that the user account for the Site Recovery Manager service is correct. If you use an account other than the Local System account, check that the user name and password are correct.

6 Run the Windows ODBC Data Source Administrator utility to check that Site Recovery Manager can connect to the Site Recovery Manager database.
   a Open, C:\Windows\System32\odbcad32.exe.
   b Select the system DSN for Site Recovery Manager and click Configure.
   c Check the database settings.
      - Check that Site Recovery Manager is attempting to connect to the correct database server.
      - Check that the login credentials for the Site Recovery Manager database are correct.
      - Check that the authentication method is correct.
   d Click Test Data Source.
      If the connection is configured correctly, the ODBC Data Source Test window shows a positive result.
   e If the connection test fails, reconfigure the Site Recovery Manager database by using the administration software from your database provider.

7 Open the Windows Server Manager utility and select Configuration > Services.

8 Verify that the services that Site Recovery Manager requires are running.
   - Windows Server
Select the VMware vCenter Site Recovery Manager Server service in the Windows Server Manager utility and click Start or Restart.

Unregister an Incompatible Version of vSphere Replication

Site Recovery Manager requires the corresponding version of vSphere Replication. The Site Recovery Manager installer verifies the version of vSphere Replication and stops if it detects an incompatible version.

Problem

If you install an incompatible version of vSphere Replication after you installed this version of Site Recovery Manager, the verification of the vSphere Replication version is not performed and vSphere Web Client stops working.

Cause

vSphere Web Client stops working, if you install an incompatible version of vSphere Replication after you have installed Site Recovery Manager.

Solution

If the Site Recovery Manager installer detects an incompatible version of vSphere Replication or if you installed an incompatible version of vSphere Replication after you installed this version of Site Recovery Manager, you must upgrade vSphere Replication to the correct version.

For information about the compatible versions of vSphere Replication, see https://www.vmware.com/resources/compatibility/sim/interop_matrix.php.

If you cannot upgrade vSphere Replication to the correct version, unregister vSphere Replication from vCenter Server. For information about how to unregister vSphere Replication from vCenter Server, see Uninstall vSphere Replication and Unregister vSphere Replication from vCenter Server if the Appliance Was Deleted in vSphere Replication Administration.
Deploying the Site Recovery Manager Appliance

The Site Recovery Manager Virtual Appliance is a preconfigured virtual machine that is optimized for running Site Recovery Manager and its associated services. You deploy the appliance on an ESXi host in your vSphere environment.

You can either use the Site Recovery Manager Virtual Appliance at both the protected and the recovery site, or you can use the Site Recovery Manager Virtual Appliance at one site and Site Recovery Manager for Windows at the other site.

You can use the Site Recovery Manager Appliance Management Interface to configure the Site Recovery Manager Appliance and edit the appliance settings.

After you deploy and configure Site Recovery Manager instances on both sites, the Site Recovery Manager plug-in appears in the vSphere Web Client or the vSphere Client.

The Site Recovery Manager Appliance supports only the vPostgress embedded database.


This chapter includes the following topics:

- **Deploy the Site Recovery Manager Virtual Appliance**
- **Log In to the VMware Site Recovery Manager Appliance Management Interface**
- **Configure the Site Recovery Manager Appliance to Connect to a vCenter Server**
- **Connect to the Site Recovery Manager Appliance Embedded vPostgres Database**
- **How to Set Up a Trusted Environment for the Site Recovery Manager Virtual Appliance**
- **Use the VMware OVF Tool to Deploy the Site Recovery Manager Virtual Appliance Virtual Machine from a Client OVF Template**

**Deploy the Site Recovery Manager Virtual Appliance**

To run Site Recovery Manager and its associated services on the preconfigured Site Recovery Manager Appliance, you deploy the appliance both at the protected and at the recovery site.
Prerequisites

If you are not deploying the appliance from an online URL, download the Site Recovery Manager ISO image and mount it on a system in your environment.

Procedure

1. Log in to the vSphere Web Client or the vSphere Client on the protected site.
2. Right-click a host and select **Deploy OVF template**.
3. Provide the location of the OVF file from which to deploy the Site Recovery Manager Appliance, and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online URL</td>
<td>Select URL and provide the URL to deploy the appliance from an online URL.</td>
</tr>
</tbody>
</table>
| Downloadable ISO file   | a. Select **Local file > Browse**, and navigate to the `\bin` directory in the ISO image.  

4. Enter the name for the virtual appliance or accept the default, select, or search for a destination folder or data center for the appliance, and click **Next**.

   The name must be unique within each vCenter Server virtual machine folder.

5. Select a cluster, host, or resource pool where you want to run the deployed template, and click **Next**.

6. Review the virtual appliance details and click **Next**.

7. Accept the end-user license agreements (EULA) and click **Next**.

8. Select the number of vCPUs for the virtual appliance and click **Next**.

9. Select a destination datastore and disk format for the virtual appliance and click **Next**.

10. Select a network from the list of available networks, set the IP protocol and IP allocation, and click **Next**.

   Site Recovery Manager supports both DHCP and static IP addresses. You can also change the network settings by using the appliance management interface after installation.
11 On the **Customize template** page, select an option for the Site Recovery Manager Appliance hostname.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leave the text box blank</td>
<td>The DNS server on your network performs reverse lookup of the host name, or the Site Recovery Manager Appliance is registered with its IP address as its host name.</td>
</tr>
</tbody>
</table>
| Enter a host name               | Depending on your network settings, select one of the following options:  
  ▪ If you have assigned a static IP address to the appliance, enter an FQDN for that IP.  
  ▪ If you do not use a DNS server, enter a host name that you have already mapped to an IP address in your network. |

12 (Optional) To enable the SSHD service of the appliance, select the **Enable SSHD** check box.

13 Set the admin, database, and root user passwords, and click **Next**.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial admin user password</td>
<td>Set the password for the <em>admin</em> user account, which you use for access to the Site Recovery Manager Appliance Management Interface and for an SSH access to the appliance OS.</td>
</tr>
<tr>
<td>Initial database password</td>
<td>Set the password for the <em>srmdb</em> database account, which you use to connect to the embedded vPostgres database.</td>
</tr>
<tr>
<td>Initial root password</td>
<td>Set the password for the <em>root</em> account, which you use to log in to the OS of the virtual appliance.</td>
</tr>
<tr>
<td>NTP Servers</td>
<td>Enter one or more NTP server host names or IP addresses.</td>
</tr>
</tbody>
</table>

**Note**  The admin, database, and root user passwords must be at least eight characters long and must contain characters from four character classes: lowercase letters, uppercase letters, numbers, and special characters.

14 (Optional) To check the integrity of the Site Recovery Manager Appliance binary files, select the **File Integrity Flag** check box.

If the Site Recovery Manager Appliance detects changes to the binary files, it sends log traces to the syslog.

15 (Optional) To enable VMware HCX support, select the **HCX Flag** check box.

If you integrate Site Recovery Manager with HCX, you cannot use vSphere Replication in the same Site Recovery Manager instance.

16 Review the settings and click **Finish**.  

The Site Recovery Manager Appliance is deployed.

17 Power on the Site Recovery Manager Appliance.

18 Take a note of the IP address of the appliance and log out of the vSphere Web Client or the vSphere Client.
19 To deploy Site Recovery Manager on the recovery site, repeat the procedure.

What to do next

Configure the Site Recovery Manager Appliance instances to connect to vCenter Server at both the protected and the recovery site.

Log In to the VMware Site Recovery Manager Appliance Management Interface

To access the Site Recovery Manager Appliance configuration settings, you must log in to the Site Recovery Manager Appliance Management Interface using the admin account.

Prerequisites

Deploy the Site Recovery Manager Virtual Appliance and power it on.

Procedure

1 In a web browser, go to the Site Recovery Manager Appliance Management Interface at https://appliance-IP-address-or-FQDN.
2 Click Launch SRM Appliance Management.
3 Log in as admin.

The default password is the admin user account password that you set during the deployment of the Site Recovery Manager Appliance.

Configure the Site Recovery Manager Appliance to Connect to a vCenter Server

To start protecting virtual machines, you must configure the Site Recovery Manager Appliance to connect to a vCenter Server instance on both the protected and the recovery sites.

Prerequisites

Deploy the Site Recovery Manager Virtual Appliance and power it on.

Procedure

1 Log in to the Site Recovery Manager Appliance Management Interface as admin.
2 Click the Summary tab, and click Configure appliance.
3 On the **Platform Services Controller** page, enter the information about the site where you deployed the Site Recovery Manager Appliance.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSC host name</td>
<td>Enter the host name (in lowercase letters) or IP address of the Platform Services Controller for the vCenter Server with which to register Site Recovery Manager.</td>
</tr>
<tr>
<td>PSC port</td>
<td>Accept the default value of 443, or enter a new value if Platform Services Controller uses a different port. Platform Services Controller only supports connections over HTTPS.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the vCenter Single Sign-On user name for the vCenter Single Sign-On domain to which this Platform Services Controller instance belongs. This user account must be a member of the vCenter Single Sign-On administrator group on the Platform Services Controller instance.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for the specified vCenter Single Sign-On user name.</td>
</tr>
</tbody>
</table>

4 If prompted, click **Connect** to verify the Platform Services Controller certificate.

5 On the **vCenter Server** page, select the vCenter Server instance with which to register the Site Recovery Manager Appliance, and click **Next**.

**Caution**   The drop-down menu includes all the vCenter Server instances that are registered with the Platform Services Controller. In an environment that uses Enhanced Linked Mode, it might also include vCenter Server instances from other Platform Services Controller instances. Make sure that you select the correct vCenter Server instance. After you configure the Site Recovery Manager Appliance, you cannot select a different vCenter Server instance.
6 On the **Name and Extension** page, enter the necessary information to register the Site Recovery Manager with vCenter Server, and select the default Site Recovery Manager extension identifier, or create a custom extension identifier.

a Enter the site name, administrator email address, and local host IP address or name.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site name</td>
<td>A name for this Site Recovery Manager site, which appears in the Site Recovery Manager interface. The vCenter Server address is used by default. Use a different name for each Site Recovery Manager instance in the pair.</td>
</tr>
<tr>
<td>Administrator email</td>
<td>The email address of the Site Recovery Manager administrator. This information is required even though you use the standard vCenter Server alarms to configure email notifications for Site Recovery Manager events.</td>
</tr>
<tr>
<td>Local host</td>
<td>The name or IP address of the local host. Only change the value if the IP address is not the one that you want to use. For example, the local host might have more than one network interface, and the one that the Site Recovery Manager Appliance detects is not the interface that you want to use.</td>
</tr>
</tbody>
</table>

**Note**: To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.

b Select the default Site Recovery Manager extension identifier, or create a custom extension ID for this Site Recovery Manager pair, and click **Next**.

Both Site Recovery Manager instances in a site pair must use the same extension ID.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default extension ID</td>
<td>Use this option when you deploy Site Recovery Manager in a standard configuration with one protected site and one recovery site.</td>
</tr>
<tr>
<td>Custom extension ID</td>
<td>Use this option when you deploy Site Recovery Manager in a shared recovery site configuration, with multiple protected sites and one recovery site. Enter the details for the custom extension ID.</td>
</tr>
<tr>
<td></td>
<td>￭ Extension ID. A unique identifier. Assign the same identifier to the Site Recovery Manager instances on the protected site and the shared recovery site.</td>
</tr>
<tr>
<td></td>
<td>￭ Organization. The name of the organization to which this Site Recovery Manager sites pair belongs. This name helps to identify Site Recovery Manager pairs in a shared recovery site configuration, especially when multiple organizations use the shared recovery site.</td>
</tr>
<tr>
<td></td>
<td>￭ Description. An optional description of the Site Recovery Manager pair.</td>
</tr>
</tbody>
</table>

7 On the **Ready to Complete** page, review your settings and click **Finish**.
8 To configure the Site Recovery Manager Appliance on the other site, repeat the procedure.

**Connect to the Site Recovery Manager Appliance Embedded vPostgres Database**

If you need to access the content in the Site Recovery Manager Appliance embedded vPostgres database, you must connect to the database through the appliance OS.

**Procedure**

1. Log in to the OS of the Site Recovery Manager Appliance as admin.
   
   You set the password for the **admin** user account during the deployment of the appliance.

2. Run `/opt/vmware/vpostgres/current/bin/psql` `-U` `user` `-d` `password`. Enter a user name and its respective password which you set during the deployment of the Site Recovery Manager Appliance.

<table>
<thead>
<tr>
<th>User</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>admin</td>
<td>The embedded vPostgres database super user account.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The <strong>admin</strong> account uses the same password to access both the appliance OS and the embedded database.</td>
</tr>
<tr>
<td>srmdb</td>
<td>The embedded vPostgres database user account. Site Recovery Manager Server uses this account to access the embedded vPostgres database.</td>
</tr>
</tbody>
</table>

**How to Set Up a Trusted Environment for the Site Recovery Manager Virtual Appliance**

To set up a trusted environment with your custom root CA certificates, you must manually import the certificates into the Site Recovery Manager Virtual Appliance.

The certificates must be in a .pem format.

**Procedure**

1. Log in to the Site Recovery Manager Virtual Appliance host machine as admin.

2. Run the following command.
   
   ```bash
   su
   ```

3. Enter the root password.

4. Copy the certificates to `/etc/ssl/certs`.

5. To modify the certificates' permissions, run the following command.

   ```bash
   chmod a+r <new-root-ca>.pem
   ```

6. Run `c_rehash`. 
To import the Site Recovery Manager Server certificates, use the Site Recovery Manager Appliance Management Interface.

a. Log in to the Site Recovery Manager Appliance Management Interface as admin.

b. Click the **Access** tab, and then, in the **Certificate** pane, click **Change**.

c. Select a certificate type.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Generate a self-signed certificate.</strong></td>
<td>Use an automatically generated certificate.</td>
</tr>
<tr>
<td></td>
<td>1. Enter text values for your organization and organization unit, typically your company name, and the name of your group in the company.</td>
</tr>
<tr>
<td></td>
<td>2. Accept the default FQDN and IP values.</td>
</tr>
</tbody>
</table>

**Note** Using a self-signed certificate is not recommended for production environments.

| Use a PKCS #12 certificate file.                     | Use a custom certificate.                                                                                           |
|                                                      | 1. Click **Browse**, navigate to the certificate file, and click **Open**. The certificate file must contain exactly one certificate with exactly one private key matching the certificate. |
|                                                      | 2. (Optional) Enter the optional private key encryption password.                                                    |

| Use a CA-signed certificate generated from CSR.      | Use a CA-signed certificate generated from a CSR.                                                                    |
|                                                      | 1. In the **Certificate file** row, click **Browse**, navigate to the certificate file, and click **Open**.          |
|                                                      | 2. (Optional) In the **CA chain** row, click **Browse**, navigate to the CA chain, and click **Open**.              |

d. Click **Change**.

To import the Site Recovery HTML 5 client trust certificate in the JRE keystore, run the following command.

```bash
keytool -importcert -v -noprompt -file root.pem -alias root-ca -keystore /usr/java/jre-vmware/lib/security/cacerts -storepass changeit
```

**Use the VMware OVF Tool to Deploy the Site Recovery Manager Virtual Appliance Virtual Machine from a Client OVF Template**

You can use the VMware OVF Tool to deploy the Site Recovery Manager Virtual Appliance virtual machine from a client OVF template.

VMware OVF Tool (ovftool) is a flexible command-line utility that you can use to import and export OVF packages to and from a wide variety of VMware products. For more information about the ovftool, see the **VMware OVF Tool documentation**.

**Prerequisites**

Verify that you have downloaded and installed VMware OVF Tool 4.2 or later.
**Procedure**

- Use the following command line to deploy the Site Recovery Manager Virtual Appliance with the VMware OVF Tool.

```bash
ovftool
--acceptAllEulas
--ipAllocationPolicy=dhcpPolicy --ipProtocol=IPv4
--deploymentOption=light / standard
--name=SRM-VA-NAME
--datastore=DATASTORE-NAME
--network=NETWORK-NAME
--net:"Network 1"=NETWORK-NAME
--prop:varoot-password=ROOT-PASSWORD
--prop:vaadmin-password=ADMIN-PASSWORD
--prop:dbpassword=DB-PASSWORD
--prop:ntpserver=NTP-SERVER
http://HOST/PATH/srm-va_OVF10.ovf
vi://VC_USERNAME:VC_PASSWORD@VC_ADDRESS/DATACENTER-NAME/host/CLUSTER-NAME/Resources/RESOURCE-POOL-NAME
```

You must replace the variables in the example with values from your environment.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>light</td>
<td>standard</td>
</tr>
<tr>
<td>SRM-VA-NAME</td>
<td>The name of the Site Recovery Manager Appliance virtual machine.</td>
</tr>
<tr>
<td>DATASTORE-NAME</td>
<td>The target datastore name.</td>
</tr>
<tr>
<td>NETWORK-NAME</td>
<td>The name of the target network.</td>
</tr>
<tr>
<td>ROOT-PASSWORD</td>
<td>The password for the root account, which you use to log in to the OS of the virtual appliance. The password must be at least eight characters long and must contain characters from four character classes: lowercase letters, uppercase letters, numbers, and special characters.</td>
</tr>
<tr>
<td>ADMIN-PASSWORD</td>
<td>The password for the admin user account, which you use for access to the Site Recovery Manager Appliance Management Interface and for SSH access to the appliance OS. The password must be at least eight characters long and must contain characters from four character classes: lowercase letters, uppercase letters, numbers, and special characters.</td>
</tr>
<tr>
<td>DB-PASSWORD</td>
<td>The password for the srmdb database account, which you use to connect to the embedded vPostgres database. The password must be at least eight characters long and must contain characters from four character classes: lowercase letters, uppercase letters, numbers, and special characters.</td>
</tr>
</tbody>
</table>
### Variable Description

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTP-SERVER</td>
<td>The NTP server host name.</td>
</tr>
<tr>
<td>HOST</td>
<td>The host address of the source virtual machine.</td>
</tr>
<tr>
<td>PATH</td>
<td>The path to the OVF package.</td>
</tr>
<tr>
<td>VC_USERNAME</td>
<td>The user name for the target vCenter Server.</td>
</tr>
<tr>
<td>VC_PASSWORD</td>
<td>The password for the target vCenter Server.</td>
</tr>
<tr>
<td>VC_ADDRESS</td>
<td>The address of the target vCenter Server.</td>
</tr>
<tr>
<td>DATACENTER-NAME</td>
<td>The name of the target data center.</td>
</tr>
<tr>
<td>CLUSTER-NAME</td>
<td>The name of the target cluster.</td>
</tr>
<tr>
<td>RESOURCE-POOL-NAME</td>
<td>The name of the target resource pool.</td>
</tr>
</tbody>
</table>

**What to do next**

**Configure the Site Recovery Manager Appliance to Connect to a vCenter Server** at both the protected and the recovery site.
Reconfiguring the Site Recovery Manager Virtual Appliance

If necessary, you can reconfigure the Site Recovery Manager Virtual Appliance settings by using the Site Recovery Manager Appliance Management Interface.

- **Configure the Time Zone and Time Synchronization Settings for the Site Recovery Manager Appliance**
  When you deploy the Site Recovery Manager Appliance, you either use the time settings of the ESXi host on which the appliance is running, or you configure time synchronization with an NTP server. If the time settings in your network change, you can edit the time zone and time synchronization settings of the appliance.

- **Start, Stop, and Restart Site Recovery Manager Appliance Services**
  If changes in your environment require the restart of certain services, you can use the Site Recovery Manager Appliance Management Interface to view the state of the services and to start, stop, and restart them.

- **Configure the Site Recovery Manager Appliance Network Settings**
  You can use the Site Recovery Manager Appliance Management Interface to customize the network settings of the appliance for privacy, speed, or security reasons.

- **Change the Site Recovery Manager Appliance Certificate**
  You can use the Site Recovery Manager Appliance Management Interface to change the appliance certificate for security reasons or if your certificate is expiring.

- **Enable or Disable SSH Access to the Site Recovery Manager Appliance**
  You can use the Site Recovery Manager Appliance Management Interface to edit the appliance SSH access settings.

- **Forward Site Recovery Manager Appliance Log Files to Remote Syslog Server**
  You can forward the Site Recovery Manager Appliance log files to a remote syslog server to conduct an analysis of your logs.

**Configure the Time Zone and Time Synchronization Settings for the Site Recovery Manager Appliance**

When you deploy the Site Recovery Manager Appliance, you either use the time settings of the ESXi host on which the appliance is running, or you configure time synchronization with an NTP server. If the time
settings in your network change, you can edit the time zone and time synchronization settings of the appliance.

**Procedure**

1. Log in to the Site Recovery Manager Appliance Management Interface as admin.
2. Click the **Time** tab.
3. Configure Site Recovery Manager Appliance time zone settings.
   - a. On the **Time zone** pane, click **Edit**.
   - b. From the **Time zone** drop-down menu, select a location or a time zone and click **Save**.
4. On the **Time synchronization** pane, click **Edit**.
5. Configure the time synchronization settings and click **Save**.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disabled</td>
<td>No time synchronization. Uses the system time zone settings.</td>
</tr>
<tr>
<td>Host</td>
<td>Uses VMware Tools to synchronize the time of the appliance with the time of the ESXi host.</td>
</tr>
<tr>
<td>NTP</td>
<td>Enables NTP synchronization. You must enter the IP address or FQDN of one or more NTP servers.</td>
</tr>
</tbody>
</table>

**Start, Stop, and Restart Site Recovery Manager Appliance Services**

If changes in your environment require the restart of certain services, you can use the Site Recovery Manager Appliance Management Interface to view the state of the services and to start, stop, and restart them.

You can start, stop, and restart the Site Recovery Manager Server service, the embedded database service, and the **dr-client** service.

**Procedure**

1. Log in to the Site Recovery Manager Appliance Management as admin.
2. In the Site Recovery Manager Appliance Management Interface, click **Services**.
   - The Services page displays a table of the installed services that can be sorted by name, startup type, and state.
3. Select a service and click **Start**, **Stop**, or **Restart**, then click **OK**.
   - Restarting some services might lead to functionality becoming temporarily unavailable.
4. Restart the appliance for the changes to take effect.
Configure the Site Recovery Manager Appliance Network Settings

You can use the Site Recovery Manager Appliance Management Interface to customize the network settings of the appliance for privacy, speed, or security reasons.

Procedure

1. Log in to the Site Recovery Manager Appliance Management Interface as admin.
2. Click Networking.
3. To configure your network settings, click Edit.
4. Configure the DNS settings in the Hostname and DNS pane.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Obtain DNS settings automatically</td>
<td>Obtains the DNS settings automatically from the network</td>
</tr>
<tr>
<td>Enter DNS settings manually</td>
<td>Uses the DNS address settings that you set manually. If you select this option, you must provide the IP addresses for a primary and a secondary DNS server.</td>
</tr>
</tbody>
</table>

5. In the eth0 pane, select the IPv4 or the IPv6 protocol type and configure the IP address settings.

   - Configure the IPv4 address settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Obtain IPv4 settings automatically</td>
<td>Obtains the IP address for the appliance from the network</td>
</tr>
<tr>
<td>Enter IPv4 settings manually</td>
<td>Uses an IPv4 address that you set manually.</td>
</tr>
<tr>
<td></td>
<td>1. Enter the IPv4 address</td>
</tr>
<tr>
<td></td>
<td>2. Enter subnet prefix length.</td>
</tr>
<tr>
<td></td>
<td>3. Enter the default IPv4 gateway.</td>
</tr>
</tbody>
</table>

   - Configure the IPv6 address settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Obtain IPv6 settings automatically using DHCP</td>
<td>Assigns IPv6 addresses to the appliance from the network by using DHCP.</td>
</tr>
<tr>
<td>Note</td>
<td>To apply this setting, you must restart the Site Recovery Manager Appliance.</td>
</tr>
<tr>
<td>Obtain IPv6 settings automatically using router advertisement</td>
<td>Assigns IPv6 addresses to the appliance from the network by using router advertisement</td>
</tr>
<tr>
<td>Use static IPv6 addresses</td>
<td>Uses static IPv6 addresses that you set up manually.</td>
</tr>
<tr>
<td></td>
<td>1. Enter the IPv6 address and the subnet prefix length in the address box.</td>
</tr>
<tr>
<td></td>
<td>2. To enter additional IPv6 addresses, click Add.</td>
</tr>
<tr>
<td></td>
<td>3. Enter the default IPv6 gateway.</td>
</tr>
</tbody>
</table>

6. Click Save.
Change the Site Recovery Manager Appliance Certificate

You can use the Site Recovery Manager Appliance Management Interface to change the appliance certificate for security reasons or if your certificate is expiring.

Procedure

1. Log in to the Site Recovery Manager Appliance Management Interface as admin.
2. Click the Access tab, and then, in the Certificate pane, click Change.
3. Select a certificate type.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate a self-signed certificate</td>
<td>Use an automatically generated certificate.</td>
</tr>
<tr>
<td></td>
<td>a Enter text values for your organization and organization unit, typically your company name, and the name of your group in the company.</td>
</tr>
<tr>
<td></td>
<td>b Accept the default FQDN and IP values.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Using self-signed certificate is not recommended for production environments.</td>
</tr>
<tr>
<td>Use a PKCS #12 certificate file</td>
<td>Use a custom certificate.</td>
</tr>
<tr>
<td></td>
<td>a Click Browse, navigate to the certificate file, and click Open. The certificate file must contain exactly one certificate with exactly one private key matching the certificate.</td>
</tr>
<tr>
<td></td>
<td>b (Optional) Enter the optional private key encryption password.</td>
</tr>
<tr>
<td>Use a CA-signed certificate generated from CSR</td>
<td>Use a CA-signed certificate generated from a CSR.</td>
</tr>
<tr>
<td></td>
<td>a In the Certificate file row, click Browse, navigate to the certificate file, and click Open.</td>
</tr>
<tr>
<td></td>
<td>b (Optional) In the CA chain row, click Browse, navigate to the CA chain, and click Open.</td>
</tr>
</tbody>
</table>

4. Click Change.

Generate and Download a Certificate Signing Request for the Site Recovery Manager Appliance

A certificate signing request (CSR) is an encrypted text file that contains specific information, such as organization name, common name, locality, and country. You send the CSR file to a certificate authority (CA) to apply for a digital identity certificate.

You generate a CSR and a matching private key. The private key remains on the Site Recovery Manager Appliance.

**Attention** Generating a new private key invalidates any existing CSR configuration.

Procedure

1. Log in to the Site Recovery Manager Appliance Management Interface as admin.
2. Click the Access tab.
3  In the Certificate pane, click Generate CSR.

4  Enter text values for your organization and organization unit, typically your company name, and the name of your group in the company.

5  Accept the default FQDN and IP values and click Generate and download.

What to do next

To submit a certificate request to the CA in accordance with the CA enrollment process, use the contents of the CSR file.

The CA creates a server certificate based on the information in the CSR file, signs it with its private key, and sends you the certificate, which you can then import to the Site Recovery Manager Appliance.

Enable or Disable SSH Access to the Site Recovery Manager Appliance

You can use the Site Recovery Manager Appliance Management Interface to edit the appliance SSH access settings.

You can enable or disable an SSH access to the appliance only for the admin account.

Procedure

1  Log in to the Site Recovery Manager Appliance Management Interface as admin.

2  Click the Access tab.

3  In the SSH pane, click Enable or Disable.

Forward Site Recovery Manager Appliance Log Files to Remote Syslog Server

You can forward the Site Recovery Manager Appliance log files to a remote syslog server to conduct an analysis of your logs.

Procedure

1  Log in to the Site Recovery Manager Appliance Management Interface as admin.

2  In the Site Recovery Manager Appliance Management Interface, select Syslog Forwarding.

3  Click New, and enter the server address of the destination host in the New Syslog Forwarding pane.

4  From the Protocol drop-down menu, select the protocol to use.

5  In the Port text box, enter the port number to use with the destination host.

   The default port number is 514.

6  Click OK.
7 Verify that the remote syslog server is receiving messages.

8 In the **Syslog Forwarding** section, click **Send Test Message**.

9 Verify that the test message is received on the remote syslog server.
The operation of Site Recovery Manager requires certain ports to be open. The components that make up a Site Recovery Manager deployment, namely vCenter Server, vSphere Web Client, Site Recovery Manager Server, the vSphere Replication appliance, and vSphere Replication servers, require different ports to be open. You must ensure that all the required network ports are open for Site Recovery Manager to function correctly.

**Note** Site Recovery Manager uses port 9086 as the default listener port. Changing the listener port prevents you from using the VMware Site Recovery service on VMware Cloud on AWS.

---

### vCenter Server and ESXi Server network port requirements for Site Recovery Manager 8.3

Site Recovery Manager requires certain ports to be open on vCenter Server, Platform Services Controller, and on ESXi Server.

<table>
<thead>
<tr>
<th>Default Port</th>
<th>Protocol or Description</th>
<th>Source</th>
<th>Target</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>443</td>
<td>HTTPS</td>
<td>Site Recovery Manager</td>
<td>vCenter Server</td>
<td>Default SSL Web port.</td>
</tr>
<tr>
<td>443</td>
<td>HTTPS</td>
<td>Site Recovery Manager</td>
<td>Platform Services Controller (PSC)</td>
<td>Traffic from Site Recovery Manager Server to local and remote Platform Services Controller.</td>
</tr>
</tbody>
</table>
### Site Recovery Manager Server 8.3 network ports

The Site Recovery Manager Server instances on the protected and recovery sites require certain ports to be open.

<table>
<thead>
<tr>
<th>Default Port</th>
<th>Protocol or Description</th>
<th>Source</th>
<th>Target</th>
<th>Endpoints or Consumers</th>
</tr>
</thead>
<tbody>
<tr>
<td>443</td>
<td>HTTPS</td>
<td>Site Recovery Manager HTML 5 user interface</td>
<td>Site Recovery Manager HTML 5 user interface</td>
<td>Default port for the Site Recovery Manager HTML 5 user interface.</td>
</tr>
<tr>
<td>443</td>
<td>HTTPS</td>
<td>Site Recovery Manager</td>
<td>vCenter Server</td>
<td>Default SSL Web Port for incoming TCP traffic.</td>
</tr>
<tr>
<td>443</td>
<td>HTTPS</td>
<td>Site Recovery Manager</td>
<td>Platform Services Controller</td>
<td>Traffic from Site Recovery Manager Server to local and remote Platform Services Controller.</td>
</tr>
<tr>
<td>Default Port</td>
<td>Protocol or Description</td>
<td>Source</td>
<td>Target</td>
<td>Endpoints or Consumers</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------</td>
<td>--------</td>
<td>--------</td>
<td>------------------------</td>
</tr>
<tr>
<td>443</td>
<td>HTTPS</td>
<td>Site Recovery Manager on the recovery site</td>
<td>Recovery site ESXi host.</td>
<td>Traffic from the Site Recovery Manager Server on the recovery site to ESXi hosts when recovering or testing virtual machines with configured IP customization, or callout commands on recovered virtual machines.</td>
</tr>
<tr>
<td>443</td>
<td>HTTPS</td>
<td>vSphere Web Client</td>
<td>Site Recovery Manager Appliance</td>
<td>All management traffic to Site Recovery Manager Server Appliance goes to this port. This includes traffic by external API clients for task automation and HTTPS interface for downloading the UI plug-in and icons. This port must be accessible from the vCenter Server proxy system. Used by vSphere Web Client to download the Site Recovery Manager client plug-in.</td>
</tr>
<tr>
<td>902</td>
<td>TCP and UDP</td>
<td>Site Recovery Manager Server on the recovery site.</td>
<td>Recovery site ESXi host.</td>
<td>Traffic from the Site Recovery Manager Server on the recovery site to ESXi hosts when recovering or testing virtual machines with IP customization, with configured callout commands on recovered virtual machines, or that use raw disk mapping (RDM). All NFC traffic for updating or patching the VMX files of virtual machines that are replicated using vSphere Replication use this port.</td>
</tr>
<tr>
<td>1433</td>
<td>TCP</td>
<td>Site Recovery Manager</td>
<td>Microsoft SQL Server</td>
<td>Site Recovery Manager connectivity to Microsoft SQL Server (for Site Recovery Manager database).</td>
</tr>
</tbody>
</table>
### Site Recovery Manager Installation and Configuration

#### Default Port

<table>
<thead>
<tr>
<th>Default Port</th>
<th>Protocol or Description</th>
<th>Source</th>
<th>Target</th>
<th>Endpoints or Consumers</th>
</tr>
</thead>
<tbody>
<tr>
<td>1521</td>
<td>TCP</td>
<td>Site Recovery Manager</td>
<td>Oracle Database Server</td>
<td>Site Recovery Manager database connectivity to Oracle.</td>
</tr>
<tr>
<td>1526</td>
<td>TCP</td>
<td>Site Recovery Manager</td>
<td>Oracle Database Server</td>
<td>Site Recovery Manager database connectivity to Oracle.</td>
</tr>
<tr>
<td>5480</td>
<td>HTTPS</td>
<td>Web Browser</td>
<td>Site Recovery Manager Appliance</td>
<td>Site Recovery Manager Appliance Management Interface</td>
</tr>
<tr>
<td>9086</td>
<td>HTTPS</td>
<td>vSphere Web Client</td>
<td>Site Recovery Manager</td>
<td>All management traffic to Site Recovery Manager Server goes to this port. This includes traffic by external API clients for task automation and HTTPS interface for downloading the UI plug-in and icons. This port must be accessible from the vCenter Server proxy system. Used by vSphere Web Client to download the Site Recovery Manager client plug-in.</td>
</tr>
</tbody>
</table>

#### Site Pairing Port Requirements

<table>
<thead>
<tr>
<th>Port</th>
<th>Protocol</th>
<th>Source</th>
<th>Target</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9086</td>
<td>HTTPS</td>
<td>vCenter Server</td>
<td>Site Recovery Manager Server</td>
<td>vCenter Server and target Site Recovery Manager communication.</td>
</tr>
<tr>
<td>9086</td>
<td>HTTPS</td>
<td>Site Recovery Manager Server</td>
<td>Site Recovery Manager Server on target site</td>
<td>Bi-directional communication between Site Recovery Manager servers.</td>
</tr>
<tr>
<td>443</td>
<td>HTTPS</td>
<td>vCenter Server</td>
<td>Site Recovery Manager Server Appliance</td>
<td>vCenter Server and target Site Recovery Manager Appliance communication.</td>
</tr>
<tr>
<td>Port</td>
<td>Protocol</td>
<td>Source</td>
<td>Target</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
<td>--------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>443</td>
<td>HTTPS</td>
<td>Site Recovery Manager Appliance</td>
<td>Site Recovery Manager Appliance on target site</td>
<td>Bi-directional communication between Site Recovery Manager Appliance servers.</td>
</tr>
<tr>
<td>443</td>
<td>HTTPS</td>
<td>Site Recovery Manager</td>
<td>Platform Services Controller and vCenter Server</td>
<td>Site Recovery Manager to vCenter Server communication - local and remote.</td>
</tr>
</tbody>
</table>

**Network ports that must be open on Site Recovery Manager and vSphere Replication Protected and Recovery sites**

Site Recovery Manager and vSphere Replication require that the protected and recovery sites can communicate.

<table>
<thead>
<tr>
<th>Port</th>
<th>Protocol or Description</th>
<th>Source</th>
<th>Target</th>
<th>Endpoints or Consumers</th>
</tr>
</thead>
<tbody>
<tr>
<td>31031</td>
<td>Initial replication traffic</td>
<td>ESXi host</td>
<td>vSphere Replication appliance on the recovery site</td>
<td>From the ESXi host at the protected site to the vSphere Replication appliance at the recovery site</td>
</tr>
<tr>
<td>32032</td>
<td>TCP</td>
<td>ESXi host on the source site</td>
<td>vSphere Replication server at the target site</td>
<td>Initial and outgoing replication traffic from the ESXi host at the source site to the vSphere Replication appliance or vSphere Replication server at the target site for replication traffic with network encryption.</td>
</tr>
<tr>
<td>8043</td>
<td>HTTPS</td>
<td>Site Recovery Manager</td>
<td>vSphere Replication appliance on the recovery and protected sites</td>
<td>Management traffic between Site Recovery Manager instances and vSphere Replication appliances.</td>
</tr>
</tbody>
</table>
When you choose to participate in the Customer Experience Improvement Program (CEIP), VMware receives anonymous information to improve the quality, reliability, and functionality of VMware products and services.

Categories of Information that VMware Receives

Details regarding the data collected by CEIP and the purposes for which it is used by VMware are available at the Trust & Assurance Center at https://www.vmware.com/trustvmware/ceip.html.

To join or leave the CEIP for this product, see *Join the Customer Experience Improvement Program in the vSphere Web Client* in the *ESXi and vCenter Server* documentation.

This chapter includes the following topics:

- Categories of Information that VMware Receives

Categories of Information that VMware Receives

This product participates in the VMware Customer Experience Improvement Program (CEIP).

Details regarding the data collected by CEIP and the purposes for which it is used by VMware are available at the Trust & Assurance Center at https://www.vmware.com/trustvmware/ceip.html.

To join or leave the CEIP for this product, see *Join the Customer Experience Improvement Program in the vSphere Web Client* in the *ESXi and vCenter Server* documentation.
Provide Feedback with the Site Recovery User Interface

You can use the feedback tool in the Site Recovery User Interface to provide timely feedback to our developers.

Procedure

1. In the vSphere Client or the vSphere Web Client, click Site Recovery > Open Site Recovery.
2. From the Site Recovery home screen, click the feedback icon in the top right-corner.
3. Select the type of feedback you want to give and enter your feedback in the Description window.
4. (Optional) Provide an email address and screenshots or other images.
5. Click Send.
Modifying and uninstalling Site Recovery Manager

You can modify an existing Site Recovery Manager installation to reflect changes in your infrastructure. To uninstall Site Recovery Manager cleanly, you must follow the correct procedure.

- **Modify a Site Recovery Manager Server Installation**
  To change some of the information that you supplied when you installed Site Recovery Manager Server, you can run the Site Recovery Manager installer in modify mode.

- **Reconfigure the Connection Between Sites**
  You must reconfigure the connection between the sites if you made modifications to your Site Recovery Manager installation.

- **Break the Site Pairing and Connect to a New Remote Site**
  To connect a Site Recovery Manager site to a new remote site, you must remove the existing Site Recovery Manager configurations and break the pairing between the existing sites.

- **Repair a Site Recovery Manager Server Installation**
  You can run the Site Recovery Manager installer in repair mode to repair a Site Recovery Manager Server installation.

- **Rename a Site Recovery Manager Site**
  After you have installed Site Recovery Manager, you can rename a site directly in the Site Recovery Manager interface in the vSphere Web Client.

- **Uninstall Site Recovery Manager**
  If you no longer require Site Recovery Manager, you must follow the correct procedure to cleanly uninstall Site Recovery Manager.

- **Uninstall and Reinstall the Same Version of Site Recovery Manager**
  If you uninstall, then reinstall the same version of Site Recovery Manager, you must perform certain actions to reconfigure your Site Recovery Manager installation. You must perform these actions even if you retained the database contents when you uninstalled Site Recovery Manager, then connected the new installation to the existing database.
Modify a Site Recovery Manager Server Installation

To change some of the information that you supplied when you installed Site Recovery Manager Server, you can run the Site Recovery Manager installer in modify mode.

Installing Site Recovery Manager Server binds the installation to a number of values that you supply, including the vCenter Server instance to extend, the Site Recovery Manager database type, DSN and credentials, the certificate, and so on. The Site Recovery Manager installer provides a modify mode that allows you to change some of the values that you configured when you installed Site Recovery Manager Server:

- The Platform Services Controller address, if the vCenter Server instance that Site Recovery Manager extends moves to a different Platform Services Controller
- The vCenter Single Sign-On user name and password, if they changed since you installed Site Recovery Manager
- The information with which you register Site Recovery Manager with vCenter Server
- Upload or generate a new certificate
- The user name, password, and connection numbers for the Site Recovery Manager database
- The user account under which the Site Recovery Manager Server service runs

**Note** If you change the certificate that vCenter Server or Platform Services Controller uses, you must run the Site Recovery Manager installer in modify mode. Running the Site Recovery Manager installer in modify mode updates the Site Recovery Manager certificate thumbprints to reflect the new vCenter Server or Platform Services Controller certificate.

**Prerequisites**

Verify that you have administrator privileges on Site Recovery Manager Server or that you are a member of the Administrators group. Disable Windows User Account Control (UAC) before you attempt the change operation or select Run as administrator when you start the Site Recovery Manager installer.

**Procedure**

1. Log in to the Site Recovery Manager Server host.
2. Open Programs and Features from the Windows Control Panel.
3. Select the entry for VMware vCenter Site Recovery Manager and click Change.
4. Click Next.
5. Select Modify and click Next.
6 Verify or modify the information with which to register the Site Recovery Manager extension with Platform Services Controller, and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>You can change the Platform Services Controller address if vCenter Server migrated to a different Platform Services Controller after the initial installation of Site Recovery Manager.</td>
</tr>
<tr>
<td></td>
<td><strong>Important</strong> If you change the Platform Services Controller address, you must reconfigure the connection between the Site Recovery Manager sites after you have updated the installation.</td>
</tr>
<tr>
<td>HTTPS Port</td>
<td>Change the Platform Services Controller port if it changed after the initial installation of Site Recovery Manager.</td>
</tr>
<tr>
<td>Username</td>
<td>Modify the vCenter Single Sign-On user name, if it has changed since the initial installation.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the vCenter Single Sign-On password.</td>
</tr>
</tbody>
</table>

7 If prompted, verify the Platform Services Controller certificate and click **Accept** to accept it.

8 Verify the vCenter Server instance that Site Recovery Manager extends, and click **Next**.

You cannot use the installer's modify mode to change the vCenter Server instance that Site Recovery Manager extends.

9 Verify or modify the information with which to register the Site Recovery Manager extension with vCenter Server, and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator E-mail</td>
<td>Modify this value if the Site Recovery Manager administrator has changed after you installed Site Recovery Manager Server.</td>
</tr>
<tr>
<td>Local Host</td>
<td>The address of the host on which Site Recovery Manager Server runs. If you change this value, you must either regenerate the certificate or provide a new certificate that includes the new address in <strong>Step 10</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Important</strong> To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.</td>
</tr>
<tr>
<td>Listener Port</td>
<td>The port for all HTTPS traffic between Site Recovery Manager Server and vCenter Server. The default port is 9086.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Changing the listener port prevents you from using the VMware Site Recovery service on VMware Cloud on AWS.</td>
</tr>
<tr>
<td>SRM UI Port</td>
<td>The HTTPS port for the Site Recovery Manager user interface.</td>
</tr>
</tbody>
</table>
10 Select a certificate type and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically generate a certificate</td>
<td>Select this option to generate a new auto-generated certificate.</td>
</tr>
<tr>
<td>Use a PKCS #12 certificate file</td>
<td>Select this option to upload a new custom certificate.</td>
</tr>
<tr>
<td>Use existing certificate</td>
<td>Select this option to retain the current certificate. If the installed certificate is not valid, this option is unavailable.</td>
</tr>
</tbody>
</table>

If you do not select Use existing certificate, you are prompted to supply additional details such as the certificate location or strings to use for Organization and Organizational Unit.

**Important** If you modified the Local Host value for Site Recovery Manager Server in Step 9, you must select Automatically generate a certificate to regenerate the certificate or Use a PKCS #12 certificate file to upload a certificate that includes the new Site Recovery Manager Server address. If you select Use existing certificate, the installation modification succeeds, but attempts to log in to Site Recovery Manager fail because the certificate contains an incorrect address for the Site Recovery Manager Server host.

11 Verify or modify the database configuration information and click Next.

If you selected the embedded database when you installed Site Recovery Manager, you cannot modify the installation to use an external database, or the reverse.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source Name</td>
<td>The DSN for the Site Recovery Manager database. This only appears if you use the embedded database. You cannot change this value.</td>
</tr>
<tr>
<td>Database User Name</td>
<td>A user ID valid for the specified database. Modify this value if the database user account has changed after you installed Site Recovery Manager Server.</td>
</tr>
<tr>
<td>Database Password</td>
<td>The password for the specified user ID. Modify this value if the password for the database user account has changed after you installed Site Recovery Manager Server. You must enter this value in all cases.</td>
</tr>
<tr>
<td>Database Port</td>
<td>This only appears if you use the embedded database. You cannot change this value.</td>
</tr>
<tr>
<td>Connection Count</td>
<td>Modify the initial connection pool size. If all connections are in use and a new one is needed, a connection is created as long as it does not exceed the maximum number of connections allowed. It is faster for Site Recovery Manager to use a connection from the pool than to create one. The maximum value that you can set depends on your database configuration. In most cases, it is not necessary to change this setting. Before changing this setting, consult with your database administrator. Setting the value too high can lead to database errors.</td>
</tr>
<tr>
<td>Max Connections</td>
<td>Modify the maximum number of database connections that can be open simultaneously. The maximum value that you can set depends on your database configuration. If the database administrator restricted the number of connections that the database can have open, this value cannot exceed that number. In most cases, it is not necessary to change this setting. Before you change this setting, consult with your database administrator. Setting the value too high can lead to database errors.</td>
</tr>
</tbody>
</table>
12 Select or deselect the **Use Local System account** check box to change the user account under which the Site Recovery Manager Server service runs, and click **Next**.

- If you deselect **Use Local System account**, you must provide a username and password for a valid user account.
- If you are using SQL Server with Integrated Windows Authentication, the username text box shows the username of the account that is running the installer and cannot be modified.

13 Click **Install** to modify the installation.

The installer makes the requested modifications and restarts the Site Recovery Manager Server.

**What to do next**

When the modification operation is finished and the Site Recovery Manager Server restarts, log in to the vSphere Web Client to check the connection between the sites. If the connection is broken, or if you changed the Platform Services Controller address, reconfigure the site pairing. For instructions about how to reconfigure the site pairing, see **Reconfigure the Connection Between Sites**.

**Reconfigure the Connection Between Sites**

You must reconfigure the connection between the sites if you made modifications to your Site Recovery Manager installation.

You cannot reconfigure the site pairing to connect Site Recovery Manager to a different vCenter Server instance. You reconfigure an existing pairing to update Site Recovery Manager on both sites if the infrastructure has changed on one or both of the sites.

- You upgraded Site Recovery Manager to a new version.
- You changed the Site Recovery Manager certificate.
- You changed the Platform Services Controller or vCenter Server certificate.
- You changed the Platform Services Controller address.

**Procedure**

1. In the vSphere Client or the vSphere Web Client, click **Site Recovery > Open Site Recovery**.
2. On the **Site Recovery** home tab, select a site pair, and click **View Details**.
3. Select **Site Pair > Summary**, and click **Reconfigure Site Pair**.
   - You can initiate the reconfiguration from either site, even if you only changed the installation on one of the sites.
4. Enter the address of the Platform Services Controller on the remote site, provide the vCenter Single Sign-On username and password, and click **Next**.
5 Select the vCenter Server and the services you want to pair, and click **Next**.

If the Platform Services Controller manages more than one vCenter Server instance, the other vCenter Server instances appear in the list but you cannot select a different instance. You can only select the vCenter Server instance that Site Recovery Manager already extends.

### Break the Site Pairing and Connect to a New Remote Site

To connect a Site Recovery Manager site to a new remote site, you must remove the existing Site Recovery Manager configurations and break the pairing between the existing sites.

Site pairing makes modifications on both Site Recovery Manager sites. You cannot reconfigure an existing pairing between Site Recovery Manager sites to connect Site Recovery Manager on one site to a new Site Recovery Manager site. You must remove all configuration from both sites in the existing pair, then break the connection between the sites before you can configure a new site pairing. You cannot break the site pairing until you have removed all existing configurations between the sites.

**Prerequisites**

- You have an existing Site Recovery Manager installation with two connected sites.
- Make a full backup of the Site Recovery Manager database on both sites by using the tools that the database software provides. For instructions about how to back up the embedded database, see [Back Up and Restore the Embedded vPostgres Database](#).

**Procedure**

1. In the vSphere Client or the vSphere Web Client, click **Site Recovery > Open Site Recovery**.
2. On the **Site Recovery** home tab, select a site pair, and click **View Details**.
3. Select the **Recovery Plans** tab, right-click on a recovery plan and select **Delete**.
   
   You cannot delete recovery plans that are running.
4. Select the **Protection Groups** tab, click on a protection group, and select the **Virtual Machines** tab.
5. Highlight all virtual machines, right-click, and select **Remove Protection**.
   
   Removing protection from a virtual machine deletes the placeholder virtual machine from the recovery site. Repeat this operation for all protection groups.
6. In the **Protection Groups** tab, right-click a protection group and select **Delete**.
   
   You cannot delete a protection group that is included in a recovery plan. You cannot delete vSphere Replication protection groups that contain virtual machines on which protection is still configured.
7. Select **Site Pair > Configure**, and remove all inventory mappings.
   
   a. Click each of the **Network Mappings**, **Folder Mappings**, and **Resource Mappings** tabs.
   b. In each tab, select a site, right-click a mapping, and select **Delete**.
8. For both sites, click **Placeholder Datastores**, right-click the placeholder datastore, and select **Remove**.
9  (Optional) If you use array-based replication, select Configure > Array Based Replication > Array Pairs, and remove all array pairs.
   a  Select an array pair, click Array Pair, and click Disable.
   b  Click Array Manager Pair and click Remove.
10  Select Site Pair > Summary, and click Break Site Pair.
    Breaking the site pairing removes all information related to registering Site Recovery Manager with Site Recovery Manager, vCenter Server and the Platform Services Controller on the remote site.

Results
The connection between the sites is broken. You can reconfigure Site Recovery Manager to connect to a new remote site.

What to do next
- Install a new Site Recovery Manager instance on the new remote site. For instructions about installing Site Recovery Manager, see Install Site Recovery Manager Server for Windows.
  
  **Important**  The new Site Recovery Manager instance must have the same Site Recovery Manager extension ID as the existing site.

- Optionally uninstall Site Recovery Manager Server from the previous remote site. For instructions about uninstalling Site Recovery Manager Server, see the steps of Uninstall Site Recovery Manager from the Break Pairing step onwards.

- Reconfigure the inventory mappings and placeholder datastore mappings to map objects on the existing site to objects on the new remote site. For instructions about configuring mappings, see Site Recovery Manager Administration.

- Reconfigure the replication of virtual machines from the existing site to the new remote site. For information about configuring array-based replication and vSphere Replication, see Replicating Virtual Machines in Site Recovery Manager Administration.

- Create new protection groups and recovery plans to recover virtual machines to the new remote site. For information about creating protection groups and recovery plans, see Site Recovery Manager Administration.

**Repair a Site Recovery Manager Server Installation**

You can run the Site Recovery Manager installer in repair mode to repair a Site Recovery Manager Server installation.

Running the installer in repair mode fixes missing or corrupted files, shortcuts, and registry entries in the Site Recovery Manager Server installation.

**Caution**  Do not run the Site Recovery Manager installer in repair mode on the protected site and on the recovery site simultaneously.
Prerequisites

Verify that you have administrator privileges on Site Recovery Manager Server or that you are a member of the Administrators group. Disable Windows User Account Control (UAC) before you attempt the change operation or select Run as administrator when you start the Site Recovery Manager installer.

Procedure

1. Log in to the Site Recovery Manager Server host.
2. Open Programs and Features from the Windows Control Panel.
3. Select the entry for VMware vCenter Site Recovery Manager and click Change.
4. Click Next.
5. Select Repair and click Next.
6. Click Install to repair the installation.

   The installer makes any necessary repairs and restarts Site Recovery Manager Server.

Rename a Site Recovery Manager Site

After you have installed Site Recovery Manager, you can rename a site directly in the Site Recovery Manager interface in the vSphere Web Client.

Procedure

1. In the vSphere Client or the vSphere Web Client, click Site Recovery > Open Site Recovery.
2. On the Site Recovery home tab, select a site pair, and click View Details.
3. Click Site Pair > Summary, and in the Site Recovery Manager box click Rename next to the name of the site you want to rename.
4. Enter a new name for the site and click Save.

Uninstall Site Recovery Manager

If you no longer require Site Recovery Manager, you must follow the correct procedure to cleanly uninstall Site Recovery Manager.

Installing Site Recovery Manager, creating inventory mappings, protecting virtual machines by creating protection groups, and creating and running recovery plans makes significant changes on both Site Recovery Manager sites. Before you uninstall Site Recovery Manager, you must remove all Site Recovery Manager configurations from both sites in the correct order. If you do not remove all configurations before uninstalling Site Recovery Manager, some Site Recovery Manager components, such as placeholder virtual machines, might remain in your infrastructure.

If you use Site Recovery Manager with vSphere Replication, you can continue to use vSphere Replication after you uninstall Site Recovery Manager.
Procedure

1. In the vSphere Client or the vSphere Web Client, click Site Recovery > Open Site Recovery.
2. On the Site Recovery home tab, select a site pair, and click View Details.
3. Select the Recovery Plans tab, right-click on a recovery plan and select Delete. You cannot delete recovery plans that are running.
4. Select the Protection Groups tab, click on a protection group, and select the Virtual Machines tab.
5. Highlight all virtual machines, right-click, and select Remove Protection. Removing protection from a virtual machine deletes the placeholder virtual machine from the recovery site. Repeat this operation for all protection groups.
6. In the Protection Groups tab, right-click a protection group and select Delete. You cannot delete a protection group that is included in a recovery plan. You cannot delete vSphere Replication protection groups that contain virtual machines on which protection is still configured.
7. Select Site Pair > Configure, and remove all inventory mappings.
   a. Click each of the Network Mappings, Folder Mappings, and Resource Mappings tabs.
   b. In each tab, select a site, right-click a mapping, and select Delete.
8. For both sites, click Placeholder Datastores, right-click the placeholder datastore, and select Remove.
9. (Optional) If you use array-based replication, select Configure > Array Based Replication > Array Pairs, and remove all array pairs.
   a. Select an array pair, click Array Pair, and click Disable.
   b. Click Array Manager Pair and click Remove.
10. Select Site Pair > Summary, and click Break Site Pair. Breaking the site pairing removes all information related to registering Site Recovery Manager with Site Recovery Manager, vCenter Server and the Platform Services Controller on the remote site.
11. Use Windows Control Panel to uninstall Site Recovery Manager, selecting the option Delete Site Recovery Manager Data.
    Do not uninstall the Site Recovery Manager database before you uninstall Site Recovery Manager.
12. (Optional) If you use the embedded database, use Windows Control Panel to uninstall the Site Recovery Manager Embedded Database.
13. Repeat Step Step 1 to Step 12 on the other site.
Uninstall and Reinstall the Same Version of Site Recovery Manager

If you uninstall, then reinstall the same version of Site Recovery Manager, you must perform certain actions to reconfigure your Site Recovery Manager installation. You must perform these actions even if you retained the database contents when you uninstalled Site Recovery Manager, then connected the new installation to the existing database.

If you configured advanced settings in the previous installation, these advanced settings are not retained if you uninstall and then reinstall the same version of Site Recovery Manager. This is by design.

Procedure

1. (Optional) If you configured advanced settings in the existing installation, take a note of the advanced settings.
   
   You configure advanced settings from the Site Pair tab Site Pair > Configure > Advanced Settings in the Site Recovery UI.

2. Uninstall Site Recovery Manager, without deleting its data.

3. Reinstall Site Recovery Manager.
   
   During reinstallation, connect Site Recovery Manager to the same vCenter Server instance and the same database as the previous installation.

4. Reconfigure the connection between the sites.

5. Reconfigure Storage Array Managers (SRAs) to enter the SRA credentials.

6. Reconfigure any advanced settings.

Migrating a Site Recovery Manager Server to Run on a Different Host

To migrate a Site Recovery Manager server to a new host, you must install Site Recovery Manager on the new host and supply database connection information used by the old installation.

You use this workflow to migrate a Site Recovery Manager server from one host to another and retain data from the previous installation, which is stored in the Site Recovery Manager database.

Prerequisites

- Backup the Site Recovery Manager database.
- Uninstall the old Site Recovery Manager preserving the database.

Procedure

1. Double-click the Site Recovery Manager installer, select an installation language, and click **OK**.

2. Follow the installer prompts to accept the license agreement, and verify that you satisfied the installation prerequisites.
3 Select where to install Site Recovery Manager Server, and click **Next**.
   - Keep the default destination folder.
   - Click **Change** to change the destination folder, and select a target volume.
   The default installation folder for Site Recovery Manager is `C:\Program Files\VMware\VMware vCenter Site Recovery Manager`. If you use a different folder, the pathname must be up to 120 characters including the end slash, and you must use ASCII characters.

4 Enter information about the Platform Services Controller at the site where you are installing Site Recovery Manager and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>The host name or IP address of the Platform Services Controller for the vCenter Server with which to register Site Recovery Manager. Enter the host name in lowercase letters. After installation is complete and you are configuring the connection between the protected and recovery sites, supply this host name or IP address exactly as you enter it here, because it is subject to case-sensitive comparisons.</td>
</tr>
<tr>
<td></td>
<td><strong>Important</strong> To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.</td>
</tr>
<tr>
<td></td>
<td><strong>Important</strong> If the Platform Services Controller uses an FQDN rather than an IP address, you must specify the FQDN when you install Site Recovery Manager.</td>
</tr>
<tr>
<td>HTTPS Port</td>
<td>Accept the default value of 443 or enter a new value if Platform Services Controller uses a different port. Platform Services Controller only supports connections over HTTPS and does not support HTTP connections.</td>
</tr>
<tr>
<td>Username</td>
<td>The vCenter Single Sign-On user name for the vCenter Single Sign-On domain to which this Platform Services Controller instance belongs. This user account must be a member of the vCenter Single Sign-On Administrator group on the Platform Services Controller instance. Only members of the Administrator group have the necessary permissions to create or recreate the Site Recovery Manager solution user.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for the specified vCenter Single Sign-On user name.</td>
</tr>
</tbody>
</table>

5 If prompted, verify the Platform Services Controller certificate and click **Accept** to accept it.

6 Select the vCenter Server instance with which to register Site Recovery Manager and click **Next**.

**Important** The drop-down menu includes all of the vCenter Server instances that are registered with the Platform Services Controller. In an environment that uses Enhanced Linked Mode, it can also include vCenter Server instances from other Platform Services Controller instances. Make sure that you select the correct vCenter Server instance. Once the Site Recovery Manager installation is complete, you cannot modify it to select a different vCenter Server instance.
7 Enter information with which to register the Site Recovery Manager extension with vCenter Server, and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Local Site Name</strong></td>
<td>A name for this Site Recovery Manager site, which appears in the Site Recovery Manager interface. The vCenter Server address is used by default. Use a different name for each Site Recovery Manager installation in the pair.</td>
</tr>
<tr>
<td><strong>Administrator E-mail</strong></td>
<td>Email address of the Site Recovery Manager administrator. This information is required even though you use the standard vCenter Server alarms to configure email notifications for Site Recovery Manager events.</td>
</tr>
<tr>
<td><strong>Local Host</strong></td>
<td>Name or IP address of the local host. The Site Recovery Manager installer obtains this value. Only change it if it is incorrect. For example, the local host might have more than one network interface and the one that the Site Recovery Manager installer detects is not the interface you want to use.</td>
</tr>
<tr>
<td><strong>Important</strong></td>
<td>To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.</td>
</tr>
<tr>
<td><strong>Listener Port</strong></td>
<td>HTTPS port for all management traffic to Site Recovery Manager Server, including traffic with external API clients for task automation. The port is also used by vSphere Web Client to download the Site Recovery Manager client plug-in. This port must be accessible from the vCenter Server proxy system. Do not change the port unless the default of 9086 causes port conflicts.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Changing the listener port prevents you from using the VMware Site Recovery service on VMware Cloud on AWS.</td>
</tr>
<tr>
<td><strong>SRM UI Port</strong></td>
<td>HTTPS port for the Site Recovery Manager user interface. The default port is 443. If the Platform Services Controller is installed on the same machine, you must change this port.</td>
</tr>
</tbody>
</table>
8 Select the default Site Recovery Manager plug-in identifier, or create a plug-in identifier for this Site Recovery Manager Server pair, and click Next.

Both Site Recovery Manager Server instances in a site pair must use the same plug-in identifier.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default SRM Plug-in Identifier</td>
<td>Use this option when you install Site Recovery Manager in a standard configuration with one protected site and one recovery site.</td>
</tr>
<tr>
<td>Custom SRM Plug-in Identifier</td>
<td>Use this option when you install Site Recovery Manager in a shared recovery site configuration, with multiple protected sites and one recovery site. Enter the details of the plug-in identifier.</td>
</tr>
<tr>
<td>Plug-in ID</td>
<td>A unique identifier. Assign the same identifier to the Site Recovery Manager Server instances on the protected site and the shared recovery site.</td>
</tr>
<tr>
<td>Organization</td>
<td>The name of the organization to which this Site Recovery Manager Server pair belongs. This name helps to identify to Site Recovery Manager Server pairs in a shared recovery site configuration, especially when multiple organizations use the shared recovery site.</td>
</tr>
<tr>
<td>Description</td>
<td>An optional description of this Site Recovery Manager Server pair.</td>
</tr>
</tbody>
</table>

9 Select a certificate type and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically generate certificate</td>
<td>Use an automatically generated certificate:</td>
</tr>
<tr>
<td>Load a certificate file</td>
<td>Use a custom certificate:</td>
</tr>
<tr>
<td>Description</td>
<td>Use an automatically generated certificate:</td>
</tr>
<tr>
<td>a Select Automatically generate certificate</td>
<td>and click Next.</td>
</tr>
<tr>
<td>b Enter text values for your organization and organization unit, typically your company name and the name of your group in the company.</td>
<td></td>
</tr>
<tr>
<td>c Click Next.</td>
<td>Use a custom certificate:</td>
</tr>
<tr>
<td>a Select Use a PKCS#12 certificate file and click Next.</td>
<td></td>
</tr>
<tr>
<td>b Click Browse, navigate to the certificate file, and click Open. The certificate file must contain exactly one certificate with exactly one private key matching the certificate.</td>
<td></td>
</tr>
<tr>
<td>c Click Next.</td>
<td>and click Next.</td>
</tr>
<tr>
<td>d Click Next.</td>
<td>Use an automatically generated certificate:</td>
</tr>
</tbody>
</table>

10 Select to use a custom database, and click Next.

Select the 64-bit DSN of the old database from the drop-down menu. You can also click DSN Setup to start the Windows 64-bit ODBC Administrator tool, to view the existing DSNs, or to create a new 64-bit system DSN for the Site Recovery Manager database.
11 Provide the Site Recovery Manager database configuration information and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Username</td>
<td>Enter the user name for an existing database user account to use with a custom database. This option is disabled if you use SQL Server with Integrated Windows Authentication. In this case, the credentials of the user account running the Site Recovery Manager installer are used to authenticate with SQL Server. This account is also used to run the Site Recovery Manager service, to guarantee that Site Recovery Manager can connect to the database.</td>
</tr>
<tr>
<td>Database Password</td>
<td>Enter the password for an existing database user account to use with a custom database. This option is disabled if you use SQL Server with Integrated Windows Authentication.</td>
</tr>
<tr>
<td>Connection Count</td>
<td>Enter the initial connection pool size. If all connections are in use and a new one is needed, a connection is created as long as it does not exceed the maximum number of connections allowed. It is faster for Site Recovery Manager to use a connection from the pool than to create one. The maximum value that you can set depends on your database configuration. In most cases, it is not necessary to change this setting. Before changing this setting, consult with your database administrator. Setting the value too high can lead to database errors.</td>
</tr>
<tr>
<td>Max Connections</td>
<td>Enter the maximum number of database connections that can be open simultaneously. The maximum value that you can set depends on your database configuration. If the database administrator restricted the number of connections that the database can have open, this value cannot exceed that number. In most cases, it is not necessary to change this setting. Before you change this setting, consult with your database administrator. Setting the value too high can lead to database errors.</td>
</tr>
</tbody>
</table>

12 Select to use existing data, and click Next.

13 Select the user account under which to run the Site Recovery Manager Server service and click Next.

- Select **Use Local System Account** to run the Site Recovery Manager Server service under the Local System account.
- Enter the username and password of an existing LDAP user account to run the Site Recovery Manager Server service under a different user account. This can be any user account, including local users, that is a member of the built-in Administrators group.

   This option is not available if you use an SQL Server database with Integrated Windows Authentication. In this case, the Site Recovery Manager Server service runs under the account that you use to install Site Recovery Manager.

14 Click Install.

15 After the installation is finished, click Finish.

Results

Site Recovery Manager server is migrated on a different host.
Exporting and Importing Site Recovery Manager Configuration Data

You can use the VMware Site Recovery Manager 8.3 Configuration Import/Export Tool to export and import configuration data.

If you plan to migrate Site Recovery Manager to a different host, you can use the tool to export inventory mappings, recovery plans, protection groups, and the related objects into an XML file. You can then import the configuration data from the previously exported file.

The VMware Site Recovery Manager 8.3 Configuration Import/Export Tool is available through the Site Recovery User Interface and as a standalone .zip archive. If you are using the Site Recovery Manager appliance, the tool is also deployed with the appliance. You can download the standalone tool from the VMware Site Recovery Manager Downloads page.

Requirements for Using the Standalone Configuration Tool

- You must have Java 1.8.x or later installed on the Site Recovery Manager host machine.
- The JAVA_HOME environment variable must be properly configured. For example, `JAVA_HOME=C:\Program Files\Java\jre1.8.0_152` for Windows, or `JAVA_HOME=/usr/java/jre1.8.0_152` for Linux.

Requirements for Exporting and Importing Site Recovery Manager Configuration Data

- Before you can export a configuration, you must have a site pair with Site Recovery Manager 8.3.x up and running on both the protected and the recovery site.
- Import is supported in a clean Site Recovery Manager 8.3.x installation, registered to the same vCenter Server instance or to a vCenter Server instance which contains the same inventory.
Input Parameters Required for Import with the Standalone Configuration Tool

- Lookup Service host name. The host name of the Platform Services Controller or the vCenter Server host name, if you are using vCenter Server with an Embedded Platform Services Controller.
- vCenter Single Sign-On administrator user name and password for both sites or solution user certificates in a Java Keystore (JKS).

Exported Information

The VMware Site Recovery Manager 8.3 Configuration Import/Export Tool exports the Site Recovery Manager version, build number, local and remote site names, inventory mappings, and placeholder datastores. Other exported information includes advanced settings, array managers with SRA information, protection groups, recovery plans, and so on. The information is stored in an XML file. You can validate the XML file by using the following XSD schema.

This chapter includes the following topics:

- Export Site Recovery Manager Configuration Data through the User Interface
- Export Site Recovery Manager Configuration Data by Using a Script Without Credentials
- Modify the Export Script of the VMware Site Recovery Manager 8.3 Configuration Import/Export Tool
- Schedule an Export of Site Recovery Manager Configuration Data by Using a Cron Job
- Export Site Recovery Manager Appliance Configuration Data by Using a Callout
- Export Site Recovery Manager Configuration Data with the Standalone Import/Export Tool
- Use a Properties File to Export Site Recovery Manager Configuration Data
- Import the Site Recovery Manager Configuration Data through the User Interface
- Import Site Recovery Manager Configuration Data with the Standalone Import/Export Tool
- Use a Properties File to Import Site Recovery Manager Configuration Data
- Syntax of the Import/Export Tool
- Properties for Automated Export and Import of Site Recovery Manager Configuration Data
- Troubleshooting the VMware Site Recovery Manager 8.3 Configuration Import/Export Tool

Export Site Recovery Manager Configuration Data through the User Interface

You use the Site Recovery User Interface to export Site Recovery Manager configuration data in an XML file.
Prerequisites

Verify that you have a site pair with Site Recovery Manager running on both the protected and the recovery sites.

Procedure

1. In the vSphere Client or the vSphere Web Client, click Site Recovery > Open Site Recovery.
2. On the Site Recovery home tab, select a site pair, and click View Details.
3. On the Summary tab, click Export/Import SRM Configuration > Export, and click Download.

Export Site Recovery Manager Configuration Data by Using a Script Without Credentials

The Site Recovery Manager 8.3 virtual appliance is bundled with a script generated during pairing that you can use to export Site Recovery Manager configuration data.

When you use the script to export Site Recovery Manager configuration data, you are not required to enter any credentials.

Prerequisites

Ensure that you have a working Site Recovery Manager pair.

Procedure

1. Log in to the Site Recovery Manager virtual appliance host machine as root by using su.
2. To export the configuration data, run sh /opt/vmware/impex/bin/export.sh.
   The VMware Site Recovery Manager 8.3 Configuration Import/Export Tool exports the configuration data to /opt/vmware/impex/exports/.

Modify the Export Script of the VMware Site Recovery Manager 8.3 Configuration Import/Export Tool

The Site Recovery Manager 8.3 virtual appliance is bundled with a script that you can use to export Site Recovery Manager configuration data. You can modify the script to change the default export location, the number of exports, and so on.

Procedure

1. Log in to the Site Recovery Manager virtual appliance host machine.
2. Log in as root by using su.
3. SSH to the following location /opt/vmware/impex/bin/.
Use a text editor to open the `export.sh` file and add the following text to the last line of the script.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To change the location of the export files.</td>
<td>Add `&quot;-e</td>
</tr>
<tr>
<td>To change the maximum number of export files.</td>
<td>Add `&quot;-m</td>
</tr>
</tbody>
</table>

Save the changes and close the editor.

**Schedule an Export of Site Recovery Manager Configuration Data by Using a Cron Job**

The Site Recovery Manager 8.3 virtual appliance is bundled with a script that you can use to schedule a cron job for the export of Site Recovery Manager configuration data.

**Prerequisites**

Ensure that you have a working Site Recovery Manager pair.

**Procedure**

1. Log in to the Site Recovery Manager virtual appliance host virtual machine.
2. Run `su`.
3. Run the following command `crontab -e`.
4. Enter the configuration data.

   For example, to export the configuration data at every hour enter the following information.
   ```
   0 * * * *
   * /usr/bin/sudo /bin/bash /opt/vmware/impex/bin/export.sh
   ```

**Export Site Recovery Manager Appliance Configuration Data by Using a Callout**

You can use a top-level recovery step in the recovery plan to export configuration data from the Site Recovery Manager appliance.

**Prerequisites**

- Verify that you are using the Site Recovery Manager virtual appliance.
- Ensure that you have a working Site Recovery Manager pair.

**Procedure**

1. In the vSphere Client or the vSphere Web Client, click **Site Recovery > Open Site Recovery**.
2. On the **Site Recovery** home tab, select a site pair, and click **View Details**.
3. On the **Recovery Plans** tab, select a recovery plan, and click **Recovery Steps**.
4 Use the View drop-down menu and select Recovery Steps.

5 Select where to add the step.
   - To add a step before a step, right-click the step, and select Add Step Before.
   - To add a step after the last step, right-click the last step, and select Add Step After.

6 Select Command on SRM Server.

7 In the Name text box, enter a name for the step.
   The step name appears in the list of steps in the Recovery Steps view.

8 Enter the following command in the Content text box. /usr/bin/sudo /bin/bash /opt/vmware/impex/bin/export.sh

9 (Optional) Modify the Timeout setting for the command to run on Site Recovery Manager Server.

10 Click Add to add the step to the recovery plan.

Results

When you run the recovery plan, the VMware Site Recovery Manager 8.3 Configuration Import/Export Tool exports the configuration data on the recovery site. The default location for the exported configuration data is /opt/vmware/impex/exports. You can change the location by modifying the export script, see Modify the Export Script of the VMware Site Recovery Manager 8.3 Configuration Import/Export Tool.

Export Site Recovery Manager Configuration Data with the Standalone Import/Export Tool

You can use the standalone VMware Site Recovery Manager 8.3 Configuration Import/Export Tool to export Site Recovery Manager configuration data in an XML file.

Prerequisites

- Verify that you have Java 1.8.x or later installed and environment variables configured on the Site Recovery Manager host virtual machine.
- Verify that you have a site pair with Site Recovery Manager running on both the protected and the recovery sites.

Procedure

1 Download the VMware Site Recovery Manager 8.3 Configuration Import/Export Tool .zip file in a folder on the Site Recovery Manager host virtual machine.

2 Extract the tool from the archive.

3 Open a command shell, navigate to the folder where you extracted the tool, and run the following command.
   java -jar import-export-tool-8.3.0-<build_number>.jar --exportInteractive
To make the XML file more human-readable, add the `format` option. Adding the `format` option significantly increases the XML file size.

```java
java -jar import-export-tool-8.3.0-<build_number>.jar --exportInteractive --format
```

4. Enter the host name or the IP address of the Lookup Service.

5. Enter the port number or press Enter, if you use the default port.

6. Accept the SHA-1 Thumbprint.

7. (Optional) Select whether to use Java keystore instead of the local vCenter Server credentials.

   **Note**  The Java keystore must hold certificate and key for a **solution** user with read permissions for the local vCenter Server and Site Recovery Manager.

   a. If you select yes, follow the prompts and provide the necessary information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keystore type</td>
<td>Press Enter to use the default keystore type JCEKS, or provide a keystore type.</td>
</tr>
<tr>
<td>Keystore path</td>
<td>Path to the Java keystore. For example, <code>path:/opt/vmware/impex/ks/ks.keystore</code>.</td>
</tr>
<tr>
<td>Keystore password</td>
<td>The password for the Java keystore.</td>
</tr>
<tr>
<td>Keystore certificate</td>
<td>The certificate alias for the solution user for the local vCenter Server.</td>
</tr>
<tr>
<td>Keystore key</td>
<td>The key alias for the solution user for the local vCenter Server.</td>
</tr>
<tr>
<td>Keystore key password</td>
<td>The key password for the solution user for the local vCenter Server.</td>
</tr>
</tbody>
</table>

8. If you selected no, enter the user name and password for the local vCenter Server instance.

9. Select a local Site Recovery Manager instance.

10. (Optional) Select whether to use Java keystore instead of the remote vCenter Server credentials.

    **Note**  The Java keystore must hold certificate and key for a **solution** user with read permissions for the remote vCenter Server and Site Recovery Manager.

    a. If you select yes, follow the prompts and provide the necessary information.

    | Option               | Description                                                                 |
    |----------------------|-----------------------------------------------------------------------------|
    | Keystore type        | Press Enter to use the default keystore type JCEKS, or provide a keystore type. |
    | Keystore path        | Path to the Java keystore. For example, `path:/opt/vmware/impex/ks/ks.keystore`. |
    | Keystore password    | The password for the Java keystore.                                          |
    | Keystore certificate | The certificate alias for the solution user for the remote vCenter Server.    |
    | Keystore key         | The key alias for the solution user for the remote vCenter Server.            |
    | Keystore key password| The key password for the solution user for the remote vCenter Server.         |
11 If you selected no, enter user name and password for the remote vCenter Server instance.

**Use a Properties File to Export Site Recovery Manager Configuration Data**

You can use a properties file to simplify or automate the export of Site Recovery Manager configuration data in an XML file.

If you are using the Site Recovery Manager appliance, you can Schedule an Export of Site Recovery Manager Configuration Data by Using a Cron Job.

**Prerequisites**

- Verify that you have Java 1.8.x or later installed on the Site Recovery Manager host virtual machine.
- Verify that you have a site pair with Site Recovery Manager running on both the protected and the recovery site.
- Verify that you have Properties for Automated Export and Import of Site Recovery Manager Configuration Data.

**Procedure**

1. Download the VMware Site Recovery Manager 8.3 Configuration Import/Export Tool in a folder on the Site Recovery Manager host virtual machine.

2. Open a command shell, navigate to the download folder, and run the following command.

```
java -jar import-export-tool-8.3.0-<build_number>.jar --exportProperties=Path_to_properties_file
```

To make the XML file more readable, add the `format` option.

```
java -jar import-export-tool-8.3.0-<build_number>.jar --exportProperties=Path_to_properties_file --format
```

**Import the Site Recovery Manager Configuration Data through the User Interface**

You can use the Site Recovery User Interface to import Site Recovery Manager configuration data from a previously exported XML file.

**Prerequisites**

Provide a clean Site Recovery Manager installation, registered with the same vCenter Server instance or with a vCenter Server instance with the same inventory as the exported.

**Procedure**

1. In the vSphere Client or the vSphere Web Client, click Site Recovery > Open Site Recovery.

2. On the Site Recovery home tab, select a site pair, and click View Details.
3 On the **Summary** tab, click **Export/Import SRM Configuration > Import**.

4 On the **Confirmation** page, select the check boxes, and click **Next**.

5 Click **Browse**, navigate to the previously exported XML file, and click **Import**.

6 If the selected export file contains array managers, select which array manager pairs to import and provide credentials, and click **Import**.

   If there are problems with an import stage, you can download a CSV report file.

7 When the import is complete, click **Close**.

---

**Import Site Recovery Manager Configuration Data with the Standalone Import/Export Tool**

You can use the standalone VMware Site Recovery Manager 8.3 Configuration Import/Export Tool to import Site Recovery Manager configuration data from a previously exported XML file.

**Prerequisites**

- Provide a clean Site Recovery Manager installation, registered with the same vCenter Server instance or with a vCenter Server instance with the same inventory as the exported.

- Verify that you have Java 1.8.x or later installed and environment variables configured on the Site Recovery Manager host virtual machine.

**Procedure**

1 Download the VMware Site Recovery Manager 8.3 Configuration Import/Export Tool.zip file in a folder on the Site Recovery Manager host virtual machine.

2 Extract the tool from the archive.

3 Open a command shell, navigate to the folder of the VMware Site Recovery Manager 8.3 Configuration Import/Export Tool, and run the following command.

   ```
   java -jar import-export-tool-8.3.0-<build_number>.jar --importInteractive --path Path_to_exported_XML_file
   ```

   By default the VMware Site Recovery Manager 8.3 Configuration Import/Export Tool is set to retry the import of virtual machines recovery settings after a delay of 10 000 milliseconds up to five times. You can manually change the default values for retry counts and delay between retries by adding the `retries` and `delay` options to the import command. For example, to make 10 retries with a 20 seconds delay, run the following command.

   ```
   java -jar import-export-tool-8.3.0-<build_number>.jar --importInteractive --path Path_to_exported_XML_file --delay 20000 --retries 10
   ```

4 Enter the host name or the IP address of the Platform Services Controller.

5 Enter the port number or press Enter to use the default.

6 Accept the SHA-1 Thumbprint.
7 (Optional) Select whether to use Java keystore instead of the local vCenter Server credentials or not.
   a If you select yes, follow the prompts and provide the necessary information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keystore type</td>
<td>Press Enter to use the default keystore type JCEKS, or provide a keystore type.</td>
</tr>
<tr>
<td>Keystore path</td>
<td>Path to the Java keystore. For example, path:/opt/vmware/impex/ks/ks.keystore.</td>
</tr>
<tr>
<td>Keystore password</td>
<td>The password for the Java keystore.</td>
</tr>
<tr>
<td>Keystore certificate</td>
<td>The certificate alias for the solution user for the local vCenter Server.</td>
</tr>
<tr>
<td>Keystore key</td>
<td>The key alias for the solution user for the local vCenter Server.</td>
</tr>
<tr>
<td>Keystore key password</td>
<td>The key password for the solution user for the local vCenter Server.</td>
</tr>
</tbody>
</table>

8 If you selected no, enter user name and password for the local vCenter Server instance.

9 Select a local Site Recovery Manager.

10 (Optional) Select whether to use Java keystore instead of the remote vCenter Server credentials or not.
   a If you select yes, follow the prompts and provide the necessary information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keystore type</td>
<td>Press Enter to use the default keystore type JCEKS, or provide a keystore type.</td>
</tr>
<tr>
<td>Keystore path</td>
<td>Path to the Java keystore. For example, path:/opt/vmware/impex/ks/ks.keystore.</td>
</tr>
<tr>
<td>Keystore password</td>
<td>The password for the Java keystore.</td>
</tr>
<tr>
<td>Keystore certificate</td>
<td>The certificate alias for the solution user for the remote vCenter Server.</td>
</tr>
<tr>
<td>Keystore key</td>
<td>The key alias for the solution user for the remote vCenter Server.</td>
</tr>
<tr>
<td>Keystore key password</td>
<td>The key password for the solution user for the remote vCenter Server.</td>
</tr>
</tbody>
</table>

11 If you selected no, enter user name and password for the remote vCenter Server instance.

12 Provide credentials for the array managers.

Results

The VMware Site Recovery Manager 8.3 Configuration Import/Export Tool imports the Site Recovery Manager configuration data to the new Site Recovery Manager instance.

Use a Properties File to Import Site Recovery Manager Configuration Data

You can use a properties file to simplify or automate the import of Site Recovery Manager configuration data from an XML file.
Prerequisites

- Provide a clean Site Recovery Manager installation, registered with the same vCenter Server instance or with a vCenter Server instance with the same inventory as the exported.
- Verify that you have Java 1.8.x or later installed and environment variables configured on the Site Recovery Manager host virtual machine.
- Verify that you have Properties for Automated Export and Import of Site Recovery Manager Configuration Data.

Procedure

1. Download the VMware Site Recovery Manager 8.3 Configuration Import/Export Tool .zip file in a folder on the Site Recovery Manager host virtual machine.
2. Extract the tool from the archive.
3. Open a command shell, navigate to the download folder, and run the following command.

   ```
   java -jar import-export-tool-8.3.0-<build_number>.jar --
   importProperties=Path_to_properties_file --path Path_to_exported_XML_file
   ```

Syntax of the Import/Export Tool

The VMware Site Recovery Manager 8.3 Configuration Import/Export Tool includes options that you can use to import or export configuration data. You can also use the options to change the delay between retries when importing virtual machine recovery settings, to customize the number of retries, to override the network mappings with the mappings from the XML file, and so on.

Table 13-1. VMware Site Recovery Manager 8.3 Configuration Import/Export Tool Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--export</td>
<td>Required when doing an export. Cannot be used together with --import.</td>
</tr>
<tr>
<td>--exportProperties</td>
<td>Used for exporting data by using a properties file.</td>
</tr>
<tr>
<td>--exportInteractive</td>
<td>Used to start an interactive export with prompts for the required information.</td>
</tr>
<tr>
<td>--importProperties</td>
<td>Required when importing configuration data with a properties file. Cannot be used together with --export.</td>
</tr>
<tr>
<td>--importInteractive</td>
<td>Used to start an interactive import with prompts for the required information.</td>
</tr>
<tr>
<td>--lspp</td>
<td>The Platform Services Controller address. It can be an IP address or FQDN.</td>
</tr>
<tr>
<td>--port &lt;[1, 2147483647]&gt;</td>
<td>The port number for the Lookup Service. The default value is 443.</td>
</tr>
<tr>
<td>--localSrmName</td>
<td>The name of the local Site Recovery Manager Server. Required unless you use --localSrmGuid.</td>
</tr>
</tbody>
</table>
Table 13-1. VMware Site Recovery Manager 8.3 Configuration Import/Export Tool Options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--localSrmGuid</td>
<td>The guid of the local Site Recovery Manager Server. Required unless you use --localSrmName.</td>
</tr>
<tr>
<td>--localAuthUseKeystore</td>
<td>Used to specify whether to use a Java Keystore (JKS) file to log in to the local site.</td>
</tr>
<tr>
<td>--localAuthCredsUsername</td>
<td>Required when not using JKS. The user name for the local vCenter Server.</td>
</tr>
<tr>
<td>--localAuthCredsPass</td>
<td>Required when not using JKS. The password for the local vCenter Server.</td>
</tr>
<tr>
<td>--localAuthKsType</td>
<td>Used to specify the type of the JKS. The default type is JCEKS.</td>
</tr>
<tr>
<td>--localAuthKsPath</td>
<td>Used to specify the path to the local JKS.</td>
</tr>
<tr>
<td>--localAuthKsPass</td>
<td>Used to specify the JKS password.</td>
</tr>
<tr>
<td>--localAuthKsCertAlias</td>
<td>Used to specify the local solution user certificate alias.</td>
</tr>
<tr>
<td>--localAuthKsKeyAlias</td>
<td>Used to specify the local solution user key alias.</td>
</tr>
<tr>
<td>--localAuthKsKeyPass</td>
<td>Used to specify the local solution user key password.</td>
</tr>
<tr>
<td>--remoteAuthUseKeystore</td>
<td>Use to specify whether to use a Java Keystore file to log in to the remote site.</td>
</tr>
<tr>
<td>--remoteAuthCredsUsername</td>
<td>Required when not using JKS. The password for the remote vCenter Server.</td>
</tr>
<tr>
<td>--remoteAuthCredsPass</td>
<td>Required when not using JKS. The password for the remote vCenter Server.</td>
</tr>
<tr>
<td>--remoteAuthKsType</td>
<td>Used to specify the type of the JKS. The default type is JCEKS.</td>
</tr>
<tr>
<td>--remoteAuthKsPath</td>
<td>Used to specify the path to the remote JKS.</td>
</tr>
<tr>
<td>--remoteAuthKsPass</td>
<td>Used to specify the remote JKS password.</td>
</tr>
<tr>
<td>--remoteAuthKsCertAlias</td>
<td>Used to specify the remote solution user certificate alias.</td>
</tr>
<tr>
<td>--remoteAuthKsKeyAlias</td>
<td>Used to specify the remote solution user key alias.</td>
</tr>
<tr>
<td>--remoteAuthKsKeyPass</td>
<td>Used to specify the remote solution user key password.</td>
</tr>
<tr>
<td>--path</td>
<td>Used for importing data. Path to the previously exported file.</td>
</tr>
<tr>
<td>--delay &lt;[1, 2147483647]&gt;</td>
<td>An integer value for the desired delay between retries in milliseconds when importing recovery settings. The default value is 10000.</td>
</tr>
<tr>
<td>--retries &lt;[1, 2147483647]&gt;</td>
<td>An integer value for the count of the retries when importing recovery settings. The default value is 5.</td>
</tr>
</tbody>
</table>
Table 13-1. VMware Site Recovery Manager 8.3 Configuration Import/Export Tool Options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| --overrideProtectionSettings | Used to override the network mappings.  
   - If there is a protection group, the tool attempts to update the network mappings for each protected virtual machine (override the site-level mappings) with the mappings from the XML file.  
   - If there is a recovery plan, the tool attempts to update the test network mappings for the recovery plan with the mappings from the XML file. |
| --format                | Used to make the exported XML file better formatted and human-readable. The --format option significantly increases the file size.            |
| --exportPath            | Path to a directory in which to create the exported file.                                                                                   |

Properties for Automated Export and Import of Site Recovery Manager Configuration Data

You can use the VMware Site Recovery Manager 8.3 Configuration Import/Export Tool properties file to automate the export and import of configuration data.

The use of srm_configuration.properties file with the standalone VMware Site Recovery Manager 8.3 Configuration Import/Export Tool is optional.

Table 13-2. Required Parameters for the Properties File

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lookup.service.address</td>
<td>The Platform Services Controller address. Can be an IP address or FQDN.</td>
</tr>
<tr>
<td>local.srm.name</td>
<td>The name of the local Site Recovery Manager Server.</td>
</tr>
<tr>
<td>local.auth.use.keystore</td>
<td>Set this parameter to true to use Java Keystore to log in to the local site. The default value is false.</td>
</tr>
<tr>
<td>local.auth.credentials.vc.username</td>
<td>The user name for the local vCenter Server. Required when local.auth.use.keystore is set to false.</td>
</tr>
<tr>
<td>local.auth.credentials.vc.password</td>
<td>The password for the local vCenter Server. Required when local.auth.use.keystore is set to false.</td>
</tr>
<tr>
<td>local.auth.keystore.type</td>
<td>The type of Java Keystore. Required when local.auth.use.keystore is set to true. The default type is JCEKS.</td>
</tr>
<tr>
<td>local.auth.keystore.path</td>
<td>Path to the Java Keystore. Required when local.auth.use.keystore is set to true.</td>
</tr>
<tr>
<td>local.auth.keystore.pass</td>
<td>Password for the Java Keystore. Required when local.auth.use.keystore is set to true.</td>
</tr>
<tr>
<td>local.auth.keystore.certAlias</td>
<td>Certificate alias for the local solution user in the Java Keystore. Required when local.auth.use.keystore is set to true.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>local.auth.keystore.keyAlias</td>
<td>Key alias for the local solution user in the Java Keystore. Required when <code>local.auth.use.keystore</code> is set to <code>true</code>.</td>
</tr>
<tr>
<td>local.auth.keystore.keyPass</td>
<td>The key password for the local solution user in the Java Keystore. Required when <code>local.auth.use.keystore</code> is set to <code>true</code>.</td>
</tr>
<tr>
<td>remote.auth.use.keystore</td>
<td>Set this parameter to <code>true</code> to use Java Keystore to log in to the remote site. The default value is <code>false</code>.</td>
</tr>
<tr>
<td>remote.auth.credentials.vc.username</td>
<td>The user name for the remote vCenter Server. Required when <code>remote.auth.use.keystore</code> is set to <code>false</code>. Required if your environment is not federated.</td>
</tr>
<tr>
<td>remote.auth.credentials.vc.password</td>
<td>The password of the user for the remote vCenter Server. Required when <code>remote.auth.use.keystore</code> is set to <code>false</code>. Required if your environment is not federated.</td>
</tr>
<tr>
<td>remote.auth.keystore.type</td>
<td>The type of Java Keystore. Required when <code>remote.auth.use.keystore</code> is set to <code>true</code>. The default type is JCEKS.</td>
</tr>
<tr>
<td>remote.auth.keystore.path</td>
<td>Path to the Java Keystore. Required when <code>remote.auth.use.keystore</code> is set to <code>true</code>.</td>
</tr>
<tr>
<td>remote.auth.keystore.pass</td>
<td>Password for the Java Keystore. Required when <code>remote.auth.use.keystore</code> is set to <code>true</code>.</td>
</tr>
<tr>
<td>remote.auth.keystore.certAlias</td>
<td>Certificate alias for the remote solution user in the Java Keystore. Required when <code>remote.auth.use.keystore</code> is set to <code>true</code>.</td>
</tr>
<tr>
<td>remote.auth.keystore.keyAlias</td>
<td>Key alias for the remote solution user in the Java Keystore. Required when <code>remote.auth.use.keystore</code> is set to <code>true</code>.</td>
</tr>
<tr>
<td>remote.auth.keystore.keyPass</td>
<td>The key password for the remote solution user in the Java Keystore. Required when <code>remote.auth.use.keystore</code> is set to <code>true</code>.</td>
</tr>
<tr>
<td>array.manager.n.name</td>
<td>The name of the array manager, where <code>n</code> is a number. All array managers must be defined at least by a name and a skip flag. Required field for import, if your environment contains any array managers.</td>
</tr>
<tr>
<td>array.manager.n.skip</td>
<td>Sets whether the array manager must be imported or skipped. The default value is <code>false</code>. Required if <code>array.manager.n.name</code> is present.</td>
</tr>
<tr>
<td>array.manager.n.username</td>
<td>The user name for the array manager. Required if <code>array.manager.n.name</code> is present and <code>array.manager.n.skip</code> value is set to <code>false</code>.</td>
</tr>
<tr>
<td>array.manager.n.password</td>
<td>The password for the array manager. Required if <code>array.manager.n.name</code> is present and <code>array.manager.n.skip</code> value is set to <code>false</code>.</td>
</tr>
</tbody>
</table>
Table 13-3. Optional Parameters for the Properties File

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>port</td>
<td>The port number for the Lookup Service. The default value is 443.</td>
</tr>
<tr>
<td>continue.after.array.manager.errors</td>
<td>If you set the value to true, the tool does not fail when an array manager is missing or there is an array-based error. The default value is false.</td>
</tr>
</tbody>
</table>

Example: Sample Properties File

```
lookup.service.address=my.psc.address.com
port=443
local.srm.name=My local SRM
local.auth.credentials.vc.username=localAdmin
local.auth.credentials.vc.password=localAdminSecretPass
remote.auth.credentials.vc.username=remoteAdmin
remote.auth.credentials.vc.password=remoteAdminSecretPass
continue.after.array.manager.errors=false
array.manager.1.name=am_1
array.manager.1.skip=false
array.manager.1.username=amlAdminUserName
array.manager.1.password=amlAdminSecretPass
array.manager.2.name=am_2
array.manager.2.skip=true
array.manager.3.name=am_3
array.manager.3.skip=true
array.manager.4.name=am_4
array.manager.4.skip=true
```

Troubleshooting the VMware Site Recovery Manager 8.3 Configuration Import/Export Tool

If you encounter problems with exporting or importing Site Recovery Manager configuration data, you can troubleshoot the problem.

When searching for the cause of a problem, also check the VMware knowledge base at http://kb.vmware.com/.

- **Export Fails with an Error About a Duplicate Key**
  When you try to export Site Recovery Manager configuration data, the export fails with an error about duplicate INSTANCE_UUID values.

**Export Fails with an Error About a Duplicate Key**

When you try to export Site Recovery Manager configuration data, the export fails with an error about duplicate INSTANCE_UUID values.
**Problem**

When you try to export Site Recovery Manager configuration data, the export fails due to the following error "Export ended with errors, check log for more information. Error: Duplicate key 1_vm_vm=123456".

**Cause**

The problem can occur when a virtual machine and a virtual machine template in one of the vCenter Server inventories have the same INSTANCE_UUIDs. The virtual machine and the virtual machine template must have different INSTANCE_UUID values.

The 1_ prefix in the error message means that the objects with the same INSTANCE_UUIDs are in the inventory of the local site. An r_ prefix in the error message means that the objects with the same INSTANCE_UUIDs are in the inventory of the remote site. The local site is the site from which the export operation is initiated, the remote site is the other site in the Site Recovery Manager pair. The end part of the error message vm=123456 represents the ManagedObjectReference value of one of the vCenter Server objects.

**Solution**

Delete the virtual machine or the virtual machine template from the vCenter Server inventory. Deleting one of the objects removes the duplicate key.
You can upgrade existing Site Recovery Manager installations. The Site Recovery Manager upgrade process preserves existing information about Site Recovery Manager configurations.


To revert to Site Recovery Manager 8.2 after upgrading to Site Recovery Manager 8.3, see Revert to a Previous Release of Site Recovery Manager.

- Information That Site Recovery Manager Upgrade Preserves
  - The Site Recovery Manager upgrade procedure preserves information from existing installations.

- Types of Site Recovery Manager Upgrade
  - Site Recovery Manager supports in-place upgrade and upgrade with migration.

- Upgrade Site Recovery Manager for Windows
  - You perform several tasks to upgrade Site Recovery Manager for Windows.

- Update the Site Recovery Manager Virtual Appliance
  - You use the Site Recovery Manager Appliance Management Interface to apply patches and updates to the virtual appliance.

### Information That Site Recovery Manager Upgrade Preserves

The Site Recovery Manager upgrade procedure preserves information from existing installations.

Site Recovery Manager preserves settings and configurations that you created for the previous release.

- Datastore groups
- Protection groups
- Inventory mappings
- Recovery plans
- IP customizations for individual virtual machines
- Custom roles and their memberships
- Site Recovery Manager object permissions in vSphere
- Custom alarms and alarm actions
- Test plan histories
- Security certificates
- Mass IP customization files (CSVs)

During an upgrade, Site Recovery Manager does not retain any advanced settings that you configured in the previous installation. This is by design.

**Important** During an upgrade, Site Recovery Manager preserves only protection groups and recovery plans that are in a valid state.

## Types of Site Recovery Manager Upgrade

Site Recovery Manager supports in-place upgrade and upgrade with migration.
### Table 14-1. Types of Site Recovery Manager Upgrade

<table>
<thead>
<tr>
<th>Upgrade Type</th>
<th>Description</th>
<th>Supported</th>
</tr>
</thead>
</table>
| In-place upgrade of Site Recovery Manager              | 1  (Optional) Upgrade the Platform Services Controller and vCenter Server instances associated with Site Recovery Manager.  
2  Run the new version of the Site Recovery Manager installer on the existing Site Recovery Manager Server host machine, connecting to the existing database. | Yes       |
| Upgrade Site Recovery Manager with migration           | 1  (Optional) Upgrade the Platform Services Controller and vCenter Server instances associated with Site Recovery Manager.  
2  Stop the existing Site Recovery Manager Server. Keep the old version of Site Recovery Manager Server and make sure that you retain the database contents.  
3  Run the new version of the Site Recovery Manager installer on the new host or virtual machine, connecting to the existing Platform Services Controller and database. | Yes       |
| New vCenter Server installation with migration of Site Recovery Manager | Create new installations of vCenter Server and migrate Site Recovery Manager Server to these new vCenter Server instances.                                                                                   | No        |

**Upgrade Site Recovery Manager for Windows**

You perform several tasks to upgrade Site Recovery Manager for Windows.


Upgrading from Site Recovery Manager 5.8.x to Site Recovery Manager 8.3 is not supported.

1  You must first upgrade Site Recovery Manager from 5.8.x to 6.0.x.

2  After upgrading Site Recovery Manager to 6.0.x, you must reconfigure the pairing between the Site Recovery Manager instances on the protected and the recovery site.

3  Upgrade Site Recovery Manager from 6.0.x to 6.1.2.x.
4 After upgrading Site Recovery Manager to 6.1.2.x, you must reconfigure the pairing between the Site Recovery Manager instances on the protected and the recovery site.

5 Upgrade Site Recovery Manager from 6.1.2.x to 8.1.1 or 8.1.2.

6 After upgrading Site Recovery Manager to 8.1.1 or 8.1.2, you must reconfigure the pairing between the Site Recovery Manager instances on the protected and the recovery site.

Upgrading from Site Recovery Manager 6.0.x to Site Recovery Manager 8.3 is not supported.

1 Upgrade Site Recovery Manager 6.0.x to Site Recovery Manager 6.1.2.x. See Upgrading Site Recovery Manager in the Site Recovery Manager 6.1 documentation for information about upgrading to 6.1.x.

2 After upgrading Site Recovery Manager to 6.1.2.x, you must reconfigure the pairing between the Site Recovery Manager instances on the protected and the recovery site.

3 Upgrade Site Recovery Manager from 6.1.2.x to 8.1.1 or 8.1.2.

4 After upgrading Site Recovery Manager to 8.1.1 or 8.1.2, you must reconfigure the pairing between the Site Recovery Manager instances on the protected and the recovery site.

You must perform the upgrade tasks in order. Complete all of the upgrade tasks on the protected site first, then complete the tasks on the recovery site.

Procedure

1 Order of Upgrading vSphere and Site Recovery Manager Components
   There are alternative strategies for the upgrade of Site Recovery Manager sites. You can upgrade all components of one of your sites before upgrading all the components on the other site or you can upgrade the Site Recovery Manager components on both sites.

2 Prerequisites and Best Practices for Site Recovery Manager Upgrade
   Before you upgrade Site Recovery Manager, you must perform preparatory tasks on both Site Recovery Manager sites and verify that you have certain information.

3 In-Place Upgrade of Site Recovery Manager Server
   An in-place upgrade provides a quick way to upgrade Site Recovery Manager Server without changing the information that you provided for the previous installation.

4 Upgrade Site Recovery Manager Server with Migration
   You can upgrade Site Recovery Manager and migrate Site Recovery Manager Server to a different host than the previous Site Recovery Manager Server installation.

5 Configure and Verify the Upgraded Site Recovery Manager Installation
   You must configure the upgraded components to establish a working Site Recovery Manager installation.

6 Revert to a Previous Release of Site Recovery Manager
   To revert to a previous release of Site Recovery Manager, you must uninstall Site Recovery Manager from the protected and recovery sites. Then reinstall the previous release.
Order of Upgrading vSphere and Site Recovery Manager Components

There are alternative strategies for the upgrade of Site Recovery Manager sites. You can upgrade all components of one of your sites before upgrading all the components on the other site or you can upgrade the Site Recovery Manager components on both sites.

When you upgrade all components of one of your sites, it is a best practice to upgrade the Site Recovery Manager components before the Platform Services Controller and the vCenter Server components.

An alternative strategy is to upgrade the Site Recovery Manager components on both sites before upgrading the Platform Services Controller and vCenter Server components.

You can upgrade the ESXi hosts at any time.

**Important** If you configured bidirectional protection, in which each site acts as the recovery site for the virtual machines on the other site, upgrade the most critical of the sites first.

Upgrading Site Recovery Manager by Sites

Upgrade the protected site first, so you can perform a disaster recovery on the recovery site if you encounter problems during the upgrade that render the protected site unusable.

1. If you use vSphere Replication, upgrade any additional vSphere Replication servers on the protected site.
2. Upgrade the vSphere Replication appliance on the protected site.
3. Upgrade Site Recovery Manager Server on the protected site.
4. If you use array-based replication, upgrade the storage replication adapters (SRA) on the protected site.
5. (Optional) Upgrade the Platform Services Controller and all components of vCenter Server on the protected site.
6. (Optional) Upgrade the ESXi host on the protected site.
7. If you use vSphere Replication, upgrade any additional vSphere Replication servers on the recovery site.
8. Upgrade the vSphere Replication appliance on the recovery site.
9. Upgrade Site Recovery Manager Server on the recovery site.
10. If you use array-based replication, upgrade the storage replication adapters (SRA) on the recovery site.
11. (Optional) Upgrade the Platform Services Controller and all components of vCenter Server on the recovery site.
12. (Optional) Upgrade the ESXi hosts on the recovery site.
13. Verify the connection between the Site Recovery Manager sites.
14 Verify that your protection groups and recovery plans are still valid.

15 (Optional) Upgrade the virtual hardware and VMware Tools on the virtual machines on the ESXi hosts.

**Upgrading Site Recovery Manager by Components**

With this strategy, you can decide when to upgrade certain components. For example, you can delay the upgrade of the Platform Services Controller appliances and vCenter Server components or the ESXi hosts. Verify which new functionalities are available with earlier versions of vCenter Server.

1 If you use vSphere Replication, upgrade any additional vSphere Replication servers on the protected site.

2 Upgrade the vSphere Replication appliance on the protected site.

3 Upgrade Site Recovery Manager Server on the protected site.

4 If you use array-based replication, upgrade the storage replication adapters (SRA) on the protected site.

5 If you use vSphere Replication, upgrade any additional vSphere Replication servers on the recovery site.

6 Upgrade the vSphere Replication appliance on the recovery site.

7 Upgrade Site Recovery Manager Server on the recovery site.

8 If you use array-based replication, upgrade the storage replication adapters (SRA) on the recovery site.

9 (Optional) Upgrade the Platform Services Controller and all components of vCenter Server on the protected site.

10 (Optional) Upgrade the Platform Services Controller and all components of vCenter Server on the recovery site.

11 Verify the connection between the Site Recovery Manager sites.

12 Verify that your protection groups and recovery plans are still valid.

13 (Optional) Upgrade the ESXi host on the recovery site.

14 (Optional) Upgrade the ESXi host on the protected site.

15 (Optional) Upgrade the virtual hardware and VMware Tools on the virtual machines on the ESXi hosts.
Prerequisites and Best Practices for Site Recovery Manager Upgrade

Before you upgrade Site Recovery Manager, you must perform preparatory tasks on both Site Recovery Manager sites and verify that you have certain information.

- Make a full backup of the Site Recovery Manager database by using the tools that the database software provides. For information about how to back up the embedded database, see Back Up and Restore the Embedded vPostgres Database. Migration of data from an external database to the embedded database is not supported. Failure to back up the database results in the loss of all Site Recovery Manager data if the upgrade fails.

- If you configured advanced settings in the existing installation, take a note of the settings that you configured in Site Pair > Configure > Advanced Settings in the Site Recovery user interface.

- Before you upgrade, check the supported upgrade paths. For information about supported upgrade paths, see Upgrade Path > VMware vCenter Site Recovery Manager in the VMware Product Interoperability Matrixes at http://partnerweb.vmware.com/comp_guide2/sim/interop_matrix.php? before you upgrade.

- The local and remote Platform Services Controller and vCenter Server instances must be running when you upgrade Site Recovery Manager.

- Upgrade Platform Services Controller and vCenter Server on the site on which you are upgrading Site Recovery Manager to a supported version.
  - For information about how to upgrade vCenter Server and its components, see vCenter Server Upgrade in the ESXi and vCenter Server Documentation.
  - For information about the order in which to upgrade the components on each site, see Order of Upgrading vSphere and Site Recovery Manager Components.

- Obtain the address of the Platform Services Controller instance for both sites.

- Obtain the vCenter Single Sign-On administrator user name and password for both of the local and remote sites.

- Obtain the user name and password for the Site Recovery Manager database, if you are not using the embedded database.

- To use Site Recovery Manager with vSphere Replication, upgrade vSphere Replication on both of the protected and the recovery sites before you upgrade Site Recovery Manager Server. After upgrading vSphere Replication, you must restart the Site Recovery Manager Server. See Order of Upgrading vSphere and Site Recovery Manager Components.

- For information about how to upgrade vSphere Replication, see Upgrading vSphere Replication in vSphere Replication Administration.

If you cannot upgrade an existing incompatible version of vSphere Replication, you must unregister vSphere Replication from both vCenter Server instances before you upgrade Site Recovery Manager. Incompatible versions of Site Recovery Manager and vSphere Replication cause the vSphere Web Client to stop working. See Unregister an Incompatible Version of vSphere Replication.

The Site Recovery Manager installer presents the SSL/TLS certificates of the vCenter Server components for validation when it runs. Obtain the necessary information to allow you validate the certificates for the Platform Services Controller instance on the local site and the Platform Services Controller and vCenter Server instances on the remote site.

If you use custom certificates, obtain an appropriate certificate file. Custom certificates must use at least the SHA1, or preferably SHA256, thumbprint algorithm. This release of Site Recovery Manager does not support certificates that use the MD5 thumbprint algorithm. See Requirements When Using Custom SSL/TLS Certificates with Site Recovery Manager.

Download the Site Recovery Manager installation file to a folder on the machines on which to upgrade Site Recovery Manager.

Verify that no reboot is pending on the Windows machine on which to install Site Recovery Manager Server. Verify that no other installation is running, including the silent installation of Windows updates. Pending reboots or running installations can cause the installation of Site Recovery Manager Server or the embedded Site Recovery Manager database to fail.

**Important** Verify that there are no pending cleanup operations on recovery plans and that there are no configuration issues for the virtual machines that Site Recovery Manager protects.

- All recovery plans are in the Ready state.
- The protection status of all of the protection groups is OK.
- The protection status of all of the individual virtual machines in the protection groups is OK.
- The recovery status of all of the protection groups is Ready.

Optimize the Adobe Flash Player settings in your browser to increase the amount of storage space that the vSphere Web Client can use. Performing a recovery with Site Recovery Manager can sometimes exceed the default amount of storage space that Flash Player is permitted to consume. For information about how to optimize the Flash Player settings for Site Recovery Manager in the vSphere Web Client, see http://kb.vmware.com/kb/2106096.

**In-Place Upgrade of Site Recovery Manager Server**

An in-place upgrade provides a quick way to upgrade Site Recovery Manager Server without changing the information that you provided for the previous installation.
With an in-place upgrade, you upgrade Site Recovery Manager Server on the same host machine as an existing Site Recovery Manager Server installation. To upgrade Site Recovery Manager and migrate the Site Recovery Manager Server to a different host machine, see Upgrade Site Recovery Manager Server with Migration.

When you upgrade Site Recovery Manager Server, you provide the address of the Platform Services Controller that the upgraded vCenter Server instance uses. For the subsequent steps of the upgrade, the Site Recovery Manager installer reuses information about vCenter Server connections, certificates, and database configuration from the previous Site Recovery Manager installation. The installer populates the text boxes in the installation wizard with the values from the previous installation.

To change installation information, for example, database connections, certificate location, or administrator credentials, you must run the installer in modify mode after you upgrade an existing Site Recovery Manager Server.

If existing configuration information is invalid for the upgrade, the upgrade fails. For example, the upgrade fails if the database is not accessible at the same DSN, or if vCenter Server is not accessible at the same port.

During upgrade, you cannot change the vCenter Server instance to which Site Recovery Manager connects. To connect to a different vCenter Server instance, you must install a new Site Recovery Manager Server.

**Prerequisites**

- Complete the tasks and obtain the information described in Prerequisites and Best Practices for Site Recovery Manager Upgrade.
- Make sure that the account you are using to log in to the Site Recovery Manager Server host machine has enough privileges.
- If you use an SQL Server database with Integrated Windows Authentication as the Site Recovery Manager database, use the same user account or an account with the same privileges when you upgrade Site Recovery Manager Server as you used when you created the Integrated Windows Authentication data source name (DSN) for SQL Server.

**Procedure**

1. Double-click the Site Recovery Manager installer, select an installation language, and click OK.
2. Follow the installer prompts to accept the license agreement, and verify that you satisfied the installation prerequisites.
3 Verify or modify the information about the Platform Services Controller at the site where you are upgrading Site Recovery Manager Server, enter the vCenter Single Sign-On password, and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>The host name or IP address of the Platform Services Controller for the vCenter Server with which to register Site Recovery Manager. If the address of the Platform Services Controller changed during the upgrade of vCenter Server, enter the new address. Enter the host name in lowercase letters. After the upgrade is complete and you are configuring the connection between the protected and recovery sites, supply this host name or IP address exactly as you enter it here, because it is subject to case-sensitive comparisons. <strong>Important</strong> To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.</td>
</tr>
<tr>
<td>HTTPS Port</td>
<td>Accept the default value of 443 or enter a new value if Platform Services Controller uses a different port.</td>
</tr>
<tr>
<td>User name</td>
<td>The vCenter Single Sign-On user name for the vCenter Single Sign-On domain to which this Platform Services Controller instance belongs. This user account must be a member of the vCenter Single Sign-On administrator group on the Platform Services Controller instance. Only members of the administrator group have the necessary permissions to create or recreate the Site Recovery Manager solution user.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for the specified vCenter Single Sign-On user name.</td>
</tr>
</tbody>
</table>

4 If prompted, verify the Platform Services Controller certificate and click **Accept** to accept it.

5 Verify the vCenter Server instance with which the Site Recovery Manager Server instance is registered, and click **Next**.

You cannot change the vCenter Server instance to which Site Recovery Manager is registered during upgrade.

6 Verify the Administrator email, Local Host, and Listener Port values and click **Next**.
7 Select a certificate type for the Site Recovery Manager instance and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Automatically generate certificate** | Use an automatically generated certificate:  
  a Select **Automatically generate certificate** and click **Next**.  
  b Enter text values for your organization and organization unit, typically, your company name and the name of your group in the company.  
  c Click **Next**. |
| **Load a certificate file** | Use a custom certificate:  
  a Select **Use a PKCS#12 certificate file** and click **Next**.  
  b Click **Browse**, navigate to the certificate file, and click **Open**. The certificate file must contain exactly one certificate with exactly one private key matching the certificate.  
  c Enter the certificate password.  
  d Click **Next**. |
| **Use existing certificate** | Select this option to retain the current certificate. |

8 Enter the password for the Site Recovery Manager database, and click **Next**.

9 Select the user account under which to run the Site Recovery Manager Server service and click **Next**.

  - Select **Use Local System Account** to run the Site Recovery Manager Server service under the Local System account.
  - Enter the username and password of an existing LDAP user account to run the Site Recovery Manager Server service under a different user account. This can be any user account, including local users, that is a member of the built-in Administrators group.
  
  This option is not available if you use an SQL Server database with Integrated Windows Authentication. In this case, the Site Recovery Manager Server service runs under the account that you use to install Site Recovery Manager.

10 Click **Install**.

11 After the installation is finished, click **Finish**.

12 Log in to the vSphere Web Client or the vSphere Client, or if you are already connected to the vSphere Web Client or the vSphere Client, log out and log in again.

  The upgraded Site Recovery Manager extension appears in vSphere Web Client or the vSphere Client. You might need to clear the browser cache for the upgrade to appear.

  If the upgrade still does not appear, restart the vSphere Web Client or vSphere Client service.

13 Click **Site Recovery > Open Site Recovery** in the vSphere Web Client or the vSphere Client.

14 On the Site Recovery home tab, select a site pair and click **View Details**.

15 On the **Summary** tab, expand the Site Recovery Manager information to verify that the build number for Site Recovery Manager Server reflects the upgrade.
What to do next

- Repeat the procedure to upgrade the Site Recovery Manager Server on the other Site Recovery Manager site.
- Reconfigure the site pairing, if you perform the following changes during upgrade:
  - Change the Platform Services Controller address.
  - Changed the Site Recovery Manager, Platform Services Controller, or the vCenter Server certificate.
  
  For information about site pairing, see Reconfigure the Connection Between Sites.
- After you have upgraded both sites, see Configure and Verify the Upgraded Site Recovery Manager Installation.

Upgrade Site Recovery Manager Server with Migration

You can upgrade Site Recovery Manager and migrate Site Recovery Manager Server to a different host than the previous Site Recovery Manager Server installation.

To upgrade Site Recovery Manager and migrate Site Recovery Manager Server to a different host, you create a new Site Recovery Manager Server installation on the new host, and connect it to the Site Recovery Manager database from the previous installation.

**Important** Do not uninstall the old Site Recovery Manager Server installation after you complete the upgrade. If you uninstall the old Site Recovery Manager Server installation, this will unregister the new installation from vCenter Server.

To upgrade Site Recovery Manager and keep Site Recovery Manager Server on the same host as the previous installation, see In-Place Upgrade of Site Recovery Manager Server.

Prerequisites

- Complete the tasks and obtain the information described in Prerequisites and Best Practices for Site Recovery Manager Upgrade.
- Log in using an account with sufficient privileges. This is an Active Directory domain administrator, or a local administrator.
- You can only upgrade Site Recovery Manager with migration if you use an external database with the previous installation. You cannot migrate the contents of the embedded database.
- Create a 64-bit ODBC system data source name (DSN) on the new host machine to connect to the existing Site Recovery Manager database that you used with the previous version. For information about creating an ODBC DSN, see Create an ODBC System DSN for Site Recovery Manager.
- If you use an SQL Server database with Integrated Windows Authentication as the Site Recovery Manager database, use the same user account or an account with the same privileges when you upgrade Site Recovery Manager Server as you used when you created the Integrated Windows Authentication DSN for SQL Server.
Procedure

1. Log in to the host machine on which the previous version of Site Recovery Manager Server is running.

2. Stop the Site Recovery Manager Server service on the old Site Recovery Manager Server host.

3. Log in to the host machine on which to install the new version of Site Recovery Manager Server.

4. Double-click the Site Recovery Manager installer, select an installation language, and click OK.

5. Follow the installer prompts to accept the license agreement, and verify that you satisfied the installation prerequisites.

6. Select where to install Site Recovery Manager Server, and click Next.
   - Keep the default destination folder.
   - Click Change to change the destination folder, and select a target volume.
     The default installation folder for Site Recovery Manager is C:\Program Files\VMware\VMware vCenter Site Recovery Manager. If you use a different folder, the pathname must be up to 120 characters including the end slash, and you must use ASCII characters.

7. Enter information about the Platform Services Controller at the site where you are upgrading Site Recovery Manager Server and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>The host name or IP address of the Platform Services Controller for the vCenter Server with which to register Site Recovery Manager. If the address of the Platform Services Controller changed during the upgrade of vCenter Server, enter the new address. Enter the host name in lowercase letters. After the upgrade is complete and you are configuring the connection between the protected and recovery sites, supply this host name or IP address exactly as you enter it here, because it is subject to case-sensitive comparisons. Important To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.</td>
</tr>
<tr>
<td>HTTPS Port</td>
<td>Accept the default value of 443 or enter a new value if Platform Services Controller uses a different port.</td>
</tr>
<tr>
<td>User name</td>
<td>The vCenter Single Sign-On user name for the vCenter Single Sign-On domain to which this Platform Services Controller instance belongs. This user account must be a member of the vCenter Single Sign-On administrator group on the Platform Services Controller instance. Only members of the administrator group have the necessary permissions to create or recreate the Site Recovery Manager solution user.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for the specified vCenter Single Sign-On user name.</td>
</tr>
</tbody>
</table>

8. If prompted, verify the Platform Services Controller certificate and click Accept to accept it.
9  Select the vCenter Server instance with which to register Site Recovery Manager and click Next.

**Important** The drop-down menu includes all of the vCenter Server instances that are registered with the Platform Services Controller. In an environment that uses Enhanced Linked Mode, it can also include vCenter Server instances from other Platform Services Controller instances. Make sure that you select the correct vCenter Server instance. Once the Site Recovery Manager installation is complete, you cannot modify it to select a different vCenter Server instance.

10 Enter information with which to register the Site Recovery Manager extension with vCenter Server, and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Local Site Name</strong></td>
<td>A name for this Site Recovery Manager site, which appears in the Site Recovery Manager interface. The vCenter Server address is used by default. Use a different name for each Site Recovery Manager installation in the pair.</td>
</tr>
<tr>
<td><strong>Administrator E-mail</strong></td>
<td>Email address of the Site Recovery Manager administrator. This information is required even though you use the standard vCenter Server alarms to configure email notifications for Site Recovery Manager events.</td>
</tr>
<tr>
<td><strong>Local Host</strong></td>
<td>Name or IP address of the local host. The Site Recovery Manager installer obtains this value. Only change it if it is incorrect. For example, the local host might have more than one network interface and the one that the Site Recovery Manager installer detects is not the interface you want to use. <strong>Important</strong> To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.</td>
</tr>
<tr>
<td><strong>Listener Port</strong></td>
<td>HTTPS port for all management traffic to Site Recovery Manager Server, including traffic with external API clients for task automation. The port is also used by vSphere Web Client to download the Site Recovery Manager client plug-in. This port must be accessible from the vCenter Server proxy system. Do not change the port unless the default of 9086 causes port conflicts. <strong>Note</strong> Changing the listener port prevents you from using the VMware Site Recovery service on VMware Cloud on AWS.</td>
</tr>
<tr>
<td><strong>SRM UI Port</strong></td>
<td>HTTPS port for the Site Recovery Manager user interface. The default port is 443. If the Platform Services Controller is installed on the same machine, you must change this port.</td>
</tr>
</tbody>
</table>
11 Select the default Site Recovery Manager plug-in identifier, or create a plug-in identifier for this Site Recovery Manager Server pair, and click **Next**.

Both Site Recovery Manager Server instances in a site pair must use the same plug-in identifier.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default SRM Plug-in Identifier</td>
<td>Use this option when you install Site Recovery Manager in a standard configuration with one protected site and one recovery site.</td>
</tr>
<tr>
<td>Custom SRM Plug-in Identifier</td>
<td>Use this option when you install Site Recovery Manager in a shared recovery site configuration, with multiple protected sites and one recovery site. Enter the details of the plug-in identifier.</td>
</tr>
</tbody>
</table>

**Plug-in ID**

A unique identifier. Assign the same identifier to the Site Recovery Manager Server instances on the protected site and the shared recovery site.

**Organization**

The name of the organization to which this Site Recovery Manager Server pair belongs. This name helps to identify to Site Recovery Manager Server pairs in a shared recovery site configuration, especially when multiple organizations use the shared recovery site.

**Description**

An optional description of this Site Recovery Manager Server pair.

12 Click **Yes** to confirm that you want to overwrite the existing Site Recovery Manager extension on this vCenter Server instance.

13 Select a certificate type and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Automatically generate certificate | Use an automatically generated certificate:  
  a Select **Automatically generate certificate** and click **Next**.  
  b Enter text values for your organization and organization unit, typically your company name and the name of your group in the company.  
  c Click **Next**. |
| Load a certificate file     | Use a custom certificate:  
  a Select **Use a PKCS#12 certificate file** and click **Next**.  
  b Click **Browse**, navigate to the certificate file, and click **Open**. The certificate file must contain exactly one certificate with exactly one private key matching the certificate.  
  c Enter the certificate password.  
  d Click **Next**. |
Select **Use a custom database server**, select the 64-bit DSN that connects to the Site Recovery Manager database that you used with the previous installation, click **Next**, and provide the database connection information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>Enter a valid user name for the specified database. If you use Integrated Windows Authentication, this option is not available.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password for the specified user name. If you use Integrated Windows Authentication, this option is not available.</td>
</tr>
<tr>
<td>Connection Count</td>
<td>Enter the initial connection pool size. In most cases, it is not necessary to change this setting. Before changing this setting, consult with your database administrator.</td>
</tr>
<tr>
<td>Max Connections</td>
<td>Enter the maximum number of database connections that can be open simultaneously. Usually, it is not necessary to change this setting. Before changing this setting, consult with your database administrator.</td>
</tr>
</tbody>
</table>

Select the user account under which to run the Site Recovery Manager Server service and click **Next**.

- Select **Use Local System Account** to run the Site Recovery Manager Server service under the Local System account.
- Enter the username and password of an existing LDAP user account to run the Site Recovery Manager Server service under a different user account. This can be any user account, including local users, that is a member of the built-in Administrators group.

This option is not available if you use an SQL Server database with Integrated Windows Authentication. In this case, the Site Recovery Manager Server service runs under the account that you use to install Site Recovery Manager.

Click **Install**.

After the installation is finished, click **Finish**.

**What to do next**

- Log in to vSphere Web Client, or if you are already connected to vSphere Web Client, log out of vSphere Web Client and log in again. The upgraded Site Recovery Manager extension appears in vSphere Web Client. You might need to clear the browser cache for the upgrade to appear in vSphere Web Client. If the upgrade still does not appear, restart the vSphere Web Client service.
- Repeat the procedure to upgrade the Site Recovery Manager Server on the other Site Recovery Manager site.
- After you have upgraded both sites, see **Configure and Verify the Upgraded Site Recovery Manager Installation**.

**Configure and Verify the Upgraded Site Recovery Manager Installation**

You must configure the upgraded components to establish a working Site Recovery Manager installation.
If you use array-based replication, you must check that your storage replication adapters (SRAs) are compatible with this version of Site Recovery Manager. According to the type of storage that you use, you might need to reinstall the SRAs.

If you use vSphere Replication and you upgraded vSphere Replication, no additional configuration is required other than verifying your connections, protection groups, and recovery plans.

**Prerequisites**

- Upgrade Site Recovery Manager.
- Download the SRA by going to [https://my.vmware.com/web/vmware/downloads](https://my.vmware.com/web/vmware/downloads), selecting *VMware vCenter Site Recovery Manager > Download Product*, then selecting *Drivers & Tools > Storage Replication Adapters > Go to Downloads*.
- If you obtain an SRA from a different vendor site, verify that it has been certified for the Site Recovery Manager release you are using. See the *VMware Compatibility Guide for Site Recovery Manager* at [http://www.vmware.com/resources/compatibility/search.php?deviceCategory=sra](http://www.vmware.com/resources/compatibility/search.php?deviceCategory=sra).

**Procedure**

1. Log in to the vSphere Client or the vSphere Web Client.
2. In the vSphere Client or the vSphere Web Client, click *Site Recovery > Open Site Recovery*.
3. On the *Site Recovery* home tab, select a site pair, and click *View Details*.
4. On the *Site Pair* tab, click *Reconfigure Site Pair* and provide the required information.
5. If you use array-based replication, select *Configure > Array Based Replication > Storage Replication Adapters* and check the status of the storage array adapters.
6. If array managers are in the Error state, uninstall the SRAs, install the new version, and rescan the SRAs on the Site Recovery Manager Server hosts that you upgraded.

You must perform these tasks on both sites.

   a. Log in to the Site Recovery Manager Server host machine on each site.
   b. Uninstall the SRAs that are in the Error state.
   c. Reinstall the SRAs with the SRA version that corresponds to this version of Site Recovery Manager.
   d. In the vSphere Client or the vSphere Web Client, click *Site Recovery > Open Site Recovery*.
   e. On the Site Recovery home tab, select a site pair and click *View Details*.
   f. Select *Configure > Array Based Replication > Storage Replication Adapters* and click *Rescan Adapters*. 
7 If you use array-based replication, reenter the login credentials for the array managers.
   a Select Configure > Array Based Replication > Array Pairs, select an array pair, click Array Manager Pair, and then click Edit Local Array Manager or Edit Remote Array Manager.
   b Enter the user name and password for the array, and click Save.
8 Select the Protection Groups tab and the Recovery Plans tab, and verify that your protection groups and recovery plans from the previous version are present.
9 On the Recovery Plans tab, run a test on each of your recovery plans.

Revert to a Previous Release of Site Recovery Manager

To revert to a previous release of Site Recovery Manager, you must uninstall Site Recovery Manager from the protected and recovery sites. Then reinstall the previous release.

Prerequisites

- Verify that your installation of vCenter Server supports the Site Recovery Manager release that you are reverting to. See the Compatibility Matrices for Site Recovery Manager 8.3 at https://docs.vmware.com/en/Site-Recovery-Manager/8.3/rn/srm-compat-matrix-8-3.html. For information about reverting a vCenter Server installation, see the vSphere documentation.
- Verify that you made a backup of the Site Recovery Manager database before you upgraded Site Recovery Manager from a previous release to this release. For information about how to back up the embedded database, see Back Up and Restore the Embedded vPostgres Database.

Procedure

1 Use the Windows Control Panel options to uninstall Site Recovery Manager at the protected and recovery sites.
   If you connected the Site Recovery Manager Server instances at the protected and recovery sites, you must uninstall Site Recovery Manager at both sites. If you uninstall Site Recovery Manager from one side of a site pairing but not the other, the database on the remaining site becomes inconsistent.
2 Restore the Site Recovery Manager database from the backup that you made when you upgraded Site Recovery Manager from the previous release.
   You must restore the database on both sites so they are synchronized. For instructions about how to restore a database from a backup, see the documentation from your database vendor.
3 Install the previous release of Site Recovery Manager Server on the protected and recovery sites.
4 Reestablish the connection between the Site Recovery Manager Server instances on the protected and recovery sites.

Results

If you restored a backup of the Site Recovery Manager database from the previous version, any configurations or protection plans that you created before you upgraded Site Recovery Manager are retained.
Update the Site Recovery Manager Virtual Appliance

You use the Site Recovery Manager Appliance Management Interface to apply patches and updates to the virtual appliance.

Procedure

1. Log in to the Site Recovery Manager Appliance Management Interface as admin.
2. Click Update.
3. To configure your update settings, click Edit.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online repository</td>
<td>a Select Use repository.</td>
</tr>
<tr>
<td></td>
<td>b Enter the repository URL, user name (optional), and password (optional).</td>
</tr>
<tr>
<td>Downloadable ISO file</td>
<td>Select Use CD-ROM.</td>
</tr>
</tbody>
</table>

4. Click OK.
5. In the Available updates pane, click Install.
6. Accept the end-user license agreement, and click Install.
   After the update is complete, the appliance restarts.
7. Refresh the browser window to reload the Site Recovery Manager Appliance Management Interface.
8. Log in to the Site Recovery Manager Appliance Management Interface as admin.
9. Click Reconfigure.
10. Follow the prompts, provide the required information, and click Finish.
Migrating from Site Recovery Manager for Windows to the Site Recovery Manager Virtual Appliance

You can migrate your Site Recovery Manager 8.3 instance from Windows to the Site Recovery Manager Virtual Appliance.

- **Migrate from Site Recovery Manager for Windows to Site Recovery Manager Virtual Appliance**
  To migrate from Site Recovery Manager 8.3 for Windows to the Site Recovery Manager Virtual Appliance, you must perform certain operations.

- **Roll Back from the Site Recovery Manager Virtual Appliance to Site Recovery Manager for Windows**
  If the migration to the Site Recovery Manager Virtual Appliance fails, you can roll back to Site Recovery Manager for Windows.

### Migrate from Site Recovery Manager for Windows to Site Recovery Manager Virtual Appliance

To migrate from Site Recovery Manager 8.3 for Windows to the Site Recovery Manager Virtual Appliance, you must perform certain operations.

**Note** If you are using a federated IPv6 environment and migrate to the Site Recovery Manager Virtual Appliance, you must use the Site Recovery Manager Appliance Management Interface to reconfigure the appliance.

**Prerequisites**

- Verify that you have upgraded your Site Recovery Manager for Windows instance to version 8.3.
- Stop the Site Recovery Manager Server on the Windows host machine.
- Deploy the Site Recovery Manager Virtual Appliance.

**Procedure**

1. Log in to the Site Recovery Manager for Windows host machine.
2. Open a command prompt, and navigate to the `bin` folder in the Site Recovery Manager installation directory `%SRM_INSTALL_DIR%\bin`. 
3 Run the following script.

`export-srm-data.bat <export_dir>`

**Note** You must have write access to the `<export_dir>`.

4 When prompted, enter a password.

5 Transfer the exported directory to the Site Recovery Manager Virtual Appliance host machine.

6 Shut down the Windows host machine.

7 Log in to the Site Recovery Manager Virtual Appliance host machine as root.

8 (Optional) If in a trusted environment, import the user-specific root CA certificates and the Site Recovery Manager Server certificates by using the Site Recovery Manager Appliance Management Interface.

**Note** The certificates must be in the `.pem` format.

9 Run the following script.

`/opt/vmware/srm/bin/import-srm-data.sh <export_dir>`

a (Optional) If in a trusted environment, enter the OS admin password.

b (Optional) If prompted, enter the Platform Services Controller and the vCenter Server thumbprints.

c Enter the vCenter Single Sign-On administrator user name.

d Enter the vCenter Single Sign-On administrator password.

e Enter the root password.

f Enter the password set during the export of the data for the credentials file.

10 (Optional) Configure the DNS settings of the Site Recovery Manager Appliance.

a Log in to the Site Recovery Manager Appliance Management Interface as admin.

b Click **Networking**.

c To configure your network settings, click **Edit**.

d Configure the DNS settings in the **Hostname and DNS** pane.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Obtain DNS settings automatically</td>
<td>Obtains the DNS settings automatically from the network</td>
</tr>
<tr>
<td>Enter DNS settings manually</td>
<td>Uses the DNS address settings that you set manually. If you select this option, you must provide the IP addresses for a primary and a secondary DNS server.</td>
</tr>
</tbody>
</table>
e  In the eth0 pane, select the IPv4 or the IPv6 protocol type and configure the IP address settings.

- Configure the IPv4 address settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Obtain IPv4 settings automatically</td>
<td>Obtains the IP address for the appliance from the network</td>
</tr>
<tr>
<td>Enter IPv4 settings manually</td>
<td>Uses an IPv4 address that you set manually.</td>
</tr>
<tr>
<td></td>
<td>1  Enter the IPv4 address.</td>
</tr>
<tr>
<td></td>
<td>2  Enter the subnet prefix length.</td>
</tr>
<tr>
<td></td>
<td>3  Enter the default IPv4 gateway.</td>
</tr>
</tbody>
</table>

- Configure the IPv6 address settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Obtain IPv6 settings automatically using DHCP</td>
<td>Assigns IPv6 addresses to the appliance from the network by using DHCP.</td>
</tr>
<tr>
<td>Note</td>
<td>To apply this setting, you must restart the Site Recovery Manager Appliance.</td>
</tr>
<tr>
<td>Obtain IPv6 settings automatically using router advertisement</td>
<td>Assigns IPv6 addresses to the appliance from the network by using router advertisement</td>
</tr>
<tr>
<td>Use static IPv6 addresses</td>
<td>Uses static IPv6 addresses that you set up manually.</td>
</tr>
<tr>
<td>1  Enter the IPv6 address and the subnet prefix length in the address box.</td>
<td></td>
</tr>
<tr>
<td>2  To enter additional IPv6 addresses, click Add.</td>
<td></td>
</tr>
<tr>
<td>3  Enter the default IPv6 gateway.</td>
<td></td>
</tr>
</tbody>
</table>

f  Click **Save**.

11  (Optional) Import the Storage Replication Adapters (SRAs) through the Site Recovery Manager Appliance Management Interface.

a  Log in to the Site Recovery Manager Appliance Management Interface as admin.

b  Click **Storage Replication Adapters**, and click **New Adapter**.

c  Click **Upload**, navigate to the directory where you saved the SRA file, and select it.

d  When the process finishes, click **Close**.

12  On the **Site Recovery** home tab, select the site pair, and click **Actions > Reconnect**.

a  Select the first site from the list. Enter the address of the Platform Services Controller for the Site Recovery Manager Server on the second site, provide the user name and password, and click **Next**.

b  Select the vCenter Server and the services you want to reconfigure, and click **Next**.

c  On the **Ready to complete** page, review the pairing settings, and click **Finish**.
Roll Back from the Site Recovery Manager Virtual Appliance to Site Recovery Manager for Windows

If the migration to the Site Recovery Manager Virtual Appliance fails, you can roll back to Site Recovery Manager for Windows.

**Prerequisites**

- Power off the Site Recovery Manager Virtual Appliance host machine.
- Power on the Site Recovery Manager Server Windows host machine.

**Procedure**

1. Log in to the Site Recovery Manager Server Windows host.

2. In the Windows Control Panel, click Programs and Features and click the entry for Site Recovery Manager.

3. To apply the values that you set during the Site Recovery Manager Virtual Appliance deployment to the Site Recovery Manager Server Windows host machine, run the Site Recovery Manager installer in **Modify** mode.

4. Log in to the vSphere Web Client or the vSphere Client.

5. In the vSphere Client or the vSphere Web Client, click Site Recovery > Open Site Recovery.

6. On the Site Recovery home tab, select the site pair, and click Actions > Reconnect.
   a. Select the first site from the list. Enter the address of the Platform Services Controller for the Site Recovery Manager Server on the second site, provide the user name and password, and click Next.
   b. Select the vCenter Server and the services you want to reconfigure, and click Next.
   c. On the Ready to complete page, review the pairing settings, and click Finish.
Installing Site Recovery Manager to Use with a Shared Recovery Site

With Site Recovery Manager, you can connect multiple protected sites to a single recovery site. The virtual machines on the protected sites all recover to the same recovery site. This configuration is known as a shared recovery site, a many-to-one, fan-in, or an N:1 configuration.

In a shared recovery site configuration, you install one Site Recovery Manager Server instance on each protected site, each of which connects to a different vCenter Server instance.

On the recovery site, you install multiple Site Recovery Manager Server instances to pair with each Site Recovery Manager Server instance on the protected sites. All the Site Recovery Manager Server instances on the shared recovery site connect to a single vCenter Server instance.

Each Site Recovery Manager Server instance in a pair must have the same Site Recovery Manager extension ID, which you can set when you install Site Recovery Manager Server.

You can use either array-based replication or vSphere Replication or a combination of both when you configure Site Recovery Manager Server to use a shared recovery site.

Site Recovery Manager also supports shared protected site (one-to-many, fan-out, or 1:N) and many-to-many (N:N) configurations.

Converting One-to-One Site Recovery Manager Configuration into a Shared Recovery Site Configuration

To convert a one-to-one configuration to a shared recovery site configuration, you deploy additional Site Recovery Manager Server and vCenter Server instances as protected sites, and pair them with additional Site Recovery Manager Server instances that all connect to the existing vCenter Server instance on the recovery site.

Each pair of Site Recovery Manager Server instances in the shared recovery site configuration must use a different Site Recovery Manager extension ID.

For example, if you installed a one-to-one configuration that uses the default Site Recovery Manager extension ID, you must deploy all subsequent Site Recovery Manager Server pairs with different custom extension IDs.
Using Site Recovery Manager with Multiple Protected Sites and a Shared Recovery Site

An organization has two field offices and a head office. Each of the field offices is a protected site. The head office acts as the recovery site for both of the field offices. Each field office has a Site Recovery Manager Server instance and a vCenter Server instance. The head office has two Site Recovery Manager Server instances, each of which is paired with a Site Recovery Manager Server instance in one of the field offices. Both of the Site Recovery Manager Server instances at the head office extend a single vCenter Server instance.

- Field office 1
  - Site Recovery Manager Server A
  - vCenter Server A

- Field office 2
  - Site Recovery Manager Server B
  - vCenter Server B

- Head office
  - Site Recovery Manager Server C, that is paired with Site Recovery Manager Server A
  - Site Recovery Manager Server D, that is paired with Site Recovery Manager Server B
  - vCenter Server C, that is extended by Site Recovery Manager Server C and Site Recovery Manager Server D
This chapter includes the following topics:

- Shared Recovery Sites and vCenter Server Deployment Models
- Limitations of Using Site Recovery Manager in Shared Recovery Site Configuration
- Models for Assigning Site Recovery Manager Licenses in a Shared Recovery Site Configuration
- Install Site Recovery Manager In a Shared Recovery Site Configuration
- Upgrade Site Recovery Manager in a Shared Recovery Site Configuration
Shared Recovery Sites and vCenter Server Deployment Models

You can use Site Recovery Manager in a shared recovery site configuration in any of the deployment models that vCenter Server supports.

For information about how the vCenter Server deployment model affects Site Recovery Manager, see Site Recovery Manager and vCenter Server Deployment Models.

Site Recovery Manager in a Shared Recovery Site Configuration

In a shared recovery site configuration, the Site Recovery Manager Server instances on the recovery site connect to the same vCenter Server and Platform Services Controller instances.

The Site Recovery Manager Server instances on the protected sites can connect to vCenter Server instances that share a Platform Services Controller or that each connect to a different Platform Services Controller.

In this example, the Site Recovery Manager Server instances on the protected sites connect to a single Platform Services Controller instance that two vCenter Server instances share.

Figure 16-2. Site Recovery Manager in a Shared Recovery Site Configuration
Site Recovery Manager in a Shared Protected Site Configuration

In a shared protected site configuration, the Site Recovery Manager Server instances on the protected site connect to the same vCenter Server and Platform Services Controller instances.

The Site Recovery Manager Server instances on the recovery sites can share vCenter Server and Platform Services Controller instances, or they can connect to a different vCenter Server and Platform Services Controller instances.

In this example, two Site Recovery Manager Server instances share a vCenter Server instance on each of two shared protected sites. The vCenter Server instances on both of the shared protected sites share a single Platform Services Controller. On the recovery sites, two Site Recovery Manager Server instances share a vCenter Server instance on each shared recovery site. The vCenter Server instances on both of the shared recovery sites share a single Platform Services Controller.

Figure 16-3. Site Recovery Manager in a Shared Protected Site and Shared Recovery Site Configuration
Limitations of Using Site Recovery Manager in Shared Recovery Site Configuration

When you configure Site Recovery Manager to use a shared recovery site, Site Recovery Manager supports the same operations as it does in a standard one-to-one configuration. Using Site Recovery Manager with a shared recovery site is subject to some limitations.

- Site Recovery Manager supports point-to-point replication. Site Recovery Manager does not support replication to multiple targets, even in a multi-site configuration.
- For each shared recovery site customer, you must install Site Recovery Manager Server once at the customer site and again at the recovery site.
- You must specify the same Site Recovery Manager extension ID when you install the Site Recovery Manager Server instances on the protected site and on the shared recovery site. For example, you can install the first pair of sites with the default Site Recovery Manager extension ID, then install subsequent pairs of sites with custom extension IDs.
- You must install each Site Recovery Manager Server instance at the shared recovery site on its own host machine. You cannot install multiple instances of Site Recovery Manager Server on the same host machine.
- Each Site Recovery Manager Server instance on the protected site and on the shared recovery site requires its own database.
- A single shared recovery site can support a maximum of ten protected sites. You can run concurrent recoveries from multiple sites. See Operational Limits of Site Recovery Manager for the number of concurrent recoveries that you can run with array-based replication and with vSphere Replication.
- In a large Site Recovery Manager environment, you might experience timeout errors when powering on virtual machines on a shared recovery site. See Timeout Errors When Powering on Virtual Machines on a Shared Recovery Site.
- When connecting to Site Recovery Manager on the shared recovery site, every customer can see all of the Site Recovery Manager extensions that are registered with the shared recovery site, including company names and descriptions. All customers of a shared recovery site can have access to other customers’ folders and potentially to other information at the shared recovery site.

Timeout Errors When Powering on Virtual Machines on a Shared Recovery Site

In a large Site Recovery Manager environment, you might encounter timeout errors when powering on virtual machines on a shared recovery site.

Problem

When you power on virtual machines on a shared recovery site, you see the error message Error:Operation timed out:900 seconds.
Cause

This problem can occur if a single vCenter Server instance manages a large number of virtual machines on the shared recovery site, for example 1000 or more.

Solution

1. Increase the remoteManager.defaultTimeout timeout value on the Site Recovery Manager Server on the recovery site.

   For example, increase the timeout from the default of 300 seconds to 1200 seconds. For information about how to increase the remoteManager.defaultTimeout setting, see Change Remote Manager Settings in the Site Recovery Manager Administration.

   Do not increase the timeout period excessively. Setting the timeout to an unrealistically long period can hide other problems, for example problems related to communication between Site Recovery Manager Server and vCenter Server or other services that Site Recovery Manager requires.

2. Open the vmware-dr.xml file in a text editor.

   - If you are using Site Recovery Manager for Windows, you find the vmware-dr.xml file in the C:\Program Files\VMware\VMware vCenter Site Recovery Manager\config folder on the Site Recovery Manager Server host machine.
   - If you are using the Site Recovery Manager Virtual Appliance, you find the vmware-dr.xml file in the /opt/vmware/srm/conf/ directory on the appliance.

3. Set the timeout for reading from the vSphere Web Client.

   Set the timeout to 900 seconds (15 minutes) by adding a line to the <vmacore><http> element.

   ```xml
   <vmacore>
   <http>
     <defaultClientReadTimeoutSeconds>900</defaultClientReadTimeoutSeconds>
   </http>
   </vmacore>
   ```

4. Restart the Site Recovery Manager Server service.

What to do next

If you still experience timeouts after increasing the RemoteManager timeout value, experiment with progressively longer timeout settings.

Models for Assigning Site Recovery Manager Licenses in a Shared Recovery Site Configuration

If you configure Site Recovery Manager to use with a shared recovery site, you can assign licenses individually on the shared recovery site. You can also share a license between all Site Recovery Manager Server instances on the shared recovery site.
In a shared recovery site configuration, you install Site Recovery Manager license keys on each of the protected sites to enable recovery.

- You can install the same license key on the shared recovery site and assign it to the partner Site Recovery Manager Server instance to enable bidirectional operation, including reprotect.
- You can use the same license key for both Site Recovery Manager Server instances in the Site Recovery Manager pair, in the same way as for a one-to-one configuration.
- Alternatively, you can install one Site Recovery Manager license key on the shared recovery site. All Site Recovery Manager Server instances on the shared recovery site share this license. In this configuration, you must ensure that you have sufficient licenses for the total number of virtual machines that you protect on the shared recovery site, for all protected sites.

Example: Sharing Site Recovery Manager Licenses on a Shared Recovery Site

You connect two protected sites to a shared recovery site. You install a single Site Recovery Manager license on the shared recovery site.

- If you protect 20 virtual machines on protected site A, you require a license for 20 virtual machines on protected site A to recover these virtual machines to the shared recovery site.
- If you protect 10 virtual machines on protected site B, you require a license for 10 virtual machines on protected site B to recover these virtual machines to the shared recovery site.
- You share a Site Recovery Manager license for 25 virtual machines between two Site Recovery Manager Server instances, C and D, on the shared recovery site. The Site Recovery Manager Server instances on sites A and B connect to Site Recovery Manager Server instances C and D respectively.

Because you have a license for 25 virtual machines on the shared recovery site, the total number of virtual machines for which you can perform reprotect after a recovery is 25. If you recover all of the virtual machines from sites A and B to the shared recovery site and attempt to perform reprotect, you have sufficient licenses to reprotect only 25 of the 30 virtual machines that you recovered. You can reprotect all 20 of the virtual machines from site A to reverse protection from Site Recovery Manager Server C to site A. You can reprotect only 5 of the virtual machines to reverse protection from Site Recovery Manager Server D to site B.

In this situation, you can purchase licenses for more virtual machines for the shared recovery site. Alternatively, you can add the license keys from sites A and B to vCenter Server on the shared recovery site, and assign the license from site A to Site Recovery Manager Server C and the license from site B to Site Recovery Manager Server D.

Install Site Recovery Manager In a Shared Recovery Site Configuration

To install Site Recovery Manager in a shared recovery site configuration, you deploy Site Recovery Manager Server on one or more protected sites, and deploy a corresponding number of Site Recovery Manager Server instances on the shared recovery site.
You can only pair protected and recovery sites that have the same Site Recovery Manager extension ID.

Procedure

1. **Use vSphere Replication in a Shared Recovery Site Configuration**
   You can use vSphere Replication with Site Recovery Manager in a shared recovery site configuration in the same way that you do in a standard one-to-one configuration.

2. **Install Site Recovery Manager Server on Multiple Protected Sites to Use with a Shared Recovery Site**
   You install Site Recovery Manager Server to use with a shared recovery site by running the Site Recovery Manager installer and specifying a Site Recovery Manager ID for the site pair.

3. **Install Multiple Site Recovery Manager Server Instances on a Shared Recovery Site**
   In a shared recovery site configuration, you can install multiple Site Recovery Manager Server instances that all extend the same vCenter Server instance on the shared recovery site.

4. **Configure the Site Recovery Manager Appliance on Multiple Protected Sites to Use with a Shared Recovery Site**
   You must deploy and configure a Site Recovery Manager Appliance on each protected site to use with a shared recovery site.

5. **Connect the Site Recovery Manager Sites in a Shared Recovery Site Configuration**
   In a shared recovery site configuration, you connect the Site Recovery Manager sites in the same way as for a standard one-to-one configuration.

6. **Use Array-Based Replication in a Shared Recovery Site Configuration**
   You can use array-based replication with Site Recovery Manager in a shared recovery site configuration in the same way as you do in a standard one-to-one configuration.

7. **Configure Placeholders and Mappings in a Shared Recovery Site Configuration**
   When you configure placeholders and mappings in a shared recovery site configuration, the customers of the shared recovery site can share the resources on the recovery site. Alternatively, you can assign isolated resources to each customer.

Use vSphere Replication in a Shared Recovery Site Configuration

You can use vSphere Replication with Site Recovery Manager in a shared recovery site configuration in the same way that you do in a standard one-to-one configuration.
You deploy one vSphere Replication appliance on each protected site. You deploy only one vSphere Replication appliance on the shared recovery site. All of the vSphere Replication appliances on the protected sites connect to this single vSphere Replication appliance on the recovery site. You deploy the vSphere Replication appliances in the same way as for a standard one-to-one configuration.

**Important**  Deploy only one vSphere Replication appliance on the shared recovery site. If you deploy multiple vSphere Replication appliances on the shared recovery site, each new vSphere Replication appliance overwrites the registration of the previous vSphere Replication appliance with vCenter Server. This overwrites all existing replications and configurations.

You can deploy multiple additional vSphere Replication servers on the shared recovery site to distribute the replication load. For example, you can deploy on the shared recovery site a vSphere Replication server for each of the protected sites that connects to the shared recovery site. For information about protection and recovery limits when using vSphere Replication with Site Recovery Manager in a shared recovery site configuration, see [http://kb.vmware.com/kb/2147110](http://kb.vmware.com/kb/2147110).

**Prerequisites**

- To use Site Recovery Manager with vSphere Replication, deploy the appropriate version of vSphere Replication on both of the protected and recovery sites before you install Site Recovery Manager Server. The Site Recovery Manager installer verifies the version of vSphere Replication during installation and stops if it detects an incompatible version. This verification is not performed if you install vSphere Replication after you install Site Recovery Manager Server, which might lead to incompatible versions. Incompatible versions of Site Recovery Manager and vSphere Replication cause the vSphere Web Client to stop working. For information about compatibility between vSphere Replication and Site Recovery Manager versions, see [vSphere Replication Requirements](https://docs.vmware.com/en/Site-Recovery-Manager/8.3/rn/srm-compat-matrix-8-3.html) in the Compatibility Matrices for Site Recovery Manager 8.3.

- If you cannot upgrade an existing incompatible version of vSphere Replication, you must unregister vSphere Replication from both vCenter Server instances before you install Site Recovery Manager. Incompatible versions of Site Recovery Manager and vSphere Replication cause the vSphere Web Client to stop working. See [Unregister an Incompatible Version of vSphere Replication](#).

**Procedure**

1. Deploy a vSphere Replication appliance on each of the protected sites.
2. Deploy one vSphere Replication appliance on the shared recovery site.
3. (Optional) Deploy additional vSphere Replication servers on the shared recovery site.
4. (Optional) Register the additional vSphere Replication servers with the vSphere Replication appliance on the shared recovery site.

The vSphere Replication servers become available to all Site Recovery Manager instances on the shared recovery site.
Results

The shared recovery site is ready to receive replicated virtual machines that you recover from the protected sites by using vSphere Replication.

Install Site Recovery Manager Server on Multiple Protected Sites to Use with a Shared Recovery Site

You install Site Recovery Manager Server to use with a shared recovery site by running the Site Recovery Manager installer and specifying a Site Recovery Manager ID for the site pair.

For each protected site, you must install one instance of Site Recovery Manager Server at the protected site and one instance of Site Recovery Manager Server at the recovery site. You can only pair Site Recovery Manager Server instances that have the same Site Recovery Manager extension ID. Each protected site must include its own vCenter Server instance. You can connect up to 10 protected sites to a single recovery site.

Prerequisites

- Download the Site Recovery Manager installation file to a folder on the Site Recovery Manager Server host.

- This information presumes knowledge of the standard procedure for installing Site Recovery Manager. See Install Site Recovery Manager Server for Windows for information about a standard Site Recovery Manager installation.

Procedure

1. Double-click the Site Recovery Manager installer, select an installation language, and click OK.

2. Follow the prompts to begin the Site Recovery Manager installation.

3. At the SRM Plug-in ID page, select Custom SRM Plug-in Identifier, provide information to identify this custom Site Recovery Manager extension, and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SRM ID</td>
<td>Enter a unique identifier for this pair of Site Recovery Manager Server instances. The Site Recovery Manager ID can be a string of up to 29 ASCII characters from the set of ASCII upper- lower-case characters, digits, the underscore, the period, and the hyphen. You cannot use the underscore, period, and hyphen as the first or last characters of the Site Recovery Manager ID, and they cannot appear adjacent to one another.</td>
</tr>
<tr>
<td>Organization</td>
<td>Enter a string of up to 50 ASCII characters to specify the organization that created the extension.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a string of up to 50 ASCII characters to provide a description of the extension.</td>
</tr>
</tbody>
</table>

4. Follow the prompts to complete the remainder of the installation.
5  Repeat the procedure on each of the sites to protect.

   Connect each Site Recovery Manager Server to its own vCenter Server instance. Assign a unique Site Recovery Manager ID to each Site Recovery Manager Server.

**Install Multiple Site Recovery Manager Server Instances on a Shared Recovery Site**

In a shared recovery site configuration, you can install multiple Site Recovery Manager Server instances that all extend the same vCenter Server instance on the shared recovery site.

The Site Recovery Manager Server instances that you install on a shared recovery site each correspond to a Site Recovery Manager Server on a protected site.

**Prerequisites**

- You created one or more protected sites, each with a Site Recovery Manager Server instance for which you configured a unique Site Recovery Manager plug-in ID.

- Download the Site Recovery Manager installation file to a folder on the Site Recovery Manager Server host.

- This information presumes knowledge of the standard procedure for installing Site Recovery Manager. See [Install Site Recovery Manager Server for Windows](#) for information about a standard Site Recovery Manager installation.

**Procedure**

1  Double-click the Site Recovery Manager installer, select an installation language, and click **OK**.

2  Follow the prompts to begin the Site Recovery Manager installation.

3  At the SRM Plug-in ID page, select **Custom SRM Plug-in Identifier**, provide information to identify this Site Recovery Manager extension as the partner of a Site Recovery Manager Server instance on a protected site, and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SRM ID</td>
<td>Enter the same Site Recovery Manager ID as you provided for the corresponding Site Recovery Manager Server instance on the protected site. For example, if you set the Site Recovery Manager ID of the Site Recovery Manager Server instance on the protected site to <strong>SRM-01</strong>, set the Site Recovery Manager ID to <strong>SRM-01</strong>.</td>
</tr>
<tr>
<td>Organization</td>
<td>Enter a string of up to 50 ASCII characters to specify the organization that created the extension.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a string of up to 50 ASCII characters to provide a description of the extension.</td>
</tr>
</tbody>
</table>

4  Follow the prompts to complete the remainder of the installation.
What to do next

Repeat the procedure to install further Site Recovery Manager Server instances on the shared recovery site, each with a Site Recovery Manager plug-in ID that matches a Site Recovery Manager Server instance on another protected site. Each additional Site Recovery Manager Server instance that you install on the recovery site connects to the vCenter Server instance. You can connect a maximum of 10 Site Recovery Manager Server instances to a single vCenter Server instance.

Configure the Site Recovery Manager Appliance on Multiple Protected Sites to Use with a Shared Recovery Site

You must deploy and configure a Site Recovery Manager Appliance on each protected site to use with a shared recovery site.

Prerequisites

Deploy the Site Recovery Manager Virtual Appliance and power it on. See Deploy the Site Recovery Manager Virtual Appliance.

Procedure

1. Log in to the Site Recovery Manager Appliance Management Interface as admin.
2. Click the Summary tab, and click Configure appliance.
3. On the Platform Services Controller page, enter the information about the site where you deployed the Site Recovery Manager Appliance.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Enter the host name (in lowercase letters) or IP address of the Platform Services Controller for the vCenter Server with which to register Site Recovery Manager.</td>
</tr>
<tr>
<td>PSC port</td>
<td>Accept the default value of 443, or enter a new value if Platform Services Controller uses a different port. Platform Services Controller only supports connections over HTTPS.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the vCenter Single Sign-On user name for the vCenter Single Sign-On domain to which this Platform Services Controller instance belongs. This user account must be a member of the vCenter Single Sign-On administrator group on the Platform Services Controller instance.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for the specified vCenter Single Sign-On user name.</td>
</tr>
</tbody>
</table>

4. If prompted, click Connect to verify the Platform Services Controller certificate.
5 On the vCenter Server page, select the vCenter Server instance with which to register the Site Recovery Manager Appliance, and click Next.

Caution  The drop-down menu includes all the vCenter Server instances that are registered with the Platform Services Controller. In an environment that uses Enhanced Linked Mode, it might also include vCenter Server instances from other Platform Services Controller instances. Make sure that you select the correct vCenter Server instance. After you configure the Site Recovery Manager Appliance, you cannot select a different vCenter Server instance.
6 On the **Name and Extension** page, enter the necessary information to register the Site Recovery Manager with vCenter Server, and select the default Site Recovery Manager extension identifier, or create a custom extension identifier.

   a Enter the site name, administrator email address, and local host IP address or name.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local site name</td>
<td>A name for this Site Recovery Manager site, which appears in the Site Recovery Manager interface. The vCenter Server address is used by default. Use a different name for each Site Recovery Manager instance in the pair.</td>
</tr>
<tr>
<td>Administrator email</td>
<td>The email address of the Site Recovery Manager administrator. This information is required even though you use the standard vCenter Server alarms to configure email notifications for Site Recovery Manager events.</td>
</tr>
<tr>
<td>Local host</td>
<td>The name or IP address of the local host. Only change the value if the IP address is not the one that you want to use. For example, the local host might have more than one network interface, and the one that the Site Recovery Manager Appliance detects is not the interface that you want to use.</td>
</tr>
</tbody>
</table>

   **Note** To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.

   b Select the default Site Recovery Manager extension identifier, or create a custom extension ID for this Site Recovery Manager pair, and click **Next**.

   Both Site Recovery Manager instances in a site pair must use the same extension ID.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default extension ID</td>
<td>Use this option when you deploy Site Recovery Manager in a standard configuration with one protected site and one recovery site.</td>
</tr>
<tr>
<td>Custom extension ID</td>
<td>Use this option when you deploy Site Recovery Manager in a shared recovery site configuration, with multiple protected sites and one recovery site. Enter the details for the custom extension ID.</td>
</tr>
</tbody>
</table>

   - Extension ID. A unique identifier. Assign the same identifier to the Site Recovery Manager instances on the protected site and the shared recovery site.
   - Organization. The name of the organization to which this Site Recovery Manager sites pair belongs. This name helps to identify Site Recovery Manager pairs in a shared recovery site configuration, especially when multiple organizations use the shared recovery site.
   - Description. An optional description of the Site Recovery Manager pair.

7 On the **Ready to Complete** page, review your settings and click **Finish**.
Connect the Site Recovery Manager Sites in a Shared Recovery Site Configuration

In a shared recovery site configuration, you connect the Site Recovery Manager sites in the same way as for a standard one-to-one configuration.

If you start the site connection from one of the protected sites, Site Recovery Manager uses the Site Recovery Manager ID that you set during installation to connect to the corresponding Site Recovery Manager Server instance on the recovery site.

Prerequisites

- You installed Site Recovery Manager Server on one or more protected sites.
- You installed one or more Site Recovery Manager Server instances on a shared recovery site.
- You assigned the same Site Recovery Manager extension ID to a Site Recovery Manager Server instance on a protected site and to a Site Recovery Manager Server instance on the shared recovery site.

Procedure

1. In the vSphere Client or the vSphere Web Client, click Site Recovery > Open Site Recovery.
2. Click the New Site Pair button.
3. Select the first site from the list. Enter the address of the Platform Services Controller for the Site Recovery Manager Server on the second site, provide the user name and password, and click Next.

   The address that you provide for the Platform Services Controller must be an exact match of the address that you provided when you installed Site Recovery Manager Server on the recovery site.

   **Important** To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.

4. Select the vCenter Server and the services you want to pair, and click Next.

   If several Site Recovery Manager Server instances are registered with this vCenter Server instance, Site Recovery Manager connects to the Site Recovery Manager Server instance that has the corresponding Site Recovery Manager ID.

5. On the Ready to complete page, review the pairing settings, and click Finish.

6. Repeat Step 1 to Step 4 to configure the site pairing for all of the sites that use the shared recovery site.

Use Array-Based Replication in a Shared Recovery Site Configuration

You can use array-based replication with Site Recovery Manager in a shared recovery site configuration in the same way as you do in a standard one-to-one configuration.
To use array-based replication with Site Recovery Manager in a shared recovery site configuration, you must install storage arrays and storage replication adapters (SRA) on each of the protected sites. Each protected site can use a different type of storage array.

Each protected site can either share the same storage on the shared recovery site, or you can allocate storage individually for each protected site. You can use storage from multiple vendors on the shared recovery site, as long as they correspond to storage that you use on the respective protected sites. You must install the appropriate SRA for each type of storage that you use on the shared recovery site.

For information about protection and recovery limits when you use array-based replication with Site Recovery Manager in a shared recovery site configuration, see Operational Limits of Site Recovery Manager.

**Prerequisites**

- You installed Site Recovery Manager in a shared recovery site configuration.
- You connected the protected sites with the shared recovery site.

**Procedure**

1. Set up storage arrays on the protected sites following the instructions that your storage array provides.
2. Install the appropriate SRAs on Site Recovery Manager Server systems on the protected sites.
3. Install the appropriate SRAs on Site Recovery Manager Server systems on the shared recovery site.
4. Configure the array managers on the protected sites and on the shared recovery sites.
5. Configure the mappings from the resources on the protected sites to resources on the shared recovery site and configure the placeholder datastores.

**Configure Placeholders and Mappings in a Shared Recovery Site Configuration**

When you configure placeholders and mappings in a shared recovery site configuration, the customers of the shared recovery site can share the resources on the recovery site. Alternatively, you can assign isolated resources to each customer.

On a shared recovery site, multiple customers share a single vCenter Server instance. In some cases, multiple customers can share a single ESXi host on the recovery site. You can map the resources on the protected sites to shared resources on the shared recovery site. You might share resources on the recovery site if you do not need to keep all of the customers' virtual machines separate, for example if all of the customers belong to the same organization.

You can also create isolated resources on the shared recovery site and map the resources on the protected sites to their own dedicated resources on the shared recovery site. You might use this configuration if you must keep all of the customers' virtual machines separate from each other, for example if all of the customers belong to different organizations.
For information about how to assign permissions to allow users to access the resources on a shared recovery site, see Managing Permissions in a Shared Recovery Site Configuration in Site Recovery Manager Administration.

Prerequisites

- You installed Site Recovery Manager in a shared recovery site configuration.
- You connected the protected sites with the shared recovery site.
- Familiarize yourself with the procedure for configuring placeholders and mappings. For information about configuring placeholders and mappings in a standard configuration, see Site Recovery Manager Administration.

Procedure

1. In the vSphere Client or the vSphere Web Client, click Site Recovery > Open Site Recovery.
2. On the Site Recovery home tab, select a site pair, and click View Details.
3. On the Site Pair tab expand Configure, and select the type of resource to configure, Network Mappings, Folder Mappings, Resource Mappings, Storage Policy Mappings, and Placeholder Datastores.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Share customer resources</td>
<td>Map the resources, networks, and datastores on the protected sites to a common datacenter, network, and placeholder datastore on the shared recovery site. You can create individual folders for each customer on the recovery site and map the folders on the protected sites to the individual folders.</td>
</tr>
<tr>
<td>Isolate customer resources</td>
<td>Map the resources, networks, folders, and datastores on the protected sites to separate datacenters, networks, folders, and placeholder datastores on the shared recovery site.</td>
</tr>
</tbody>
</table>

4. (Optional) If you use vSphere Replication, select the appropriate target datastores for the replica virtual machines when you configure replication.

Avoid using the same datastore as the target for vSphere Replication as you use as the placeholder datastore for Site Recovery Manager.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Share customer resources</td>
<td>Select a common target datastore on the shared recovery site. You can create individual folders in the target datastore for each customer on the recovery site.</td>
</tr>
<tr>
<td>Isolate customer resources</td>
<td>Select a different datastore for each customer on the shared recovery site.</td>
</tr>
</tbody>
</table>

Upgrade Site Recovery Manager in a Shared Recovery Site Configuration

You can upgrade existing Site Recovery Manager installations that use a shared recovery site.
When you upgrade a Site Recovery Manager installation that uses a shared recovery site, apply the same recommendations for upgrading a standard one-to-one installation of Site Recovery Manager. See Chapter 14 Upgrading Site Recovery Manager.

Upgrade all of the protected sites before you upgrade the shared recovery site. When you upgrade all of the protected sites before you upgrade the shared recovery site, you can run recoveries on the shared recovery site if failures occur on a protected site during the upgrade process. If you upgrade vCenter Server on the shared recovery site before you upgrade all of the protected sites, you must complete all the upgrades to perform recovery.

Upgrade the protected sites in order of importance, upgrading the most important sites first and the least important sites last. For example, upgrade protected sites that run business-critical applications before you upgrade sites that are less vital to your operations.

Prerequisites

- Verify that you know the standard procedure for upgrading Site Recovery Manager. For information about a standard Site Recovery Manager upgrade, see Chapter 14 Upgrading Site Recovery Manager.
- Evaluate the importance of each protected site, and prioritize the upgrade of the sites accordingly.

Procedure

1. (Optional) Upgrade vCenter Server on the most critical of the protected sites.
2. (Optional) If you use vSphere Replication, upgrade the vSphere Replication appliance that connects to the vCenter Server instance that you upgraded in Step 1.
3. Upgrade the Site Recovery Manager Server instance that connects to the vCenter Server instance that you upgraded in Step 1.
   - If you perform in-place upgrade of Site Recovery Manager Server, the installer obtains from the registry the Site Recovery Manager extension ID that you set during the previous installation. There is no option to modify the Site Recovery Manager extension ID during upgrade.
   - If you upgrade Site Recovery Manager Server with migration, you must specify the same Site Recovery Manager extension ID as you used for the previous installation.
4. (Optional) If you use array-based replication, upgrade the storage replication adapters (SRA) on the Site Recovery Manager Server host machine that you upgraded in Step 3.
5. Repeat Step 1 to Step 4 for each of the protected sites that connect to the shared recovery site.
6. (Optional) Upgrade vCenter Server on the shared recovery site.
7. (Optional) If you use vSphere Replication, upgrade the vSphere Replication appliance on the shared recovery site.
8 Upgrade the Site Recovery Manager Server instance on the shared recovery site that is paired with the first protected site that you upgraded.
   - If you perform in-place upgrade of Site Recovery Manager Server, the installer obtains from the registry the Site Recovery Manager extension ID that you set during the previous installation. There is no option to modify the Site Recovery Manager extension ID during upgrade.
   - If you upgrade Site Recovery Manager Server with migration, you must specify the same Site Recovery Manager extension ID as you used for the previous installation.

9 (Optional) If you use array-based replication, upgrade the SRAs for this Site Recovery Manager Server instance on the shared recovery site.

10 Repeat Step 8 and Step 9 for each of the remaining Site Recovery Manager Server instances on the shared recovery site.

11 (Optional) Upgrade the ESXi Server instances on the shared recovery sites and each of the protected sites.

12 Upgrade the virtual hardware and VMware Tools on the virtual machines on the ESXi Server instances.
Silent Installation, Upgrade, and Uninstallation of Site Recovery Manager

You can automate Site Recovery Manager installation, upgrade, and uninstallation.

This chapter includes the following topics:

- Install Site Recovery Manager with Embedded vPostgreSQL Database Silently
- Install Site Recovery Manager Server Silently with an External Database
- Upgrade Site Recovery Manager with Embedded vPostgreSQL Database Silently
- Upgrade Site Recovery Manager Server Silently
- Uninstall Site Recovery Manager Server Silently

Install Site Recovery Manager with Embedded vPostgreSQL Database Silently

Site Recovery Manager includes Site Recovery Manager Server and an embedded vPostgreSQL database. You can install them by using the command-line interface.

You can use the following procedure in the standard one-to-one Site Recovery Manager configuration and in a shared recovery site configuration. For information about a shared recovery site configuration, see Chapter 16 Installing Site Recovery Manager to Use with a Shared Recovery Site.

If you install Site Recovery Manager in a shared recovery site, you must use custom extension keys and run the procedure on each site.

The following procedure is for an installation using the Windows LocalSystem account for the Site Recovery Manager service.

Prerequisites

- Perform the tasks listed in Prerequisites and Best Practices for Site Recovery Manager Server Installation.
- Log in to the Site Recovery Manager host VM.
- For a shared recovery site configuration, perform the procedure for installing as described in Install Site Recovery Manager In a Shared Recovery Site Configuration.
Procedure

1. Run the Site Recovery Manager installer by specifying the locale ID and the path to the log file.

   \texttt{VMware-srm-****.exe /clone_wait /s /L.locale ID in decimal format /V"/l*vx path to the log file /qr // the installer displays a reduced user interface}

2. Specify the path to the Site Recovery Manager installation directory.

   \texttt{INSTALLDIR="installation path\"}

3. Specify Platform Services Controller on the local site by providing the FQDN or the IP address of Platform Services Controller and the thumbprint of the certificate. Use a colon between the HEX value pairs to specify the thumbprint.

   \texttt{PLATFORM_SERVICES_CONTROLLER_HOST=FQDN or IP address}

   \texttt{PLATFORM_SERVICES_CONTROLLER_THUMBPRINT=Thumbprint of the certificate // use : to separate the HEX value pairs}

   For example,


---

**Table 17-1. Supported Locale IDs**

<table>
<thead>
<tr>
<th>Locale ID in Decimal Format</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>1028</td>
<td>Chinese, Traditional</td>
</tr>
<tr>
<td>1031</td>
<td>German</td>
</tr>
<tr>
<td>1033</td>
<td>English</td>
</tr>
<tr>
<td>1034</td>
<td>Spanish, Traditional</td>
</tr>
<tr>
<td>1036</td>
<td>French</td>
</tr>
<tr>
<td>1041</td>
<td>Japanese</td>
</tr>
<tr>
<td>1042</td>
<td>Korean</td>
</tr>
<tr>
<td>2052</td>
<td>Chinese, Simplified</td>
</tr>
</tbody>
</table>

For example,

\texttt{VMware-srm-****.exe /clone_wait /L1033 /s /V"/l*vx C:\install.log /qr // installs Site Recovery Manager in English}

The installer displays a reduced user interface.
4 Enter the administrator credentials to the local Platform Services Controller.

* SS0_ADMIN_USER="username"

* SS0_ADMIN_PASSWORD="password"

5 Specify vCenter Server on the local site by providing the FQDN, and the thumbprint of the certificate. Use a colon between the HEX value pairs to specify the thumbprint.

* DR_TXT_VCHOSTNAME=FQDN

* VC_CERTIFICATE_THUMBPRINT="Thumbprint of the certificate // use : to separate the HEX value pairs"

For example,


6 Specify the Site Recovery Manager extension key.

You can use a default or custom extension key. In a shared recovery site configuration, use a custom extension key. Use com.vmware.vcDr for a default key. For an extension key, you can use alphanumeric characters, a hyphen, a period, or underscore. The custom extension key must include fewer than 29 characters. The key cannot start or end with a sequence of hyphen, period, or underscore characters.

* DR_TXT_EXTKEY="Site Recovery Manager key"

For example,

* DR_TXT_EXTKEY="com.vmware.vcDr" //use the Site Recovery Manager default extension key

7 Specify the Site Recovery Manager plug-in description. You can use alphanumeric characters for a company name and a description. Use fewer than 50 characters for each parameter.

* DR_TXT_PLUGIN_COMPANY="Company"

* DR_TXT_PLUGIN_DESC="Description"

For example,

* DR_TXT_PLUGIN_COMPANY="VMware, Inc." 

* DR_TXT_PLUGIN_DESC="Created for SRM."

8 Specify the Site Recovery Manager host VM by providing the FQDN or the IP address of the VM.

* DR_CB_HOSTNAME_IP=FQDN or IP address
9 Specify the name of the local Site Recovery Manager site.

   DR_TXT_LSN="local site name"

10 Specify the email address of the Site Recovery Manager administrator.

   DR_TXT_ADMINEMAIL="email address"

11 Specify whether to use an automatically generated certificate or a certificate from a certification file.

   DR_RB_CERTSEL=0 // use an existing PKCS#12 certification file
   DR_RB_CERTSEL=1 // use an automatically generated certificate

12 If you use an existing certification file, specify the path to the file and enter the password to access the file.

   DR_TXT_CERTFILE="path to certificate file"
   DR_TXT_CERTPWD="password"

13 If you use an automatically generated certificate, enter the description of the certificate.

   DR_TXT_CERTORG="Organization"
   DR_TXT_CERTORGUNIT="Organization unit"

   For example,

   DR_TXT_CERTORG="VMware, Inc."
   DR_TXT_CERTORGUNIT="ORG"

14 Configure Site Recovery Manager to use the embedded vPostgreSQL database.

   DR_USES_EMBEDDED_DB=1 // use embedded database

15 Specify a port for the embedded vPostgreSQL database. Use value from 1 to 65535.

   DR_EMBEDDED_DB_PORT=decimal value

   For example,

   DR_EMBEDDED_DB_PORT=5678 // use the default port of the embedded database

16 Specify the system data source name (DSN) that points to the embedded vPostgreSQL database. Use alphanumeric characters or underscore. DSN must not start with an underscore or a number.

   DR_EMBEDDED_DB_DSN="System DSN"
Specify the user name and password to access the embedded vPostgreSQL database.

- `DR_EMBEDDED_DB_USER="username"`
- `DR_EMBEDDED_DB_PWD="password"`

**Important** Do not use `postgres` as the embedded database user name. The `postgres` user name is reserved for the embedded vPostgreSQL database super user.

Clean the existing database.

- `DR_RB_EXISTDBSEL=0`

**Example: Silent Installation of Site Recovery Manager**

You can use the following commands to install Site Recovery Manager using the Windows LocalSystem account for the Site Recovery Manager service and automatically generated certificates.

```
VMware-srm-*****.exe /clone_wait /L1033 /s /V" /l*vx c:\install.log /qr
INSTALLDIR="C:\Program Files\VMware\VMware vCenter Site Recovery Manager"
PLATFORM_SERVICES_CONTROLLER_HOST=<FQDN or IP address>
PLATFORM_SERVICES_CONTROLLER_THUMBPRINT=<Thumbprint of the certificate>
SSO_ADMIN_USER=""username"
SSO_ADMIN_PASSWORD=""password"
DR_TXT_VCHOSTNAME=<FQDN>
VC_CERTIFICATE_THUMBPRINT=<Thumbprint of the certificate>
DR_TXT_EXTKEY="com.vmware.vcDr"
DR_TXT_PLUGIN_COMPANY="VMware, Inc."
DR_TXT_PLUGIN_DESC="VMware vCenter Site Recovery Manager Extension"
DR_CB_HOSTNAME_IP=<FQDN or IP address>
DR_TXT_LSN="local site name"
DR_TXT_ADMINEMAIL="email address"
DR_RB_CERTSEL=1
DR_TXT_CERTORG="Organization"
DR_TXT_CERTORGUNIT="Organization unit"
DR_USES_EMBEDDED_DB=1
DR_EMBEDDED_DB_DSN="System DSN"
DR_EMBEDDED_DB_USER="username"
DR_EMBEDDED_DB_PWD="password"
DR_RB_EXISTDBSEL=0
```

You can use the following commands to install Site Recovery Manager using the Windows LocalSystem account for the Site Recovery Manager service and custom certificates.

```
VMware-srm-*****.exe /clone_wait /L1033 /s /V" /l*vx c:\install.log /qr
INSTALLDIR="C:\Program Files\VMware\VMware vCenter Site Recovery Manager"
PLATFORM_SERVICES_CONTROLLER_HOST=<FQDN or IP address>
PLATFORM_SERVICES_CONTROLLER_THUMBPRINT=<Thumbprint of the certificate>
SSO_ADMIN_USER=""username"
SSO_ADMIN_PASSWORD=""password"
DR_TXT_VCHOSTNAME=<FQDN>
VC_CERTIFICATE_THUMBPRINT=<Thumbprint of the certificate>
```
What to do next

Repeat the procedure on the remote site.

Install Site Recovery Manager Server Silently with an External Database

Site Recovery Manager can work with an external database. To use Site Recovery Manager with an external database, you must install the database and Site Recovery Manager Server. You can install Site Recovery Manager Server by using the command-line interface or automate the Site Recovery Manager Server installation.

You can use the following procedure in the standard one-to-one Site Recovery Manager configuration and in a shared recovery site configuration. For information about a shared recovery site configuration, see Chapter 16 Installing Site Recovery Manager to Use with a Shared Recovery Site.

If you install Site Recovery Manager in a shared recovery site, you must use custom extension keys and run the procedure on each site.

The following procedure is for an installation using the Windows LocalSystem account for the Site Recovery Manager service and DSN with SQL authentication.

**Note** Use the silent installation of Site Recovery Manager Server if you use Microsoft SQL Server as an external database.

**Prerequisites**

- Perform the tasks listed in Prerequisites and Best Practices for Site Recovery Manager Server Installation.
- Install and configure Microsoft SQL Server as an external database and the respective native client. See Requirements when Using Microsoft SQL Server with Site Recovery Manager.
- Configure the system database source name. See Create an ODBC System DSN for Site Recovery Manager.
Procedure

1. Run the Site Recovery Manager installer by specifying the locale ID and the path to the log file.

   ```
   VMware-srm-****.exe /clone_wait /s /L locale ID in decimal format /V"/lx path to the log file /qr // the installer displays a reduced user interface
   ```

   **Table 17-2. Supported Locale IDs**

<table>
<thead>
<tr>
<th>Locale ID in Decimal Format</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>1028</td>
<td>Chinese, Traditional</td>
</tr>
<tr>
<td>1031</td>
<td>German</td>
</tr>
<tr>
<td>1033</td>
<td>English</td>
</tr>
<tr>
<td>1034</td>
<td>Spanish, Traditional</td>
</tr>
<tr>
<td>1036</td>
<td>French</td>
</tr>
<tr>
<td>1041</td>
<td>Japanese</td>
</tr>
<tr>
<td>1042</td>
<td>Korean</td>
</tr>
<tr>
<td>2052</td>
<td>Chinese, Simplified</td>
</tr>
</tbody>
</table>

   For example,

   ```
   VMware-srm-****.exe /clone_wait /L1033 /s /V" /lx C:\install.log /qr // installs Site Recovery Manager in English
   ```

   The installer displays a reduced user interface.

2. Specify the path to the Site Recovery Manager installation directory.

   ```
   INSTALLDIR="installation path"
   ```

3. Specify Platform Services Controller on the local site by providing the FQDN or the IP address of Platform Services Controller and the thumbprint of the certificate. Use a colon between the HEX value pairs to specify the thumbprint.

   ```
   PLATFORM_SERVICES_CONTROLLER_HOST=FQDN or IP address
   PLATFORM_SERVICES_CONTROLLER_THUMBPRINT=Thumbprint of the certificate // use : to separate the HEX value pairs
   ```

   For example,

   ```
   ```
4 Enter the administrator credentials to the local Platform Services Controller.

```
SSO_ADMIN_USER="username"
SSO_ADMIN_PASSWORD="password"
```

5 Specify vCenter Server on the local site by providing the FQDN, and the thumbprint of the certificate. Use a colon between the HEX value pairs to specify the thumbprint.

```
DR_TXT_VCHOSTNAME=FQDN
VC_CERTIFICATE_THUMBPRINT=Thumbprint of the certificate // use : to separate the HEX value pairs
```

For example,
```
```

6 Specify the Site Recovery Manager extension key.

You can use a default or custom extension key. In a shared recovery site configuration, use a custom extension key. Use com.vmware.vcDr for a default key. For an extension key, you can use alphanumeric characters, a hyphen, a period, or underscore. The custom extension key must include fewer than 29 characters. The key cannot start or end with a sequence of hyphen, period, or underscore characters.

```
DR_TXT_EXTKEY="Site Recovery Manager key"
```

For example,
```
DR_TXT_EXTKEY="com.vmware.vcDr" //use the Site Recovery Manager default extension key
```

7 Specify the Site Recovery Manager plug-in description. You can use alphanumeric characters for a company name and a description. Use fewer than 50 characters for each parameter.

```
DR_TXT_PLUGIN_COMPANY="Company"
DR_TXT_PLUGIN_DESC="Description"
```

For example,
```
DR_TXT_PLUGIN_COMPANY="VMware, Inc."
DR_TXT_PLUGIN_DESC="Created for SRM."
```

8 Specify the Site Recovery Manager host VM by providing the FQDN or the IP address of the VM.

```
DR_CB_HOSTNAME_IP=FQDN or IP address
```
9 Specify the name of the local Site Recovery Manager site.

   DR_TXT_LSN="local site name"

10 Specify the email address of the Site Recovery Manager administrator.

   DR_TXT_ADMINEMAIL="email address"

11 Specify whether to use an automatically generated certificate or a certificate from a certification file.

   DR_RB_CERTSEL=0 // use an existing PKCS#12 certification file
   DR_RB_CERTSEL=1 // use an automatically generated certificate

12 If you use an existing certification file, specify the path to the file and enter the password to access the file.

   DR_TXT_CERTFILE="path to certificate file"
   DR_TXT_CERTPWD="password"

13 If you use an automatically generated certificate, enter the description of the certificate.

   DR_TXT_CERTORG="Organization"
   DR_TXT_CERTORGUNIT="Organization unit"

   For example,
   DR_TXT_CERTORG="VMware, Inc."
   DR_TXT_CERTORGUNIT="ORG"

14 Configure Site Recovery Manager to use an external database.

   DR_USES_EMBEDDED_DB=0 // use external database

15 Enter **SQL Server** for the type of the external database.

   DR_CB_DC="SQL Server"

16 Specify the system data source name (DSN) that points to your database. Use alphanumeric characters or underscore but do not start with an underscore or a number.

   DR_TXT_DSN="System DSN"
Enter the administrator credentials of your database.

DR.TXT_DBUSR="username"
DR.TXT_DBPWD="password"

Clean the existing database.

Example: Silent Installation of Site Recovery Manager Server

You can use the following commands to install Site Recovery Manager Server using the Windows LocalSystem account for the Site Recovery Manager service and automatically generated certificates.

```
VMware-srm-*****.exe /clone_wait /L1033 /s /V /l*vx c:\install.log /qr
INSTALLDIR="C:\Program Files\VMware\VMware vCenter Site Recovery Manager"
PLATFORM_SERVICES_CONTROLLER_HOST=<FQDN or IP address>
PLATFORM_SERVICES_CONTROLLER_THUMBPRINT=<Thumbprint of the certificate>
SSO_ADMIN_USER=<username>
SSO_ADMIN_PASSWORD=<password>
DR.TXT_VCHOSTNAME=<FQDN>
VC_CERTIFICATE_THUMBPRINT=<Thumbprint of the certificate>
DR.TXT_VCDOMAIN="$com.vmware.vcDr$
DR.TXT_PLUGIN_COMPANY="VMware, Inc."
DR.TXT_PLUGIN_DESC="VMware vCenter Site Recovery Manager Extension"
DR.TXT_DC="SQL Server"
DR.TXT_DSN="System DSN"
DR.TXT_DBUSR="username"
DR.TXT_DBPWD="password"
DR_RB_EXISTDBSEL=0
```

You can use the following commands to install Site Recovery Manager Server using the Windows LocalSystem account and custom certificates.

```
VMware-srm-*****.exe /clone_wait /L1033 /s /V /l*vx c:\install.log /qr
INSTALLDIR="C:\Program Files\VMware\VMware vCenter Site Recovery Manager"
PLATFORM_SERVICES_CONTROLLER_HOST=<FQDN or IP address>
PLATFORM_SERVICES_CONTROLLER_THUMBPRINT=<Thumbprint of the certificate>
SSO_ADMIN_USER=<username>
SSO_ADMIN_PASSWORD=<password>
DR.TXT_VCHOSTNAME=<FQDN>
VC_CERTIFICATE_THUMBPRINT=<Thumbprint of the certificate>
DR.TXT_VCDOMAIN="$com.vmware.vcDr$
DR.TXT_PLUGIN_COMPANY="VMware, Inc."
DR.TXT_PLUGIN_DESC="VMware vCenter Site Recovery Manager Extension"
```
What to do next

Repeat the procedure on the remote site.

Upgrade Site Recovery Manager with Embedded vPostgreSQL Database Silently

You can automate the upgrade of your Site Recovery Manager with an embedded database or upgrade it by using the command-line interface.

You can use the following procedure in the standard one-to-one Site Recovery Manager configuration and in a shared recovery site configuration.

The following procedure is for in-place upgrade using the Windows LocalSystem account for the Site Recovery Manager service.

Prerequisites

- Perform the procedures for upgrading as described in Order of Upgrading vSphere and Site Recovery Manager Components.

- In a shared recovery site configuration, perform the procedure for upgrading as described in Upgrade Site Recovery Manager in a Shared Recovery Site Configuration.

- Back up the Site Recovery Manager embedded vPostgreSQL database. For information about how to back up your embedded database, see Back Up and Restore the Embedded vPostgres Database.

- Log in to the Site Recovery Manager host VM.

Procedure

1 Run the Site Recovery Manager installer by specifying the locale ID and the path to the log file.

```
VMware-srm-****.exe /clone_wait /s /Locale ID in decimal format /V"/l"vx path to the log file /qr // the installer displays a reduced user interface
```
Table 17-3. Supported Locale IDs

<table>
<thead>
<tr>
<th>Locale ID in Decimal Format</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>1028</td>
<td>Chinese, Traditional</td>
</tr>
<tr>
<td>1031</td>
<td>German</td>
</tr>
<tr>
<td>1033</td>
<td>English</td>
</tr>
<tr>
<td>1034</td>
<td>Spanish, Traditional</td>
</tr>
<tr>
<td>1036</td>
<td>French</td>
</tr>
<tr>
<td>1041</td>
<td>Japanese</td>
</tr>
<tr>
<td>1042</td>
<td>Korean</td>
</tr>
<tr>
<td>2052</td>
<td>Chinese, Simplified</td>
</tr>
</tbody>
</table>

For example,

```
VMware-srm-****.exe /clone_wait /L1033 /s /V" /l*vx C:\install.log /qr // installs Site Recovery Manager in English
```

The installer displays a reduced user interface.

2 Specify Platform Services Controller on the local site by providing the FQDN or the IP address of Platform Services Controller and the thumbprint of the certificate. Use a colon between the HEX value pairs to specify the thumbprint.

```
PLATFORM_SERVICES_CONTROLLER_HOST=FQDN or IP address
PLATFORM_SERVICES_CONTROLLER_THUMBPRINT=Thumbprint of the certificate // use : to separate the HEX value pairs
```

For example,

```
```

3 Enter the administrator credentials to the local Platform Services Controller.

```
SSO_ADMIN_USER="username"
SSO_ADMIN_PASSWORD="password"
```

4 Enter the thumbprint of the vCenter Server certificate. Use a colon between the HEX value pairs to specify the thumbprint.

```
VC_CERTIFICATE_THUMBPRINT=Thumbprint of the certificate // use : to separate the HEX value pairs
```

For example,

```
```
5  Use the existing Site Recovery Manager certificate.

   DR_RB_CERTSEL=2

6  Specify the user name and password to access the embedded vPostgreSQL database.

   DR_EMBEDDED_DB_USER="username"

   DR_EMBEDDED_DB_PWD="password"

   **Important**  Do not use postgres as the embedded database user name. The postgres user name is reserved for the embedded vPostgreSQL database super user.

**Example: Silent Upgrade of Site Recovery Manager**

You can use the following commands to upgrade Site Recovery Manager using the Windows LocalSystem account for the Site Recovery Manager service.

```
VMware-srm-*****.exe /clone_wait /L1033 /s /V" /l*v c:\upgrade.log /qr
PLATFORM_SERVICES_CONTROLLER_HOST=<FQDN or IP address>
PLATFORM_SERVICES_CONTROLLER_THUMBPRINT=<Thumbprint of the certificate>
SSO_ADMIN_USER="username"
SSO_ADMIN_PASSWORD="password"
VC_CERTIFICATE_THUMBPRINT=<Thumbprint of the certificate>
DR_RB_CERTSEL=2
DR_EMBEDDED_DB_USER="username"
DR_EMBEDDED_DB_PWD="password"
```

**What to do next**

Repeat the procedure on the remote site.

**Upgrade Site Recovery Manager Server Silently**

If you use Site Recovery Manager with an external database, you can automate the upgrade of your Site Recovery Manager Server or upgrade it by using the command-line interface.

You can use the following procedure in the standard one-to-one Site Recovery Manager configuration and in a shared recovery site configuration.

**Note**  Use the silent upgrade of Site Recovery Manager Server if you use Microsoft SQL Server as an external database.

The following procedure is for in-place upgrade using the Windows LocalSystem account for the Site Recovery Manager service.

**Prerequisites**

- Perform the procedures for upgrading as described in Order of Upgrading vSphere and Site Recovery Manager Components.
Back up the database.

In a shared recovery site configuration, perform the procedure for upgrading as described in Upgrade Site Recovery Manager in a Shared Recovery Site Configuration.

Log in to the Site Recovery Manager host VM.

Procedure

1. Run the Site Recovery Manager installer by specifying the locale ID and the path to the log file.

   ```
   VMware-srm-****.exe /clone_wait /s /locale ID in decimal format /V"/l*vx path to the log file /qr // the installer displays a reduced user interface
   ```

   **Table 17-4. Supported Locale IDs**

<table>
<thead>
<tr>
<th>Locale ID in Decimal Format</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>1028</td>
<td>Chinese, Traditional</td>
</tr>
<tr>
<td>1031</td>
<td>German</td>
</tr>
<tr>
<td>1033</td>
<td>English</td>
</tr>
<tr>
<td>1034</td>
<td>Spanish, Traditional</td>
</tr>
<tr>
<td>1036</td>
<td>French</td>
</tr>
<tr>
<td>1041</td>
<td>Japanese</td>
</tr>
<tr>
<td>1042</td>
<td>Korean</td>
</tr>
<tr>
<td>2052</td>
<td>Chinese, Simplified</td>
</tr>
</tbody>
</table>

   For example,

   ```
   VMware-srm-****.exe /clone_wait /L1033 /s /V" /l*vx C:\install.log /qr // installs Site Recovery Manager in English
   ```

   The installer displays a reduced user interface.

2. Specify Platform Services Controller on the local site by providing the FQDN or the IP address of Platform Services Controller and the thumbprint of the certificate. Use a colon between the HEX value pairs to specify the thumbprint.

   ```
   PLATFORM_SERVICES_CONTROLLER_HOST=FQDN or IP address
   PLATFORM_SERVICES_CONTROLLER_THUMBPRINT=Thumbprint of the certificate // use : to separate the HEX value pairs
   ```

   For example,

   ```
   ```
3 Enter the administrator credentials to the local Platform Services Controller.

<table>
<thead>
<tr>
<th>SSO_ADMIN_USER=&quot;username&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSO_ADMIN_PASSWORD=&quot;password&quot;</td>
</tr>
</tbody>
</table>

4 Enter the thumbprint of the vCenter Server certificate. Use a colon between the HEX value pairs to specify the thumbprint.

| VC_CERTIFICATE_THUMBPRINT=Thumbprint of the certificate // use : to separate the HEX value pairs |

For example,


5 Use the existing Site Recovery Manager certificate.

| DR_RB_CERTSEL=2 |

6 Enter the administrator credentials of your database.

| DR_TXT_DBUSR="database administrator's username" |
| DR_TXT_DBPWD="database administrator's password" |

**Example: Silent Upgrade of Site Recovery Manager Server**

You can use the following commands to upgrade Site Recovery Manager using the Windows LocalSystem account for the Site Recovery Manager service.

```
VMware-srm-*****.exe /clone_wait /L1033 /s /V /l*v c:\upgrade.log /qr
PLATFORM_SERVICES_CONTROLLER_HOST=<FQDN or IP address>
PLATFORM_SERVICES_CONTROLLER_THUMBPRINT=<Thumbprint of the certificate>
SSO_ADMIN_USER="username"
SSO_ADMIN_PASSWORD="password"
VC_CERTIFICATE_THUMBPRINT=<Thumbprint of the certificate>
DR_RB_CERTSEL=2
DR_TXT_DBUSR="username"
DR_TXT_DBPWD="password"
```

**What to do next**

Repeat the procedure on the remote site.

**Uninstall Site Recovery Manager Server Silently**

You can automate the uninstalling and unregistering of your Site Recovery Manager Server.

The following procedure uninstalls Site Recovery Manager Server and keeps the embedded or external database.
If you use Site Recovery Manager with vSphere Replication, you can continue to use vSphere Replication after you uninstall Site Recovery Manager.

You can use the following procedure in the standard one-to-one Site Recovery Manager configuration and in a shared recovery site configuration. In a shared recovery site configuration, you must run the procedure on each site.

**Prerequisites**

1. Remove the recovery plans, protection groups, mappings, and array managers on both sites. For information about how to remove them, see [Uninstall Site Recovery Manager](#).
2. Log in to the Site Recovery Manager host VM.
3. Uninstall the SRAs on both sites.

**Procedure**

1. Run the installer by entering the Site Recovery Manager product code and specifying the uninstallation log file.

   ```
   msiexec.exe /x {Site Recovery Manager Product Code} /q
   /l*vx "path to the uninstallation log file" // the installer does not use the user interface
   ```

   For example,

   ```
   msiexec.exe /x {BF127EFC-D3D9-49BD-BFC6-03DFB131FDB7} /q
   /l*vx "C:srm-uninstall-log.txt"
   ```

   The installer does not use the user interface.

2. Enter the administrator credentials to the local Platform Services Controller.

   ```
   SSO_ADMIN_USER="username"
   SSO_ADMIN_PASSWORD="password"
   ```

3. Specify whether to remove the Site Recovery Manager records from the database and unregister Site Recovery Manager from the local vCenter Server and Platform Services Controller or keep them.

   ```
   DR_CB_REMOVE_DATA=1 // removes Site Recovery Manager Server and its files, folders, and registry entries.
   Remove the Site Recovery Manager records from the database and un-register Site Recovery Manager from the local vCenter Server and Platform Services Controller
   ```

   ```
   DR_CB_REMOVE_DATA=0 // removes Site Recovery Manager Server and keeps the database records and registrations of Site Recovery Manager in the local vCenter Server and Platform Services Controller
   ```

**Results**

Your embedded or external database exists, but Site Recovery Manager is uninstalled.
What to do next

Repeat the procedure on the remote site.